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 1

I n t r o d u c t i o n

Welcome to the COMSOL Multiphysics® simulation software! This book details 
features and techniques that help you throughout all COMSOL Multiphysics 
modeling in version 5.5 using the COMSOL Desktop® environment. For example, 
detailed information about:

• How to build geometries in COMSOL Multiphysics.

• How to create a mesh for the analysis.

• How to create parameters and variables used within a model.

• How to add the physics interfaces and material properties.

• How to solve and display the results.

The full set of documentation shows you, step by step, how to tap into the 
functions and capabilities in the COMSOL Multiphysics software. This 
introductory chapter provides an overview of COMSOL Multiphysics and its 
product family, documentation set, and other resources.

Version 5.5 contains further enhanced COMSOL Compiler™, Application 
Builder, and COMSOL Server™ products for creating and deploying custom 
applications based on COMSOL Multiphysics.
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In this chapter:

• About COMSOL Multiphysics

• COMSOL Documentation and Help

• Overview of the Reference Manual
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Abou t  COMSOL Mu l t i p h y s i c s

COMSOL Multiphysics is a powerful interactive simulation environment used to model and solve all kinds of 
scientific and engineering problems. The software provides a powerful integrated desktop environment with a 
Model Builder that gives you a full overview of the model and access to all functionality. With COMSOL 
Multiphysics you can easily extend conventional models for one type of physics into multiphysics models that solve 
coupled physics phenomena — and that do so simultaneously. Accessing this power does not require an in-depth 
knowledge of mathematics or numerical analysis.

Using the built-in physics interfaces and the advanced support for material properties, you can build models by 
defining the relevant physical quantities — such as material properties, loads, constraints, sources, and fluxes — 
rather than by defining the underlying equations. You can always apply these variables, expressions, or numbers 
directly to solid and fluid domains, boundaries, edges, and points independently of the computational mesh. The 
COMSOL Multiphysics software then internally compiles a set of equations representing the entire model.

You access the power of COMSOL Multiphysics as a standalone product through a flexible graphical user interface 
(GUI), in applications created using the Application Builder and deployed using COMSOL Compiler™ or 
COMSOL Server™, or by script programming in Java® or the MATLAB® language (this requires a LiveLink™ for 
MATLAB® license).

Using these physics interfaces, you can perform various types of studies including:

• Stationary and time-dependent (transient) studies

• Linear and nonlinear studies

• Eigenfrequency, modal, and frequency response studies

When solving the models, the COMSOL Multiphysics software assembles and solves the problem using a set of 
advanced numerical analysis tools. The software runs the analysis together with adaptive mesh refinement (if 
selected) and error control using a variety of numerical solvers. The studies can make use of multiprocessor systems 
and cluster computing, and you can run batch jobs and parametric sweeps.

The COMSOL Multiphysics software creates sequences to record all steps that create the geometry, mesh, physics, 
studies and solver settings, and visualization and results presentation. This makes it easy to parameterize any part 
of the model; simply change a node in the model tree and rerun the sequences. The program remembers and 
reapplies all other information and data in the model.

R E A L - W O R L D  A P P L I C A T I O N S

Partial differential equations (PDEs) form the basis for the laws of science and provide the foundation for modeling 
a wide range of scientific and engineering phenomena. You can use the COMSOL Multiphysics software in many 
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application areas, including the following, combining physics freely and incorporating user-defined PDEs, ODEs, 
and DAEs if needed:

Many real-world applications involve simultaneous couplings of physics, represented in a system of PDEs — 
multiphysics. For instance, the electric resistance of a conductor often varies with temperature, and a model of a 
conductor carrying current should include resistive-heating effects. The Multiphysics Modeling Workflow section 
discusses multiphysics modeling techniques. Predefined multiphysics interfaces provide easy-to-use entry points for 
common multiphysics applications.

In its base configuration, COMSOL Multiphysics offers modeling and analysis power for many application areas. 
For several of the key application areas there are also optional add-on modules. These application-specific modules 
use terminology, solution methods, and plot types specific to the particular discipline, which simplifies creating and 
analyzing models. The modules also include comprehensive Application Libraries with example models that show 
the use of the product within its application areas.

The COMSOL Multiphysics Modules and Interfacing Options

The optional modules, including interfacing options such as the CAD Import Module and bidirectional interfaces 
such as the LiveLink™ products, are optimized for specific application areas and offer discipline-standard 
terminology and physics interfaces. For some modules, additional material libraries, specialized solvers, element 
types, and visualization tools are also available.

• Acoustics

• Bioscience

• Chemical reactions

• Corrosion and corrosion protection

• Diffusion

• Electrochemistry

• Electrodeposition

• Electromagnetics

• Fatigue analysis

• Fluid dynamics

• Fuel cells and batteries

• Geophysics and geomechanics

• Heat transfer

• Layered shells and composite materials

• Metal processing

• Microelectromechanical systems (MEMS)

• Microfluidics

• Microwave engineering

• Multibody dynamics

• Optics

• Optimization and sensitivity analysis

• Particle tracing

• Photonics

• Piezoelectric devices

• Pipe flow

• Plasma physics

• Porous media flow

• Quantum mechanics

• Radio-frequency components

• Ray tracing and ray optics

• Rotordynamics

• Semiconductor devices

• Structural mechanics

• Subsurface flow

• Transport phenomena

• Wave propagation

For up-to-date module availability, product descriptions, and a specification chart, go to 
www.comsol.com/products.
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COMSOL Do cumen t a t i o n  and He l p

About the Documentation Set

The full documentation set that ships with COMSOL Multiphysics consists of the following titles:

• Introduction to COMSOL Multiphysics — information about version 5.5 and how to build models using the 
desktop environment, including quick references to keyboard shortcuts and common commands and functions.

• COMSOL License Agreement.

• COMSOL Multiphysics Installation Guide — besides covering various installation options, it describes system 
requirements and how to configure and run the COMSOL Multiphysics software on different platforms, 
including client-server architectures as well as shared-memory and distributed (cluster) parallel versions.

• COMSOL Multiphysics Reference Manual — this book, which covers the functionality of COMSOL 
Multiphysics across its entire range from geometry modeling to results evaluation and visualization, including 
the physics interfaces for physics and equation-based modeling. It serves as a tutorial and a reference guide to 
use COMSOL Multiphysics. This book reviews geometry, mesh, solver, and results functionality and provides 
detailed information about the settings and options. Additionally, it describes some advanced functionality and 
settings in COMSOL Multiphysics and provides background material and references.

• COMSOL Multiphysics Programming Reference Manual — this book provides details about features and 
techniques that help you control COMSOL Multiphysics using its application programming interface (API). The 
COMSOL API can be used from the Application Builder, in a standalone Java® application, and from MATLAB® 
using the LiveLink™ for MATLAB® interface. For the Application Builder, the Application Programming Guide 
provides information about using the COMSOL API and the API of the Application Builder components to 
create methods for custom applications.

• The Introduction to the Application Builder and the Application Builder Reference Manual provide 
documentation related to the Application Builder and how to create and deploy simulation applications and how 
to use COMSOL Compiler™ to create standalone runnable applications. See also the COMSOL Server Manual 
for configure a server and clients for COMSOL Multiphysics applications.

• COMSOL Server Manual — information about setting up, configuring, and running a COMSOL Server for 
running and deploying applications within an organization.

• The Physics Builder Manual provides documentation related to the Physics Builder for creating custom physics 
interfaces.

• The Essentials of Postprocessing and Visualization and Specialized Techniques for Postprocessing and 
Visualization provide tips and information that help you get the most out of the postprocessing and 
visualization tools in COMSOL Multiphysics.

• COMSOL Multiphysics Release Notes — information about new functionality and changes in the 5.5 release 
and about compatibility with earlier versions of COMSOL Multiphysics.

In addition, each of the optional modules includes a manual as described in The COMSOL Multiphysics Modules 
and Interfacing Options. The documentation for the optional CAD Import Module and LiveLinks to CAD 
packages is available in separate manuals, and the documentation for the optional Material Library in the Material 
Library User’s Guide.

The COMSOL LiveLink™ for MATLAB® User’s Guide shows how to access the capabilities of COMSOL from the 
MATLAB programming environment.
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D I F F E R E N T  I N S T R U C T I O N S  F O R  D I F F E R E N T  O P E R A T I N G  S Y S T E M S

The Windows® platform uses a ribbon layout, a style familiar to Microsoft® Office users and integrated into many 
other Windows software designs. The ribbon-style layout is intuitive and makes it easy to locate similar and 
frequently used features. For the Linux® and macOS platforms, there are extended toolbars that provide almost 
identical single-click access to most functionality in the software.

The use of the ribbon for Windows users means that there are slightly different instructions about how to access 
some features compared to macOS or Linux users. When specific instructions are included about where to find a 
particular feature, the instructions distinguish between the operating systems using different icons.

• Where there are no differences, the icons are not used.

• Where there are minor differences in appearance or accessibility, but the functionality is the same, no icons are 
used.

• In general, instructions for all platforms imply that the feature is available from a named toolbar. For example, 
the Home toolbar, Physics toolbar, Mesh toolbar, or Geometry toolbar. See Toolbars and Keyboard Shortcuts for 
information about each toolbar.

A B O U T  T H E  S C R E E N S H O T S  U S E D  I N  T H I S  M A N U A L

The screenshots used throughout this reference manual are captured using the Windows platform except when 
there are clear differences other than fonts or cosmetic appearance.

A D D I T I O N A L  I N T E R N E T  R E S O U R C E S

A number of internet resources have more information about COMSOL, including licensing and technical 
information. The electronic documentation, topic-based (or context-based) help, and the application libraries are 
all accessed through the COMSOL Desktop.

C O N T A C T I N G  C O M S O L  B Y  E M A I L

For general product information, contact COMSOL at info@comsol.com.

C O M S O L  A C C E S S  A N D  T E C H N I C A L  S U P P O R T

To receive technical support from COMSOL for the COMSOL products, please contact your local COMSOL 
representative or send your questions to support@comsol.com. An automatic notification and a case number are 

A ribbon tab, ribbon group, or modal ribbon tab, are available in the Windows version. See 
Figure 2-1 for an example of the Windows Home toolbar.

The Model Toolbar and Contextual Toolbar are available in the cross-platform version, primarily 
for macOS and Linux users. See Figure 2-12 for an example of these toolbars.

If you are reading the documentation as a PDF file on your computer, 
the blue links do not work to open an application or content 
referenced in a different guide. However, if you are using the Help 
system in COMSOL Multiphysics, these links work to open other 
modules, application examples, and documentation sets.
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sent to you by email. You can also access technical support, software updates, license information, and other 
resources by registering for a COMSOL Access account.

C O M S O L  O N L I N E  R E S O U R C E S

The Help Window and Topic-Based Help

The Help window is useful as it is connected to many of the features in the COMSOL Desktop. This concept is 
called topic-based help or context help. You can also search and access all the HTML documentation content from 
this window. 

To learn more about a node in the Model Builder, or a window on the Desktop, click to highlight a node or 
window, then press F1. The Help window opens and displays the topic information about the selected feature. 

O P E N I N G  T H E  H E L P  W I N D O W  A N D  T H E  T O P I C - B A S E D  H E L P

There are several ways to open the Help window:

• Press F1.

• In the main toolbar, click Help ( ).

• In the upper-right corner of the COMSOL Desktop, click the ( ) button.

• From the main menu, select File>Help (Windows) Help>Help (Linux and macOS).

• Right-click any node in the Model Builder and select Help.

A B O U T  U S I N G  T H E  F 1  K E Y  T O  A C C E S S  C O N T E X T  H E L P

To display topic-based (context) information in the Help window, on the COMSOL Desktop:

• Click to highlight a node in the Model Builder tree. For example, the Component or Geometry node.

COMSOL website www.comsol.com

Contact COMSOL www.comsol.com/contact

COMSOL Access www.comsol.com/access

Support Center www.comsol.com/support

Product Download www.comsol.com/product-download

Product Updates www.comsol.com/support/updates

COMSOL Blog www.comsol.com/blogs

Discussion Forum www.comsol.com/community

Events www.comsol.com/events

COMSOL Video Gallery www.comsol.com/video

Support Knowledge Base www.comsol.com/support/knowledgebase

The Help system automatically starts a web server using port 8090 on the computer where 
COMSOL Multiphysics is installed. Depending on the security settings, you might get a question 
to allow that port to be used the first time the help system is started.

The operating system might also issue a firewall security warning. To use Help, allow COMSOL 
Multiphysics access through the firewall.
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• Click a window tab, for example, Model Builder, Add Study, or Messages.

• For Windows users, hover over ribbon buttons or menu items to display a tooltip. While the tooltip is showing, 
you can press F1 to display more detail.

At the top of the Help window you find the tools and search functionality listed in the table below. Also, above the 
help text, a clickable breadcrumb trail shows the location of the displayed contents in the COMSOL documentation 
set. Click any part of the trail to move to that level in the COMSOL documentation.

C H A N G I N G  T H E  D E F A U L T  D O C U M E N T A T I O N  A N D  H E L P  S E T T I N G S

To edit the following settings, open The Preferences Dialog Box and click Help.

Locate the Target area and choose Documentation window (the default) from the Show documentation in list to show 
the help contents in the Documentation window that is included in the COMSOL Desktop environment (default), 
or select External browser to display the help contents in a separate web browser. For further details on how to access 
and use the documentation, see the section The Documentation Window below. Similarly, using the Show help in 
list, you can choose between Help window (default) and External browser to show topic-based help in the Help 

In some cases you need to refocus the context help on its target before pressing F1. Try clicking 
to highlight a node, a window, or the button or click to focus on the Help window, hover over a 
toolbar button (Windows only) and press F1.

TABLE 1-1:  THE HELP AND DOCUMENTATION TOOLBARS

BUTTON NAME DESCRIPTION

Click the Home button or select the COMSOL Documentation top node in the table of 
contents tree to return to the COMSOL Documentation window home page. Not 
available when showing context help in the Help window.

Show 
Table of 
Contents/
Show 
Topic

When a help topic page is shown in the Help window, click Show Table of Contents to 
open a tree-based menu of the COMSOL documentation. When you select a node in the 
table of contents tree the corresponding topic is shown on the topic page. Alternatively, 
click again (Show Topic) to return to the topic page.

Search On the Help window, click to open the search engine to look for contents in the 
COMSOL documentation. Search results are shown sorted by product.

On the Documentation window, enter search terms in the field and choose the Search 
scope — All documents, Selected only, or Application libraries.

See Searching Help and Documentation Content for more information about search 
terms you can use.

/ Back Navigates backward to the previous page in the Help or Documentation window’s 
browser history.

/ Forward Navigates forward in the browser history, but only to the end of the current list.

Sticky 
Help

On the Help window, click the Sticky Help button to lock the current help window (the 
icon is highlighted ), which can be useful to keep some help topic or model instruction 
active, or to release the window and view topic-based (context) help when a node or 
window is clicked.

Show in 
External 
Browser

On the Help window, click the Show in External Browser button to show the current help 
topic in an external web browser.

Navigates backward to the previous section in the documentation.

Navigates forward to the next section in the documentation.
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window inside the COMSOL Desktop or in an external web browser, respectively. When showing topic-based help 
in an external browser, you need to press F1, choose Help>Help, or select the Help context menu item (when 
applicable) to trigger an update of the browser’s contents. The PDF-file target setting controls what happens when 
you click a PDF link on the COMSOL Documentation entry page. Choose In place to display PDF documents 
using the native browser’s PDF display settings, or choose New window to launch them in the default system 
application for PDF-files. On Windows, the native browser is always Microsoft Edge or Internet Explorer.

In the Source area, set the Location to Local to display help using locally installed help files or to Online to access help 
from the COMSOL website. For the Local option, edit the Documentation root directory file path as required. The 
default file paths are based on the platform:

• On Windows C:\Program Files\COMSOL\COMSOL55\Multiphysics\doc, or generically COMSOL55\doc.

• For macOS and Linux, under the main COMSOL installation directory: COMSOL55/Multiphysics/doc.

Proxy Server Settings
If you connect to the internet through a web proxy, you can use the controls in the Proxy server settings area to 
specify the proxy server settings to use when communicating with the COMSOL website for displaying online help 
in integrated mode as well as for performing updates of the COMSOL Application Library and the COMSOL Part 
Library (see The Application Library Update Window and The Part Library Update Window for further details 
about these services).

The Configuration list has the following options:

• No proxy server: Connect to the update server directly, bypassing any proxies. This is the default setting.

• Use system settings: Use the system-wide proxy server settings defined on your computer.

• Manual: Choose this alternative if you want to specify a proxy server by entering the name (or IP address) and 
port number in the Server and Port number fields. The default port number is 443, which is the default for HTTP 
secure (HTTPS). If the proxy server requires authentication, you are asked to provide username and password 
the first time in each COMSOL session you access documentation or update the COMSOL Application Library 
or Part Library.

Selecting a Web Browser
In the General section of the Preferences dialog, under Web browser (Windows and Linux only), you can choose 
which browser the COMSOL Multiphysics software should use to show pages on the COMSOL website and 
documentation when using the web browser mode. The following settings are available:

• On Windows: Choose the Program setting System default to use the default system web browser. Alternatively, 
choose Custom and then give the path to an Executable location for a different browser installed on your 
computer.

• On Linux: Type the path to the web browser directly in the Executable field, or click the Browse button and then 
point to the executable file on the file system.

On macOS, this setting is not available, and COMSOL Multiphysics always uses the system’s 
default web browser.
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The Documentation Window

In the Documentation window (or a browser window, depending on your preference settings), you can navigate 
to PDF or HTML versions of the documentation (availability is based on your license), as well as search all the 
documentation, save or open PDFs, or view the HTML content in this window. There are different ways to access 
the same information using either the left-hand side (Figure 1-1) or right-hand side (Figure 1-2) of the window.

To open the Documentation window:

• Press Ctrl+F1.

• From the File menu, select Help>Documentation.

To open the Documentation window:

• Press Ctrl+F1 

• In the main toolbar, click the Documentation ( ) button.

• From the Help menu, select Documentation.
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Figure 1-1: Based on your license, links to the HTML versions of the product documentation are accessed and can be 
browsed in the tree. When you click a topic in the tree the information displays to the right. You can also adjust the search 
scope.

Figure 1-2: Based on your license, links to PDF and HTML versions of the product documentation are accessed from this 
window. When you click HTML it jumps to the first page of the documentation for that product; when you click PDF 
you can Open or Save a full PDF version of that document.

Searching Help and Documentation Content

After you open The Help Window and Topic-Based Help, click the Search button ( ) to open the search engine 
and search the HTML content. Search results are shown sorted by product. You can also search in the contents of 
The Documentation Window.

• The Help Window and Topic-Based Help

• Table 1-1 for a list of the Documentation toolbar buttons.
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S E A R C H I N G  T H E  D O C U M E N T A T I O N

On the Documentation window, you can adjust the Search scope (see Figure 1-1). Enter a search term in the Search 

expression field and then select All documents, Selected only, or Application libraries from the list to narrow or expand 
the search scope as needed. For Selected only (Figure 1-3), first click a branch in the tree (for example, COMSOL 

Multiphysics Reference Manual) and then the search includes all the documents below the selected node until the 
beginning of the next branch. In this example it searches until the end of the Troubleshooting License Errors 
section. 

Figure 1-3: When searching in the Documentation window, choose a Search scope to search only a selected portion of the 
documentation, all the documentation, or only the Application Libraries.

S E A R C H  P A R A M E T E R S  F O R  H E L P  A N D  T H E  D O C U M E N T A T I O N

Some examples of search parameters you can use:

The first search can take a couple of minutes while the search index is generated. 

TABLE 1-2:  SEARCH PARAMETERS FOR THE COMSOL HELP SYSTEM

OPERATOR EXAMPLE SEARCH RESULT EXAMPLE

&&, AND block && cone

block AND cone

Results include all instances of the words.

OR, || block OR cone

block || cone

Results include any of the listed words.

+, − +block −cone Search for one term (+block) but not the other term (−cone).

“, ~ “plot line”~10 Search for the words enclosed in the quotation marks (plot line) within (~) a 
certain number of words (10) from each other.

~ excentric~ Search for something “almost” spelled in a particular way. For example, excentric. 
The results include eccentric cone.
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The About COMSOL Multiphysics Box

Figure 1-4: The About COMSOL Multiphysics dialog box with the setting to show the Acknowledgments list.

To open the About COMSOL Multiphysics ( ) window:

• For Windows users, select it from the File menu.

• For macOS and Linux (cross platform) users, choose it from the Help menu.

In addition to copyright and patent information, the About COMSOL Multiphysics dialog box has the following 
information:

• The Version number

? h?t Use in a search query to mean exactly one character. For example, search for all 
instances of hat, hit, or hut where ? represents a, i, or u, or any other letter 
between h and t.

* strain*

strain*d

The asterisk (*) is a wildcard character. Search for any word that starts with 
“strain”. Results include strain-based, strain-rate, or strain, for example. The 
asterisk represents any number of characters.

If the asterisk is used in the middle of the word, it searches for one letter between 
“n” and “d”. The result in this example is strained.

You can use the asterisk before and after the word in order to search for it in the 
middle of a longer word or expression, For example, *setdefaultgeometry* 
finds ModelUtil.setDefaultGeometryKernel.

enclosed 
quotation 
marks “ ”

“time dependent 
study”

Use quotation marks around a text string to search for exactly that phrase; that is, 
to search for the words in the order given within the quotation marks.

TABLE 1-2:  SEARCH PARAMETERS FOR THE COMSOL HELP SYSTEM

OPERATOR EXAMPLE SEARCH RESULT EXAMPLE
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• The user or company This product is licensed to

• The License number

Select an option from the list below and then click Show Information to open a separate window of the same name 
containing this information:

• Select Acknowledgments to show information about third-party software components, including license notices 
required by the software component authors. Then click Show Information.

• Select License agreement to show the COMSOL Multiphysics software license agreement. Then click Show 

Information.

• Select Licensed products to show the licensed COMSOL products, including the number of used licenses and the 
total number of licenses for each product. Then click Show Information.

• Select Patents to show the patents that the COMSOL software products are protected by. Then click Show 

Information.

• Select System information to show a list of system properties, which can be useful for troubleshooting purposes, 
for example. Then click Show Information.

• Click COMSOL Web Page to open your web browser on the main COMSOL web page.

Checking for Product Software Updates

COMSOL provides product software updates that improve the software and correct any issues found.

To check if a product update is available, from the File menu select Help>Check for Product Updates ( ).

The program then checks if an update that is applicable, but not yet installed, is available from the COMSOL 
website.

If an update is available, an Update dialog box appears; click Download to download the update directly, or click 
Browse Update to open the COMSOL website where you can read about and download the update. 

If no updates are available, the Update dialog box reports that your COMSOL installation is up to date. Open The 
Preferences Dialog Box and click Updates to select the Check for updates at launch check box to make the program 
check for updates each time you launch the COMSOL Multiphysics program.

Typographical Conventions

All documentation uses a set of consistent typographical conventions that make it easier to follow the discussion, 
understand what you can expect to see on the graphical user interface (GUI), and know which data must be entered 
into various data-entry fields.

You can also get information about the licensed products from the Licensed and Used Products in 

Session window.

The Root Settings and Properties Windows
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In particular, these conventions are used throughout the documentation:

K E Y  T O  T H E  G R A P H I C S

Throughout the documentation, icons are used to help organize the information. These icons vary in importance, 
but it is recommended that you read these text boxes. 

CONVENTION EXAMPLE

text highlighted in blue Click text highlighted in blue to go to other information in the PDF. When you are using 
the help desk in COMSOL, links to other modules, application examples, and 
documentation sets also work.

boldface font A boldface font indicates that the given word(s) appear exactly that way on the 
COMSOL Desktop (or, for toolbar buttons, in the corresponding tooltip). For example, 
the Model Builder window is often referred to, and this is the window that contains the 
model tree. As another example, the instructions might say to click the Zoom 
Extents button ( ), and this means that when you hover over the button with your 
mouse, the same label displays on the COMSOL Desktop.

italic font An italic font is the introduction of important terminology. Expect to find an 
explanation in the same paragraph or in the Glossary. The names of other documents in 
the COMSOL documentation set are also in italic font.

Forward arrow symbol > The forward arrow symbol > means you select a series of menu items or nodes in a 
specific order. For example, Component>Mesh is equivalent to: Under the Component 
node, click the Mesh node.

code (monospace) font A code (monospace) font means you make a keyboard entry in the COMSOL Desktop. 
You might see an instruction such as “Enter (or type) 1.25 in the Current density field.” 
The monospace font is also used to indicate programming code and variable names. 

Italic code (monospace) 
font

An italic code (monospace) font indicates user inputs and parts of names that can vary 
or be defined by the user.

Arrow brackets <> 
following the code 
(monospace) or code 
(italic) fonts

The arrow brackets included in, for example, programming examples (after a 
monospace code or an italic code font) mean that the content in the string can be 
freely chosen or entered by the user, such as a feature Name or Label. For example, 
model.geom(<label>), where <label> is the geometry’s label.

When the string is predefined by COMSOL Multiphysics, no bracket is used and this 
indicates that this is a finite set, such as a feature type. 

ICON NAME DESCRIPTION

Caution A Caution icon indicates that the user should proceed carefully and consider the next steps. 
It might mean that an action is required, or if the instructions are not followed, that there will 
be problems with the model solution.

Important An Important icon indicates that the information provided is key to the model building, 
design, or solution. The information is of higher importance than a note or tip, and the user 
should endeavor to follow the instructions.

Note A Note icon indicates that the information can be of use to the user. It is recommended that 
the user reads the text.

Tip A Tip icon is used to provide information, reminders, shortcuts, suggestions for improving 
model design, and other information that might be useful.

See Also The See Also icon indicates that other useful information is located in the named section. If 
you are working online, click the hyperlink to go to the information directly. When the link is 
outside of the current PDF document, the text indicates this, for example, “See The 
Laminar Flow Interface in the COMSOL Multiphysics Reference Manual.” Note that if 
you are in the online help, the link works.



52 |  C H A P T E R  1 :  I N T R O D U C T I O N

An 
example 
from the 
Application 
Libraries

The icon is used in the documentation to indicate examples that demostrate the use of some 
functionality. In some cases, an example is only available if you have a license for a specific 
module. The Application Library path describes how to find the actual file in COMSOL 
Multiphysics, for example:

If you have the RF Module, see Radar Cross Section: Application Library path RF_Module/
Scattering_and_RCS/radar_cross_section

Space Dimension Another set of icons is used in the Model Builder — the component space dimension is 
indicated by 1D axial symmetry , 2D , 2D axial symmetry , and 3D  icons. The 
1D and 0D icons are not used but the space dimension is indicated. These icons are also 
used in the documentation to list the differences to a physics interface, node, or theory 
section, which are based on space dimension.

Windows This icon means that the information is specific to a Microsoft Windows operating system.

macOS This icon means that the information is specific to a macOS operating system. This may also 
be referred to as cross-platform when describing how to access a feature or menu on the 
COMSOL Desktop.

Linux This icon means that the information is specific to a Linux operating system. This may also be 
referred to as cross-platform when describing how to access a feature or menu on the 
COMSOL Desktop.

ICON NAME DESCRIPTION
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Ove r v i ew o f  t h e  R e f e r e n c e  Manua l

This COMSOL Multiphysics Reference Manual provides comprehensive information about all modeling steps 
using the COMSOL Multiphysics software. See the individual module manuals for information specific to a 
specialized module (see The COMSOL Multiphysics Modules and Interfacing Options for a link to the COMSOL 
website). 

T A B L E  O F  C O N T E N T S ,  G L O S S A R Y ,  A N D  I N D E X

To help you navigate through this guide, see the Contents, Glossary, and Index.

E N V I R O N M E N T

The COMSOL Modeling Environment chapter provides an overview of the COMSOL modeling environment as 
controlled by the COMSOL Desktop and the tools and windows it provides in the Windows version as well as the 
cross-platform version. Topics include The COMSOL Desktop, The Application Libraries Window, The Physics 
Interfaces, Creating a New Model with the Model Wizard, and a key to the icons including links in the Toolbars 
and Keyboard Shortcuts section.

M O D E L I N G

Building a COMSOL Multiphysics Model explains a range of methods and topics including information about the 
following: details about an introduction to The Model Builder, The Component Node, The Physics Nodes, 
Selecting Physics Interfaces, Analyzing Model Convergence and Accuracy, Specifying Model Equation Settings, 
Boundary Conditions, Using Units, Numerical Stabilization, and much more.

C U S T O M I Z I N G  T H E  C O M S O L  D E S K T O P

In the Customizing the COMSOL Desktop chapter, the settings are described related to Customizing a Model, 
changing Preferences Settings, and details about the Showing More Options.

D E F I N I T I O N S

The Global and Local Definitions chapter describes the global and local (component) definitions features. 
Depending on the geometric scope, you add the nodes described in this section to either the Global Definitions 
node or under the Definitions node for a particular component. Topics include Operators, Functions, and 
Constants, Predefined and Built-In Variables, Mass Properties, Functions, Nonlocal Couplings and Coupling 
Operators, Coordinate Systems, Identity and Contact Pairs, Probes, and Infinite Elements, Perfectly Matched 
Layers, and Absorbing Layers.

V I S U A L I Z A T I O N  A N D  S E L E C T I O N

The Visualization and Selection Tools chapter describes the tools used to visualize and control how you view 
models and select parts of the model geometry in the Graphics window and the Settings windows. Important topics 
include Working with Geometric Entities, Creating Named Selections, and User-Defined Views.

G E O M E T R Y

The Geometry Modeling and CAD Tools chapter covers geometry modeling in 1D, 2D, and 3D with examples of 
solid modeling, boundary modeling, Boolean operators, and other CAD tools in COMSOL. In addition, it shows 
how to use the tools for exploring geometric properties, such as volumes and surfaces. There is also information 

As detailed in the section COMSOL Documentation and Help this information can also be 
searched from the Help system in COMSOL Multiphysics. 
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about using external CAD data. Topics include Creating a Geometry for Analysis, Working with Geometry 
Sequences, Geometric Primitives, Geometry Operations, and Virtual Geometry and Mesh Control Operations.

M E S H

The Meshing chapter summarizes how to create and control your mesh for 1D, 2D, and 3D geometries in the 
COMSOL Multiphysics software. It also explains these topics, which include: Creating a Mesh for Analysis, 
Meshing Techniques, Meshing Operations and Attributes, and Importing and Exporting Meshes.

M A T E R I A L

The Materials chapter introduces you to the material databases included with the COMSOL products. Topics 
include a Materials Overview, Working with Materials, Material Properties Reference, User-Defined Materials and 
Libraries, Using Functions in Materials, and Module-Specific Material Databases.

A C / D C

The AC/DC Interfaces chapter explains the physics interfaces available for modeling electromagnetics, which you 
find under the AC/DC branch ( ) when adding a physics interface. It also contains sections about general 
fundamentals and theory for electric fields.

A C O U S T I C S

The Pressure Acoustics Interface chapter describes how to use the Pressure Acoustics, Frequency Domain interface, 
found under the Acoustics branch ( ) when adding a physics interface, for modeling and simulation of acoustics 
and vibrations.

C H E M I C A L  S P E C I E S  T R A N S P O R T

The Chemical Species Transport Interfaces chapter explains how to use the Transport of Diluted Species interface, 
found under the Chemical Species Transport branch ( ) when adding a physics interface, to model and simulate 
mass transfer by diffusion and convection based on Fick’s law of diffusion.

F L U I D  F L O W

The Fluid Flow Interface chapter explains how to use the Laminar Flow interface, found under the Fluid 
Flow>Single-Phase Flow branch ( ) when adding a physics interface, to model and simulate fluid mechanics for 
laminar, incompressible fluids.

H E A T  T R A N S F E R

The Heat Transfer Interfaces chapter describes the different types of Heat Transfer interfaces (Heat Transfer in 
Solids and Heat Transfer in Fluids), and the Joule Heating interface, all found under the Heat Transfer 
branch ( ) when adding a physics interface.

S O L I D  M E C H A N I C S

The Solid Mechanics chapter explains how to use the Solid Mechanics interface, found under the Structural 
Mechanics branch ( ) when adding a physics interface, to simulate and analyze applications involving solid 
mechanics. The physics interface is used for stress analysis and general solid mechanics simulation.

E Q U A T I O N - B A S E D  M O D E L I N G

The Equation-Based Modeling chapter describes the use of the mathematics interfaces, found under the 
Mathematics branch ( ) when adding a physics interface, which are used for equation-based modeling. With 
those interfaces you can solve various types of PDEs using different formulations. You can also solve ODEs and 
other global equations, add events and curvilinear coordinates, compute sensitivities, and add moving interfaces 
and deforming meshes.
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S E N S I T I V I T Y  A N A L Y S I S

The Sensitivity Analysis chapter describes how to perform sensitivity analysis using the Sensitivity interface, found 
under the Mathematics>Optimization and Sensitivity ( ) branch when adding a physics interface.

D E F O R M E D  M E S H E S

The Deformed Geometry and Moving Mesh chapter explains how to use the modeling physics interfaces that 
control mesh deformation. These are found under the Mathematics>Deformed Mesh ( ) branch when adding a 
physics interface. It also contains fundamentals about deformed meshes and information about the Eulerian and 
Lagrangian formulations of the physics, the frame types that support these formulations, and the arbitrary 
Lagrangian-Eulerian (ALE) method.

S T U D I E S  A N D  S O L V E R S

The Studies and Solvers chapter lists the various types of solvers and studies in the COMSOL Multiphysics software 
and explains the study steps and solver configurations. It also describes the major solvers and settings as well as batch 
jobs, parametric sweeps, and cluster computing. See also the Optimization Module Manual for other 
supplementary information.

R E S U L T S  A N D  V I S U A L I Z A T I O N

The Results Analysis and Plots chapter helps you analyze results in COMSOL Multiphysics and describes numerous 
result-evaluation and visualization tools, including advanced graphics, data display, and export functions. Topics 
include Results Overview, Datasets, Plot Groups and Plots, Derived Values, Evaluation Groups, and Tables, 
Exporting Data and Images, Reports, and Printing and Capturing Screenshots.

R U N N I N G  C O M S O L  M U L T I P H Y S I C S

Running COMSOL Multiphysics is an overview of the different ways that you can run the COMSOL Multiphysics 
software in addition to running the COMSOL Desktop on a dedicated computer, including client-server and 
distributed-memory architectures and cloud-based computing. This chapter also includes information about how 
to compile COMSOL applications from the command line using COMSOL Compiler.
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T h e  C O M S O L  M o d e l i n g  E n v i r o n m e n t

The COMSOL Desktop® provides a complete and integrated modeling 
environment for creating, analyzing, and visualizing multiphysics models. This 
chapter provides an overview of the COMSOL Multiphysics® modeling 
environment as controlled by the COMSOL Desktop and the tools and windows 
it provides.

In this chapter:

• The COMSOL Desktop

• The Application Libraries Window

• The Physics Interfaces

• Creating a New Model

• Toolbars and Keyboard Shortcuts
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Th e  COMSOL De s k t o p

This section is an overview of the major components in the COMSOL Multiphysics environment. These 
components are integrated into the COMSOL Desktop, which you can personalize to your own modeling needs 
and preferences. Primarily consisting of the Model Builder nodes, Settings windows, and Graphics windows, other 
dockable windows can be opened, closed, and organized according to the modeling settings you need to access and 
the GUI configuration you want to work in. You can save these configurations, and the last opened configuration 
is always displayed when you open COMSOL again.

• Creating a New Model

• Building a COMSOL Multiphysics Model

• Customizing the COMSOL Desktop

• The Model Builder

The COMSOL Desktop in the cross-platform version, primarily for the Linux and macOS 
operating systems, looks slightly different than for the Windows operating system (shown in 
Figure 2-1). The primary difference is that the Main Menu and Main Toolbar are used instead of 
ribbons. Otherwise, the default windows (Model Builder, Graphics, Settings, Log, Progress, and 
Messages) are in the same location on the default desktop layout. See The COMSOL Desktop 
Menus and Toolbars for more details.

You can also launch the cross-platform version on Windows using comsolxpl.exe.
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Figure 2-1: The default COMSOL Desktop with its major windows in a widescreen layout. The ribbon tabs and groups 
are available for Windows users. For macOS and Linux users the layout is similar but you access some options from the 
main menu or contextual toolbars. 

A ribbon tab, ribbon group, or modal ribbon tab, are available in the Windows version. In general, 
these are referred to as toolbars. See Figure 2-1 for an example of the Windows Home toolbar. Also 
see Figure 2-2 for an example of how the ribbon changes when a window is resized.

The Model Toolbar and Contextual Toolbar are available in the cross-platform version, primarily 
for macOS and Linux users. See Figure 2-12 for an example of these toolbars.

Settings Messages Progress Log GraphicsModel Builder

File menu Customizable Quick 
Access Toolbar

Ribbon tab and 
toolbar

Contextual tab Ribbon group
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A B O U T  C H A N G E S  T O  T H E  R I B B O N  D I S P L A Y  ( W I N D O W S  U S E R S )

When the complete COMSOL Desktop is resized, the toolbar collapses and the buttons are grouped into menus. 
In Figure 2-2, all the groups in the Home toolbar are collapsed into menus. As the window is widened, the ribbon 
groups expand again to include the options as buttons or other submenus.

Figure 2-2: When the COMSOL Desktop is resized, the ribbon toolbar buttons are grouped together with the ribbon tab 
group name. In this example for the Home toolbar, all the buttons are available from a menu, such as Definitions, 
Geometry, Material, Physics, and so forth (top). As the window is widened, the menus expand accordingly (bottom).

O P E N I N G  T H E  A P P L I C A T I O N  B U I L D E R  F R O M  T H E  C O M S O L  D E S K T O P

When you are on the COMSOL Desktop you can toggle between the Application Builder and COMSOL 
Multiphysics. In the Home toolbar click Application Builder  to open the Application Editor and modify the user 
interface of the application and to create and edit code for the application. You can also press Ctrl+Shift+A.

Conversely, when you are in the Application Builder, you can click Model Builder  in the Home toolbar to return 
to COMSOL Multiphysics. You can also press Ctrl+Shift+M.

O V E R V I E W

The rest of this section introduces you to the features of the COMSOL Desktop, explains some basic navigation, 
and provides you with an overview of the windows, toolbars, and menus available. In this chapter you will also learn 
about the model file formats, the options to save files, and the units systems available for modeling.

• Basic Navigation

• Adjusting Window Location and Size on the Desktop

• The COMSOL Desktop Windows

• The COMSOL Desktop Menus and Toolbars

• Windows Toolbars and Menus

• Cross Platform (macOS and Linux) Toolbars and Menus

• Features Available on Toolbars and From Menus

• The Messages Window

• About the COMSOL Model File Formats

• Saving COMSOL Files

• Saving and Opening Recovery Files

• The Root Settings and Properties Windows

• Unit Systems

After this introductory overview, The Application Libraries Window section explains how to work with the 
application libraries included with the COMSOL Multiphysics products. The Physics Interfaces section lists the 
interfaces available with a basic COMSOL Multiphysics license. This prepares you to start creating a new model.
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The next section, Creating a New Model, shows you how to use the Model Wizard to begin building a new model 
by choosing a physics interface and study combination.

The last section, Toolbars and Keyboard Shortcuts, is a quick reference to all the features found on the toolbars. It 
includes links to the information contained throughout this reference manual.

Basic Navigation

Basic navigation on the COMSOL Desktop extensively involves the nodes in the Model Builder as well as moving 
between windows and sections on Settings windows.

W O R K I N G  W I T H  N O D E S  I N  T H E  M O D E L  B U I L D E R

The following methods are available to select nodes, expand and collapse branches, open the Settings window, or 
move up and down the nodes in the model tree:

• Click a node in the Model Builder to highlight it and to open the associated Settings window. See Settings and 
Properties Windows for Feature Nodes. You can also adjust how you are Displaying Node Names, Tags, and 
Types in the Model Builder.

• Once a node is highlighted, there are many things you can do; for example, you can copy, duplicate, delete, and 
move most nodes around. See Copying, Pasting, and Duplicating Nodes, Moving Nodes in the Model Builder, 
and Clearing Sequences and Deleting Sequences or Nodes. 

• Right-click a node to open a context menu. See Opening Context Menus and Adding Nodes.

• Group related nodes together, for better overview and structure for the model tree. See Custom Grouping of 
Nodes.

• When a node is highlighted, use the up arrow key on the keyboard to move to the node above; to move to the 
node below, use the down arrow key.

• To expand a branch to display all nodes in the branch, click the small left-pointing white triangle next to the 
branch icon in the model tree, or press the right arrow key. To collapse a branch to display only the main branch 
node, click the small downward-right pointing black triangle next to the branch icon in the model tree, or press 
the left arrow key. See The Model Builder Toolbar for information about how to collapse or expand all branches.

• A highlighted node is also dynamic and its appearance can change based on where in the modeling process you 
are. See Dynamic Nodes in the Model Builder for a list of these visual cues.

M O V I N G  B E T W E E N  W I N D O W S  A N D  S E C T I O N S  O N  T H E  C O M S O L  D E S K T O P

Keyboard shortcuts are quick ways to navigate between the windows on the COMSOL Desktop and to switch focus 
between windows and Settings window sections:

• Press Ctrl+Tab to switch focus to the next window on the desktop.

• Press Ctrl+Shift+Tab to switch focus to the previous window in the desktop.

• Press Ctrl+Alt+left arrow to switch focus to the Model Builder window.

• Press Ctrl+Alt+right arrow to switch focus to the Settings window.

The COMSOL Desktop Menus and Toolbars
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• Press Ctrl+Alt+up arrow to switch focus to the previous section in the Settings window.

• Press Ctrl+Alt+down arrow to switch focus to the next section in the Settings window.

Adjusting Window Location and Size on the Desktop

M O V I N G  A N D  R E S I Z I N G  T H E  W I N D O W

• To move a window, click-and-drag the window tab (the tab is where the window name displays, Model Builder 
for example) to where you want it.

• To resize a window, hover your mouse over the window borders until a double arrow displays. Click-and-drag 
the borders between windows until the layout appears as you want it to be.

C L O S I N G  A  W I N D O W

Not all windows in the COMSOL Desktop are closable. Windows that you can close have an X to the right of the 
window tab. Click that X, right-click the window and choose Close, or press Ctrl+F4 (Command+W on macOS). 
You can reopen a closed window by choosing it from the Windows menu (on the Home toolbar in the Windows® 
version), for the Properties and Statistics window, by right-clicking a node and choosing Properties or Statistics (for 
mesh statistics), respectively.

Figure 2-3: Click the X to close the Properties window. The Settings window cannot be closed.

The section Keyboard Shortcuts lists additional shortcuts for all operating systems.

• The COMSOL Desktop

• The Model Builder

• Creating a New Model

At any time, in the Home toolbar, Layout group, click the Reset desktop  button.
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F L O A T I N G / D E T A C H I N G  A  W I N D O W

H I D I N G  O R  P I N N I N G  A  W I N D O W  T O  T H E  S I D E  O F  T H E  D E S K T O P  ( W I N D O W S  U S E R S )

To hide a window, right-click the window and select Hide. The window is minimized along the side of the Desktop 
(see Figure 2-4). Hover over the name to view a hidden/minimized window. To restore a hidden window, either 
right-click the window, or from the list, select Float or Dock.

Pinning a window performs the same action as hiding it. Click the Toggle hide button  in the top-right corner 
of any window to hide and pin it to the side of the COMSOL Desktop. To return the window to its unhidden state, 
hover over the window name to open it, then click the Toggle hide button (now laying on its side, see Figure 2-4) 
to restore the window to its default location. 

Figure 2-4: A hidden window is minimized along the side of the Desktop. Hover over the window name to view it. You 
can then choose to Float or Dock the window (either right-click the window or choose options from the menu), or click the 
Toggle hide icon to restore it to the default location on the Desktop.

U S I N G  T H E  P O S I T I O N  G U I D E S  ( W I N D O W S  U S E R S )

When customizing your COMSOL Desktop, or when you want to return a floating window to the Desktop (dock 
it), there are several visual guides available to assist.

Click and hold the mouse on a window to reposition or dock it on the Desktop. This displays the positioning guides 
(Figure 2-5 and Figure 2-6). Drag the window over any of the guides to highlight the area where the window is to 
be placed on the desktop (Figure 2-6). The center guide has five options. There are two vertical positioning guides, 

To detach a window to move and resize it, right-click the window tab and select Float. Right-click 
the window and choose Dock to return it to its default location on the Desktop.

To detach a window to move and resize it, right-click the window tab and select Detached. 
Right-click and select the option again to dock it to the COMSOL Desktop, or drag and drop it 
back to where you want it.

When you hide a window, it is minimized along the 
side of the Desktop. Hover over the name to view 
the window.
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one on the left and one on the right of the Desktop and two horizontal positioning guides, one on the top and one 
on the bottom of the Desktop.

Figure 2-5: Examples of the positioning guides.

Figure 2-6: The positioning guides display (top image) when you click and hold the mouse pointer on a window. Drag 
the window over any of the guides to see the highlighted light blue area, which indicates the destination for the window. 
Release the mouse button and the window drops into place (bottom image).



T H E  C O M S O L  D E S K T O P  |  65

R E S I Z A B L E  T A B L E S  A N D  T E X T  A R E A S  ( W I N D O W S  U S E R S )

Some tables and text areas are resizable so that you can drag the area to extend it if it contains a lot of text. A border 
that you can drag to resize a table or text area is indicated by a thicker line:

Figure 2-7: You can click and drag the thicker bottom border to resize the Material Overview table.

You can also click the >> button in the top-left corner to expand the table to show its contents. If you click at the 
border between two columns in a table, you can then drag to resize the column to the left of the border, or 
double-click to resize that column to fit its contents.

S E L E C T I N G ,  C O P Y I N G ,  A N D  P A S T I N G  I N  T A B L E S

In tables of parameters or variables, for example, you can select a row by clicking in one of the cells, and you can 
select multiple rows by Shift-clicking to select a range of rows or Ctrl-clicking to select a deselect a single row. 
Pressing Ctrl+A when you are editing a cell selects all text in the cell. If you are not editing a cell, the pressing 
Ctrl+A select the entire table. You can right-click selected rows in a table and choose Select All.

You can also right-click to Cut, Copy, and Paste the selected table rows. Alternatively, you can use the corresponding 
keyboard shortcuts Ctrl+X, Ctrl+C, and Ctrl+V, respectively.

M O V I N G ,  M I N I M I Z I N G ,  A N D  M A X I M I Z I N G  W I N D O W S  ( M A C O S  A N D  L I N U X )

• Right-click the window tab and select Move>View (to move a separate window). Move the mouse to where you 
want the window to display and left-click to confirm the move.

• Right-click the window tab and select Move>Tab Group (to move several tabbed windows) from the list. Move 
the mouse to where you want to the group of windows to display and left-click to confirm the move. 

• To resize a window, hover the mouse over the left, right, top, or bottom boundaries of the window until a double 
arrow displays. Drag the mouse to resize the window. Or right-click the window tab and select Size>Left, Right, 
Top, or Bottom. A blue line highlights the choice; drag to resize.

• To maximize and restore a window’s original position, double-click a window tab to maximize it; double-click 
again to restore it.

• Click the Minimize or Maximize button in the top-right corner or right-click the window tab and select Minimize 
or Maximize from the list.

At any time, click the Reset desktop  button in the main toolbar. The section Keyboard 
Shortcuts has additional shortcuts for all operating systems.
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V E R T I C A L  O R  H O R I Z O N T A L  W I N D O W  O R I E N T A T I O N  ( M A C O S  A N D  L I N U X )

After a window is minimized along the side of the COMSOL Desktop, you also have the option to change the 
window Orientation to Vertical (the default) or Horizontal when you click the window icon (see Figure 2-8). 

Figure 2-8: A minimized window is accessible to the left of the Desktop. Click the window icon to view it. You can then 
right-click the window to Move, Size, Minimize or Maximize the window. You can also change the Orientation of a 
minimized window to be Horizontal or Vertical when you click and view it on the Desktop in its minimized state.

The COMSOL Desktop Windows

The COMSOL Desktop windows, including those shown in Figure 2-1, are integral to building your model. The 
windows listed in Table 2-1 are described throughout the documentation and the table includes links to this 
information. You can open windows that are currently not open in the COMSOL Desktop by choosing them from 
the Windows menu. The Model Builder, Settings, Graphics, and Statistics (for mesh statistics) windows cannot be 
closed and are therefore not available in the Windows menu.

• The COMSOL Desktop

• The Model Builder

• Creating a New Model

TABLE 2-1:  COMSOL DESKTOP WINDOWS

WINDOW NAME AND LINK DESCRIPTION

BUILDING A MODEL

The Model Wizard Start building a model by choosing the Component space dimension, physics 
interfaces, and study.

The New window Open the New window to begin modeling using the Model Wizard to start with a 
Blank Model. See Open a New Window to Begin Modeling.

The Model Builder Control the modeling procedure using the model tree. This window has all the 
functionality and operations for building and solving models and displaying the 
results. 

The Graphics Window This window is a graphical view of the geometry, mesh, and results of the model. 
It also has useful tools to change the view and select multiple geometric entities, 
for example.

The Material Browser Window Browse the material libraries and load materials into your models.

The Add Material Window Add predefined materials. 

Part Libraries The Part Libraries contain collections of geometry parts, which serve as more 
advanced geometric primitives specially created for an application area.

The Add Physics Window Add physics interfaces.

The Add Multiphysics 
Window

Add applicable multiphysics couplings.

When you minimize a window, it is 
available to the left of the Desktop. Click 
the button to view the window.
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The Settings and Properties 
windows

When a node is clicked in the Model Builder a corresponding Settings window 
opens with the same name as the node. It is a window with settings that define 
operations and properties specific to that node. The Properties window is 
accessed from the context menu and displays other node properties. See Settings 
and Properties Windows for Feature Nodes.

The Selection List Window Choose objects, for example, while working with complex geometries and when 
you need to easily locate a geometric entity that is not easily viewed.

The Message window for 
geometry measurements

A tool used to measure geometry objects and entities. See Measuring Geometry 
Objects.

The Find Results window Displays search results from searches performed using the Find tool. See 
Searching and Finding Text.

The Recovery Files window Displays any existing recovery files and provides tools for opening, saving, and 
deleting recovery files. See Saving and Opening Recovery Files.

The Add-in Libraries Window Add an available add-in in the Model Builder from the list of add-in in this window.

RESULTS AND ANALYSIS

The Add Study Window Add a study or studies to models. 

The Plot Windows Plot windows are also graphics windows. These plot windows display convergence 
results and monitor probe values while solving, for example. 

The Table window Displays the results from integral and variable evaluations defined in Derived 
Values nodes or by Probes and stored in Table nodes. It also displays results from 
nodes under an Evaluation Group node. See The Table Window and Tables 
Node.

The Messages Window Contains information useful after an operation is performed.

The Progress Window Displays the progress of the solver or mesher during the process, including a 
progress bar and progress information for each solver or mesher. 

The Log Window Contains information from previous solver runs, including convergence 
information, solution time, and memory use. 

The Debug Log window Contains debug information for model methods. See the Application Builder 
documentation for more information about debugging methods.

The External Process Window Follow external processes (such as distributed batch jobs) that have been started. 
The window updates when you are attached to the external processes. 

The Mesh Statistics Window This window includes information about the minimum and average mesh element 
quality and a mesh element quality histogram, which shows the relative frequency 
of mesh elements with different quality values.

Comparing Models and 
Applications

This window includes the resulting differences from a comparison of models or 
applications.

APPLICATION EXAMPLES

The Application Libraries 
Window

Displays all the models and applications included with an installation. The folders 
contain models and applications specific to the installed module.

The Application Library 
Update Window

A service that provides new and updated models and applications for each of the 
application libraries of the COMSOL products that your license includes.

HELP AND DOCUMENTATION

The Help Window and 
Topic-Based Help

Provides access to context help in the COMSOL Desktop. 

TABLE 2-1:  COMSOL DESKTOP WINDOWS

WINDOW NAME AND LINK DESCRIPTION
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The COMSOL Desktop Menus and Toolbars

The menus and toolbars available from the COMSOL Desktop vary slightly between operating systems. However, 
the variations are subtle and the overall functionality remains the same. 

The sections Windows Toolbars and Menus and Cross Platform (macOS and Linux) Toolbars and Menus show 
examples of the main terms and locations of the toolbars and menus. 

The Model Builder toolbar is the same for all platforms and is described in this section. 

The Features Available on Toolbars and From Menus section details the available features and functions. 

T H E  M O D E L  B U I L D E R  T O O L B A R

The Model Builder toolbar is the same for all operating systems. It is located at the top of the window as shown in 
Figure 2-9. The actions listed in Table 2-2 are used to navigate the Model Builder tree. 

Figure 2-9: The Model Builder toolbar for Windows (left) and macOS and Linux (right). 

Windows Toolbars and Menus

The available ribbon toolbar options are dynamic, based on where in the model you are working and what is 
logically available for a specific task. When a blank model is created, only the default tabs are included (Model, 
Definitions, Study, and Results). The Physics, Geometry, and Mesh tabs are added once a model and physics 
interface are added to the Model Wizard, as shown in Figure 2-10. 

The top of the COMSOL Desktop includes a customizable Quick Access Toolbar. Underneath this are ribbon tabs 
and ribbon groups, which together, are referred to as toolbars. The Home toolbar is a collection of frequently used 
features from all the other toolbars. For documentation purposes, a toolbar uses the same name as the tab. For 

The Documentation Window Navigate to PDF or HTML versions of the documentation (availability is based on 
your license), as well as Search, Bookmark, Print Topics, and Link with Contents.

The Root Settings and 
Properties Windows

The root node is the topmost level of the Model Builder tree. When you click this 
node, the root node’s Settings window opens and includes detailed information 
about the model file.

• Creating a New Model

• The COMSOL Desktop

• COMSOL Documentation and Help

• Toolbars and Keyboard Shortcuts

• The COMSOL Desktop

• Creating a New Model

• The Toolbars and Keyboard Shortcuts section has detailed information about the contextual 
toolbars available on the COMSOL Desktop.

TABLE 2-1:  COMSOL DESKTOP WINDOWS

WINDOW NAME AND LINK DESCRIPTION
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example, the Home toolbar, Physics toolbar, Geometry toolbar, or Study toolbar. See The Model Builder Toolbar and 
Features Available on Toolbars and From Menus for a detailed list of all the features available. 

Figure 2-10: The Quick Access Toolbar can be positioned above or below the ribbons. You can also customize the toolbar 
to include or exclude a variety of buttons.

C U S T O M I Z E  T H E  Q U I C K  A C C E S S  T O O L B A R

The Quick Access Toolbar has several default buttons that can be displayed above or below the ribbon. Click the 
small arrow at the end of the toolbar to open the Customize the Quick Access Toolbar list. You can either edit which 
of the default buttons display directly from the list, or click More Commands to Add and Remove (or double-click to 
add or remove) the buttons as detailed in the section Features Available on Toolbars and From Menus. This can 
also be done in The Preferences Dialog Box in the Quick Access Toolbar section.

K E Y B O A R D  S H O R T C U T S  F O R  T H E  Q U I C K  A C C E S S  T O O L B A R

You can use numeric keyboard shortcuts for the buttons on the Quick Access Toolbar. To activate those keyboard 
shortcuts, press the Alt key. The keyboard shortcuts (1, 2, 3, and so on) then appear underneath the Quick Access 
Toolbar (see the following screenshot).

Figure 2-11: Pressing the Alt key displays the keyboard shortcuts for the Quick Access Toolbar.

D I S P L A Y  T H E  Q U I C K  A C C E S S  T O O L B A R  A B O V E  O R  B E L O W  T H E  R I B B O N

Right-click a ribbon to select Show Quick Access Toolbar Above the Ribbon or Show Quick Access Toolbar Below the 

Ribbon. These options are also available from the Customize Quick Access Toolbar menu. See Figure 2-10.

Select Minimize the Ribbon. To restore the ribbon, right-click anywhere in the top of the window and click Minimize 

the Ribbon to deactivate it (remove the check mark).

M I N I M I Z E  ( H I D E )  T H E  R I B B O N

Right-click anywhere on a ribbon and choose Minimize the Ribbon to hide the ribbon on the Desktop. To access the 
ribbon features, click the ribbon tab name (for example, Model, Definitions, or Study). The ribbon features are then 
available. To restore the ribbon to the top of the Desktop, right-click in the tab name area and click to remove the 
check mark next to Minimize the Ribbon.

Cross Platform (macOS and Linux) Toolbars and Menus

For cross-platform users (primarily macOS and Linux), the Main Toolbar is similar to the Quick Access Toolbar for 
Windows. In addition, there is a Model Toolbar and a variety of Contextual Toolbars available. These are a mixture of 

The Quick Access Toolbar displays above the 
ribbon by default. Click the small arrow at the 
end to customize the toolbar.
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drop-down menus and buttons for frequently used actions. For documentation purposes, a toolbar uses the same 
name as the contextual toolbar. For example, the Physics toolbar, Geometry toolbar, or Study toolbar. See The Model 
Builder Toolbar and Features Available on Toolbars and From Menus for a detailed list of all the features available.

The Contextual Toolbar changes when you click a Definitions, Geometry, Mesh, Study, or Results node in the Model 

Builder. The Model Toolbar and Contextual Toolbar are similar to the ribbon toolbars for a Windows operating 
system. 

Figure 2-12: The menu and toolbar options for cross-platform users (usually macOS and Linux operating systems). Only 
part of the Model Toolbar and Contextual Toolbars are shown. When one of the buttons is clicked on this toolbar, the 
associated toolbar opens, in this example for the Definitions node. This toolbar also opens when the Definitions node is 
clicked in the Model Builder.

D I S P L A Y  O R  H I D E  T H E  T O O L B A R S  F R O M  T H E  T O O L S  M E N U

From the Tools menu, you can choose to display or hide each toolbar. Select Main Toolbar, Model Toolbar, or 
Contextual Toolbar to turn that toolbar on or off in the COMSOL Desktop. For the Toolbar Button Label, you can 
also choose to Show Icon Only or Show Icon and Text. When Show Icon and Text is on it adjusts what is available on 
the toolbar as some buttons in the Model Toolbar display the text, while others have the label when you hover over 
the button. Finally, choose the Toolbar Display Mode as Normal or Compact. Compact compresses some buttons in the 
Contextual Toolbar and Model Toolbar under menus. 

O T H E R  U S E F U L  F U N C T I O N S  A V A I L A B L E  F R O M  T H E  W I N D O W S  M E N U

From the Windows menu there are also other useful functions:

• Open a variety of useful windows. See The COMSOL Desktop Windows for a list and links to applicable sections. 

• From the Model Builder Node Label submenu, choose a way to label the nodes in the Model Builder. See 
Displaying Node Names, Tags, and Types in the Model Builder.

• From the Desktop Layout submenu, choose a Widescreen or Regular Screen layout, or Reset the Desktop. See 
Customizing the Desktop Layout.

Features Available on Toolbars and From Menus

The features listed in Table 2-2 are often accessed from multiple locations. In general, the button or menu option 
is located as follows, with some minor differences between Windows and the cross-platform (macOS and Linux) 

You can also launch the cross-platform version on Windows using comsolxpl.exe.

If you are using a Regular Screen Layout and want to view all available buttons, the optimal settings 
are to set the Toolbar Button Label to Show Icon Only and the Toolbar Display Mode to Compact. 

Main toolbarMain menu Tools menu

Contextual toolbar displaying in Normal mode

Model toolbar 

Definitions toolbar 
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systems and as described in Windows Toolbars and Menus and Cross Platform (macOS and Linux) Toolbars and 
Menus.

• The File menu. See Figure 2-10 (Windows) and Figure 2-12 (macOS and Linux).

• The Model Builder toolbar. See Figure 2-9.

• The Quick Access Toolbar (Windows only; see Figure 2-10). Customize the toolbar to access some of the buttons 
listed in the table.

• Main Menu and a Main Toolbar (macOS and Linux, see Figure 2-12).

• Additional menus along the top of the Desktop: Edit, Windows, Options. Tools, and Help (macOS and Linux, see 
Figure 2-12).

TABLE 2-2:  FEATURES AVAILABLE ON VARIOUS TOOLBARS AND FROM MENUS

ICON NAME DESCRIPTION OR LINK TO MORE INFORMATION

Creating Models

New (Ctrl+N) Open the New window to begin modeling using the Model Wizard or start with a 
Blank Model. See Creating a New Model.

For all users, this is available from the File menu. It is also available on the Quick 
Access Toolbar (Windows users) or the Main Toolbar (cross-platform users).

Additional options are available when check boxes are enabled on the Preferences 
dialog box under Physics Builder.

Blank Model Start a new blank model without any settings. This command is available after choose 
File>New. It is also available on the Quick Access Toolbar (Windows users).

Working in the Application Builder

Application Builder 
(Ctrl+Shift+A)

Toggle between the Application Builder and COMSOL Multiphysics Model Builder 
windows. For Windows users this is available in the Home toolbar and the Developer 
toolbar.

Data Access Add data and properties that can be modified from a running application. For 
Windows users this is available in the Developer toolbar. See Data Access in the 
Application Builder Reference Manual.

Record Method Record changes to the embedded model to a new method. For Windows users this is 
available in the Developer toolbar. See Recording Code in the Application Builder 
Reference Manual.

Test Application 
(Ctrl+F8)

Launch the application in a separate window. For Windows users this is available in 
the Developer toolbar and on the Quick Access Toolbar. See Testing the Application 
in the Application Builder Reference Manual.

Run Application Run an application as a standalone application using a custom user interface. For all 
users, this is available from the File menu. It is also available on the Quick Access 
Toolbar (Windows users).

Compiler Compile an application to run separately from COMSOL Multiphysics or COMSOL 
Server as a standalone executable application. Requires a license for COMSOL 
Compiler.

Opening and Saving Files

Open (Ctrl+O) Open an existing file located on the computer.

For all users, this is available from the File menu. It is also available on the Quick 
Access Toolbar (Windows users) or the Main Toolbar (cross-platform users).
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Recent files From the File menu, select a recent file to open. For Windows users, the file is 
selected from the Recent submenu. For cross-platform users, the most recent files 
are listed at the bottom of the list.

Windows users can also customize the Quick Access Toolbar to access this button.

Find Displays search results from searches performed using the Find tool. Press Ctrl+F. 
Windows users can also customize the Quick Access Toolbar to access this button. 
See Searching and Finding Text.

Application Libraries Open The Application Libraries Window.

For Windows users, this is available in the Home toolbar’s Windows menu or from the 
File menu. You can also customize the Quick Access Toolbar and then click the 
button.

For cross-platform users, this is available from the File menu.

Open Recovery File COMSOL Multiphysics can store recovery files each time you start a solver. This is a 
preference setting that is initially active by default. For all users, this is available from 
the File menu. It is also available on a customized Quick Access Toolbar (Windows 
users).

See Saving and Opening Recovery Files.

Save (Ctrl+S) Save the current file. For all users, this is available from the File menu. It is also 
available on the Quick Access Toolbar (Windows users) or the Main Toolbar 
(cross-platform users).

See Saving COMSOL Files.

Save As Choose to save in one of the COMSOL file formats. The Save As window opens, and 
from the Save as type list select: COMSOL Application (*.mph) (the default), Model file 
for Java (*.java), Model file for MATLAB (*.m), or Model File for Visual Basic (*.vba).

For all users, this is available from the File menu. It is also available on the Quick 
Access Toolbar (Windows users).

See About the COMSOL Model File Formats.

Revert to Saved Opens the last saved version of the file and reinitializes the GUI. For all users, this is 
available from the File menu. It is also available on a customized Quick Access Toolbar 
(Windows users) or the Main Toolbar (cross-platform users).

See Reverting to the Last Saved File.

Compact History The files for Java and for MATLAB contain the entire model history, including settings 
that are no longer part of the model or application. For all users, this is available from 
the File menu. It is also available on a customized Quick Access Toolbar (Windows 
users).

See Compacting the History.

Run Application Run an application created using the Application Builder.

For all users, this is available from the File menu. It is also available on the Quick 
Access Toolbar (Windows users) or the Main Toolbar (cross-platform users).

COMSOL Multiphysics Server

Connect to Server To connect to a server from the COMSOL Desktop. For all users, this is available 
from the File>COMSOL Multiphysics Server menu. It is also available on a customized 
Quick Access Toolbar (Windows users).

See Connecting to a COMSOL Multiphysics Server.

Disconnect from 
Server

To close the connection to the server or MATLAB. For all users, this is available from 
the File>COMSOL Multiphysics Server menu. It is also available on a customized Quick 
Access Toolbar (Windows users).

See Disconnecting from a COMSOL Multiphysics Server.

TABLE 2-2:  FEATURES AVAILABLE ON VARIOUS TOOLBARS AND FROM MENUS

ICON NAME DESCRIPTION OR LINK TO MORE INFORMATION
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Import Application 
from Server

To import a particular application when working with MATLAB, Excel, or the 
COMSOL API. For all users, this is available from the 
File>COMSOL Multiphysics Server menu. It is also available on a customized Quick 
Access Toolbar (Windows users).

See Working with MATLAB, Excel, or the COMSOL API.

Remove 
Applications from 
Server

To delete applications (remove them from the server) that you have created using 
ModelUtil. For all users, this is available from the File>COMSOL Multiphysics Server 
menu. It is also available on a customized Quick Access Toolbar (Windows users).

See Working with MATLAB, Excel, or the COMSOL API.

Model Builder Toolbar

Previous Node 
(Alt+Left)

Next Node 
(Alt+Right)

Navigate back to the node previously selected or to the next node in the sequence. 
See also Keyboard Shortcuts.

Show More Options Click to select options to display from the Show More Options dialog box. See 
Showing More Options.

 Collapse All

Expand All

Click to collapse or expand all nodes in the model tree, except the top nodes on the 
main branch. 

Model Builder Node 
Label

Choose to display any combination of Name, Tag, or Type. See Displaying Node 
Names, Tags, and Types in the Model Builder and Settings and Properties 
Windows for Feature Nodes.

Undo, Redo, Copy, Paste, Duplicate, and Delete

Undo (Ctrl+Z)

Redo (Ctrl+Y)

Undo and Redo the last operation for some operations (such as adding, disabling, 
moving, and deleting nodes in the Model Builder) as well as changing values in the 
Settings window.

For Windows users, this is available on the Quick Access Toolbar.

For cross-platform users, this is available in the Main Toolbar or from the Edit menu.

See Undoing and Redoing Operations.

Copy Copy, paste, and duplicate some features. Also right-click a node to select one of 
these options from the context menu.

For Windows users, this is available on the Quick Access Toolbar.

For cross-platform users, this is available in the Main Toolbar or from the Edit menu.

See Copying, Pasting, and Duplicating Nodes. 

Paste

Duplicate

Delete (Del) Delete some nodes while building a model, or delete a selected geometry object. 
Also press the Del key or right-click a node to select this option from the context 
menu.

For Windows users, this is available on the Quick Access Toolbar.

For cross-platform users, this is available in the Main Toolbar or from the Edit menu.

See Clearing Sequences and Deleting Sequences or Nodes.

TABLE 2-2:  FEATURES AVAILABLE ON VARIOUS TOOLBARS AND FROM MENUS

ICON NAME DESCRIPTION OR LINK TO MORE INFORMATION



74 |  C H A P T E R  2 :  T H E  C O M S O L  M O D E L I N G  E N V I R O N M E N T

Select All To select all or clear the selection of all geometric entities in the Graphics window, 
click the Select All or Clear Selection buttons, respectively. 

For Windows users, this is available on the Quick Access Toolbar. For cross-platform 
users, this is available from the Edit menu.

See Selecting and Clearing Selection of Geometric Entities.

Clear Selection

Other

Reset Desktop Set the COMSOL Desktop back to widescreen or regular screen, or reset it to 
default settings.

For Windows users, this is available in the Home toolbar, in the Layout menu. You can 
also customize the Quick Access Toolbar and then click the button.

For cross-platform users, this is available in the Main Toolbar or from the 
Windows>Desktop Layout menu.

See Customizing the Desktop Layout.

Licensed and Used 
Products

Open the Licensed and Used Products window to list or block the products your 
license includes. See Checking and Controlling Products and Licenses Used.

For Windows users, this is available from the File menu. You can also customize the 
Quick Access Toolbar and then click the button.

For cross-platform users, this is available from the Options menu.

Preferences To make changes to how items are displayed or available throughout the COMSOL 
Multiphysics software. See Preferences Settings.

For Windows users, this is available from the File menu. You can also customize the 
Quick Access Toolbar and then click the button.

For cross-platform users, this is available from the Options menu.

Measure Measure geometric properties such as volumes (see Measuring Geometry Objects). 
Available in the Geometry toolbar. Also, for Windows users, you can customize the 
Quick Access Toolbar and then click the button.

Group (Ctrl+G) Group related and similar nodes under a Group node. Available in several parts of 
the model tree (see Custom Grouping of Nodes). Also, for Windows users, you 
can customize the Quick Access Toolbar and then click the button.

Ungroup 
(Ctrl+Shift+G)

Ungroup nodes that are grouped under a Group node. Available in several parts of 
the model tree (see Custom Grouping of Nodes). Also, for Windows users, you 
can customize the Quick Access Toolbar and then click the button.

Help and Documentation

Help (F1) Open the context help. See COMSOL Documentation and Help.

For Windows users, this is available from the File>Help menu or in the upper-right 
corner of the Desktop.

For cross-platform users, this is available in the Main Toolbar or from the Help menu.

Documentation 
(Ctrl+F1)

Open the Documentation.

For Windows users, this is available from the File>Help menu.

For cross-platform users, this is available in the Main Toolbar or from the Help menu.

See COMSOL Documentation and Help.

Application Gallery Go to the online Application Gallery on the COMSOL website.

For Windows users, this is available from the File>Help menu. For cross-platform 
users, this is available from the Help menu.

TABLE 2-2:  FEATURES AVAILABLE ON VARIOUS TOOLBARS AND FROM MENUS
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The Messages Window

The Messages window ( ) displays by default and contains information useful to you after an operation is 
performed. 

The information in this window includes:

• Details about opening and saving model files such as MPH-files.

• Information about geometry objects imported from CAD files.

• On the Mesh and Geometry toolbars, click the Measure ( ) button to view information about:

- The geometry finalization (forming a union or an assembly) and about the number of geometric entities 
(domains, boundaries, and so on) in the finalized geometry.

- The number of mesh elements and degrees of freedom in the model.

• Solution times.

• Error messages. The messages are in chronological order and can be scrolled through.

By default, the messages are preceded by a timestamp, providing the current date and time for the message. To turn 
off the timestamps, open the Preferences dialog box and clear the Add timestamps to messages check box on the 
General page under Log and messages.

To open the Messages window:

• From the Home toolbar (Windows users) select Windows>Messages.

Support Center Go to the online Support Center on the COMSOL website.

For Windows users, this is available from the File>Help menu. For cross-platform 
users, this is available from the Help menu.

Training Go to the Training page on the COMSOL website.

For Windows users, this is available from the File>Help menu. For cross-platform 
users, this is available from the Help menu.

Check for Product 
Updates

For Windows users, this is available from the File>Help menu. For cross-platform 
users, this is available from the Help menu.

See Checking for Product Software Updates.

Update COMSOL 
Application Libraries

For Windows users, this is available from the File>Help menu. For cross-platform 
users, this is available from the Help menu.

See The Application Library Update Window

Update COMSOL 
Part Libraries

For Windows users, this is available from the File>Help menu. For cross-platform 
users, this is available from the Help menu.

See The Part Library Update Window

About COMSOL 
Multiphysics

For Windows users, this is available from the File>Help menu. For cross-platform 
users, this is available from the Help menu.

See The About COMSOL Multiphysics Box.

TABLE 2-2:  FEATURES AVAILABLE ON VARIOUS TOOLBARS AND FROM MENUS
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• From the main menu (macOS and Linux users) select Windows>Messages.

• To clear the window of all messages, click the Clear button ( ).

About the COMSOL Model File Formats

Below find a list of the COMSOL file formats: MPH-files for applications and models, model files for Java, model 
files for MATLAB, and model files for VBA.

T H E  R O O T  N O D E

When you first open or create a new model, the root node ( ) is the topmost level of the tree. By default, 
unnamed files are called Untitled.mph. The filename changes when the file is saved for the first time, but the root 
node Name does not change for this top level node. See The Root Settings and Properties Windows for details 
about the settings available when this node is clicked.

C O M S O L  M P H - F I L E S

The default standard file format with the extension .mph. The files contain binary and text data. The mesh and 
solution data are stored as binary data, while all other information is stored as plain text.

You can quickly save and load MPH-files. All models and applications in the COMSOL Application Libraries in the 
modules are saved as MPH-files.

The MPH-files in the COMSOL Application Libraries can have two formats:

• Solved MPH-files include all meshes and solutions. In the Application Libraries window these files appear with 
the icon . If the MPH-file’s size exceeds 25MB, a tooltip with the text “Large file” and the file size appears 
when you position the cursor at the node in the Application Libraries tree.

• Compact MPH-files include all settings but have no built meshes and solution data to save space (a few compact 
MPH-files have no solutions for other reasons). You can open these to study the settings and to mesh and 
re-solve it. It is also possible to download the full versions — with meshes and solutions — of most of these 
through Application Library Update (see The Application Library Update Window). In the Application Libraries 
window these appear with the icon . If you position the cursor at a compact file in the Application Libraries 
window, a No solutions stored message appears. If a full MPH-file is available for download, the corresponding 
node’s context menu includes a Download File With Solution icon ( ).

File Locking
Only one user can open and edit an MPH-file at the same time. If you try to open an MPH-file that is already open 
in another user’s COMSOL Desktop, that MPH-file is locked, and you get an option to open the MPH-file in a 
read-only mode (click Open As Read-Only). That means that you can edit the model but you cannot save it unless 
you save the MPH-file under another name. When an MPH-file is locked, COMSOL creates a separate lock file 
with the same filename as the MPH-file plus the extension .lock, stored in the same directory as the locked 
MPH-file. If a lock file remains after all COMSOL Desktop sessions have ended (which can happen if the 

• Meshing

• Geometry Modeling and CAD Tools

• Studies and Solvers
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COMSOL Desktop session is ended in a nonstandard way), you can reset the lock when trying to open the file the 
next time by clicking Reset Lock and Open.

M O D E L  F I L E S  F O R  J A V A

Editable script files that contain sequences of COMSOL commands as Java code (see the COMSOL Multiphysics 
Programming Reference Manual for more information about these commands). You can compile these Java files 
and run them as separate applications. Edit the files in a text editor to add additional commands. For parts of the 
model that appears under a component (such as the geometry, physics, and mesh), the default format is to include 
the component level in the Java code. If you want do not want to include the component level, clear the Use 
component syntax check box on the Methods page in the Preferences dialog box.

M O D E L  F I L E S  F O R  M A T L A B

Model files for MATLAB are editable script files (M-files), similar to the model files for Java, for use with MATLAB. 
A model file for MATLAB contains a sequence of COMSOL commands as an M-file. You can run these model files 
in MATLAB like any other M-file scripts. You can also edit the files in a text editor to include additional COMSOL 
commands or general MATLAB commands.

M O D E L  F I L E S  F O R  V B A

Model files for VBA are editable script files (VBA-files), similar to the model files for Java, for use with VBA (Visual 
Basic for Applications) in Microsoft Excel®. A model file for VBA contains a sequence of COMSOL commands as 
a VBA-file (extension .vba). You can use these files from Excel® to access settings and data in COMSOL models. 

Saving COMSOL Files

The following options are selected from different menus and toolbars as described in The COMSOL Desktop 
Menus and Toolbars.

Linux and macOS do not support operating system locking of files. On those platforms, locking is 
supported to help users avoid editing the same COMSOL Multiphysics model file, but it is possible 
to ignore the file locking and delete the lock files.

When saving a Model Java-file history for running a method call in the COMSOL Desktop, it 
contains the history produced while running the method call and not the method itself.

Running model files in the M-file format requires LiveLink™ for MATLAB®.

Using model files in the VBA format requires LiveLink™ for Excel®.

• The Application Libraries Window

• Saving COMSOL Files

• Reverting to the Last Saved File

• Printing and Capturing Screenshots

• Saving and Opening Recovery Files
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S A V I N G  A  N E W  M O D E L  O R  A P P L I C A T I O N

If this is the first time saving a model or application, or if you want to update the file and keep the current name 
and format, in general, these are the ways to save a model:

• Click the Save button ( ) on the Quick Access Toolbar or Main Toolbar.

• Press Ctrl+S.

• Select File>Save.

C R E A T I N G  A  C O P Y  U S I N G  S A V E  A S

If the model has been saved before and you want to create a copy you can choose to save in one of the COMSOL 
file formats (see COMSOL MPH-Files, Model Files for Java, and Model Files for MATLAB).

Select File>Save As. The Save As window opens, and from the Save as type list select COMSOL Application (*.mph) (the 
default), Model file for Java (*.java), Model file for MATLAB (*.m), or COMSOL File for VBA (*.vba).

In all cases, navigate to the location where you want to save the model, enter a File name, and then click Save.

R E V E R T I N G  T O  T H E  L A S T  S A V E D  F I L E

To open the last saved version of the file and reinitialize the GUI, select File>Revert to Saved ( ). For Windows 
users, you can also customize the Quick Access Toolbar and then click the Revert to Saved button.

C O M P A C T I N G  T H E  H I S T O R Y

The COMSOL files for Java and for MATLAB contain the entire history of the model, including settings that are 
no longer part of it. To compact the history so that the files only include the settings that are part of the current 
model, select File>Compact History. For Windows users, you can also customize the Quick Access Toolbar and then 
click the Compact History ( ) button.

W H E N  S A V I N G ,  O P T I M I Z I N G  F O R  S P E E D  O R  F I L E  S I Z E

You can choose to save COMSOL files (MPH-files) that are optimized for speed (the default, using uncompressed 
files that are faster to save) or optimized for file size (using compressed files). In the Preferences dialog box (see 

If you save a model that was previously saved in an earlier version of COMSOL Multiphysics, you 
get a question about if you want to continue to save the model file, thereby overwriting the 
original file with a new file that has been converted so that it can only be opened in version 5.4. 
Select the Do not show this message again check box if desired. There is also a preference setting on 
the Files page in the Preferences dialog box. Under Saving COMSOL application files, clear the Warn 

before overwriting a file saved by an older version of COMSOL check box (selected by default) to turn 
off this question.

You can add the author to the header of model files for Java and for MATLAB that are saved. Open 
The Preferences Dialog Box and under General>History export, select the Include author check box.

Compacting the history works best if you make sure that the geometry is built before running 
File>Compact History.
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Preferences Settings), click Files and choose Speed or File size from the Optimize for list under Saving COMSOL 

application files.

Saving and Opening Recovery Files

The COMSOL Multiphysics software can store recovery files each time you start a solver. This setting is initially 
active by default. If the server has lost contact with the client, a recovery file is also saved or kept.

If any recovery files exist, the Recovery Files window is open when you start the COMSOL Desktop. You can also 
open the Recovery Files window from the Windows menu.

The update of the recovery file occurs at the following events:

• After completing the solution for each time step specified as the output times in the Times field for a 
time-dependent simulation.

• After completing each parameter step in a parametric simulation.

• After completing each successful Newton iteration for a nonlinear stationary simulation.

The recovery files are COMSOL MPH-files that represent the state at the time that they were saved. They make it 
possible to recover from a solver error, which can be especially useful for long time-dependent or parametric runs.

You can control the use of recovery files using the buttons at the top of the Recovery Files window:

• Click the Open button ( ) to open a selected recovery file. Opening the recovery files this way ensures that the 
recovery file can be deleted without compromising the open model. It does not remove the recovery file when 
the open model is saved though

• Click the Save and Open ( ) button saves the recovery file to a Model MPH-file and open it. It also removes 
the recovery file.

• Click the Save As button ( ) to save the recovery file to a Model MPH-file and remove the recovery file.

• Click the Delete button ( ) or press Delete to remove the selected recovery files.

The COMSOL Multiphysics software keeps track of the computed time steps or parameter steps in the recovery 
file, so right-click the Study node and select Continue ( ) to continue the computation from the point where it 
was stored in the recovery file. If you are solving a stationary nonparametric problem, the last converged Newton 
iteration is stored in the recovery file; selecting Continue causes the software to resume solving from this stored state.

You can make changes to these default settings in The Preferences Dialog Box in the Files section.

• The Save recovery file check box is selected by default to save recovery files to disk during the solution process 
for time-dependent, parametric, and nonlinear solvers.

• The Check for recovery files at launch check box is selected by default so that the Recovery Files window opens at 
launch when there are any recovery files.

• In the Folder for recovery files field, you can specify a different folder from the default to, for example, use a folder 
on the server where there is more disk space for storing large recovery files. Click Browse to browse to a recovery 
file folder.

• About the COMSOL Model File Formats

• Windows Toolbars and Menus

• The Root Settings and Properties Windows

• Printing and Capturing Screenshots
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• In the Folder for temporary files field you can specify a different folder than the default to, for example, use a 
folder where there is more disk space for storing large temporary files. Click Browse to browse to a folder for 
temporary files.

• If you run the COMSOL Multiphysics software in a client-server configuration, you can specify a Folder for 

temporary files on client and a Folder for temporary files on server.

The Root Settings and Properties Windows

The root node is the topmost level of the Model Builder tree and the Explorer tree in the Application Builder. When 
you click this node, the Settings window for the root node ( , or  in the Application Builder) opens and 
includes detailed information about the model file. To open the corresponding Properties window, right-click the 
root node and choose Properties from the context menu.

R O O T  S E T T I N G S  W I N D O W

Some of the fields can be edited directly in this window, while others display system information that cannot be 
changed, or information that changes as updates are made throughout the model (for example, adding a node that 
requires an additional module license).

• Protection: Click Set Password next to Editing not protected or Running not protected to enter a password in the 
Protect Edit with Password or Protect Running with Password dialog boxes. To change the password, click Change 
Password to enter the previous password and a new password in the Protect Edit with Password or Protect Running 

with Password dialog boxes. Note that, for the password that protects editing, lost passwords cannot be 
recovered.

• Used Products: The information included here is based on the purchased license or modules. See Checking and 
Controlling Products and Licenses Used. Also see The About COMSOL Multiphysics Box.

• Presentation: In this section you can specify a title and a description of the model. By default, these texts are used 
on the title page of a report; see The Title Page. Under Computation time, you can enter an expected computation 
time in the Expected field. Also, the time after Last is the last measured computation time (if available). To 
illustrate the model you can also set an image as a thumbnail that displays in this section, when opening a file in 
the Application Libraries window, and as the default report title page image. See the section Setting and Clearing 
the Thumbnail Image for details about how to do this.

• Unit System: The default unit system is SI units. Or select any other option from the list. See Unit Systems and 
Setting the Unit System for Models to change the setting globally or locally.

• Graphics: For specifying the color theme used for selection colors, use the Color theme list, where you can select 
from all available color themes. The default is to use the default color theme — for example, Default from 

preferences (Default). You specify the default color theme in the Preferences dialog box, in the Color theme list on 
the Graphics and Plot Windows page. See Selection Colors for more information about selection colors.

For the Font settings, the default is to use the font family that is set in the Preferences dialog box — on the 
Graphics and Plot Windows page under Default font — with a default font size. Depending on the operating system 
and the installed fonts on the computer, you can select from a number of other font families from the Family list. 
The default font is indicated in the default settings for Family (Default from preferences (Vera), for example). For 
the font size, the Default size setting in the Size list uses the font size that is used in the graphics and plots, which 
is a system-dependent value. You can also choose another font size between 6 and 24 points or type a font size 
in the Size combined field and list. The font and the font size affect text in the Graphics window and other plot 

Studies and Solvers
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windows in the COMSOL Desktop and in Graphics form objects in the Application Builder. See Changing the 
Font for Plot Labels and Titles to make global changes.

• Applications (this section is only available from the Application Builder window): Select the Ask to save application 

when closing check box to ask users if they want to save changes in an application when closing it. Also, from the 
When starting with COMSOL Multiphysics list, you can control the behavior when a user starts COMSOL 
Multiphysics with the option to open an application or when a user double-clicks an MPH-file in Windows: 
Select Edit application (the default) to open the COMSOL Desktop for editing the application, or select Run 

application to launch and run the application directly.

Select the Ignore license errors during launch check box to make it possible to start the application even if not all 
required licenses are available. It is, however, still not possible to use products when the license is not available, 
so available API methods will typically have to be used in the application to limit the application’s functionality 
depending on what licenses are available.

R O O T  P R O P E R T I E S  W I N D O W

To access the Properties window, right-click the root node and choose Properties from the context menu.

• File: The file location where a file is saved. This field cannot be edited, but is automatically updated when the file 
is saved to a new path. Also see Documentation and Application Libraries Root Directories.

• Version: Includes the version and build of the COMSOL Multiphysics instance that you are running. This 
information is system generated.

• Created and Last modified: These sections cannot be edited and are automatically generated based on the 
computer system or network time and date settings.

• Saved with license: The license number of the installed software that the model or application was saved with is 
included here. Also see The About COMSOL Multiphysics Box.

• Application version: Enter a tracking version number for the model or application (for example, Internal Draft 
V1, Sales Demonstration V2, or Version B).

• Search path: Enter a file path to set a search path for external files. This path corresponds to 
model.modelPath(<path>) in the COMSOL Multiphysics API.

Unit Systems

The COMSOL Multiphysics software supports the following unit systems:

M E T R I C  U N I T  S Y S T E M S

• SI units, the International System of Units (SI, Système International d’Unités). This is the default unit system 
(sometimes also called MKS). For a list of SI units in COMSOL Multiphysics, see SI Base, Derived, and Other 
Units.

• CGSA units. The CGS system uses centimeter, gram, and second as basic units of length, mass, and time, 
respectively. The remaining basic units are identical to the SI units. The CGS unit system gives nice values for 
small lengths, masses, forces, pressures, and energies when working on a microscale and with weak 
electromagnetic forces. The derived units of force, pressure, and energy have well-known and widely used names: 

You can change a filename by saving the file, but the root node Name (root) cannot be changed 
for this top level node. This is different than for other nodes in the tree, where the name can be 
edited. See Displaying Node Names, Tags, and Types in the Model Builder for information. Also 
see Settings and Properties Windows for Feature Nodes.
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dyne, barye, and erg, respectively. CGSA adds ampere as the basic unit for electric current. For a list of CGSA 
units, see Special CGSA Units.

• Electromagnetic units (EMU). This system is based on Ampère’s law, which defines the unit of electric current 
once you select an appropriate value for the constant C. When dealing exclusively with magnetic effects, it is 
convenient to set C = 1. If CGS units are used for the remaining basic dimensions, the current unit is called an 
abampere, and the corresponding coherent unit system is called electromagnetic units. Unique names for 
derived units have been introduced by prefixing the SI name with ab-. For a list of EMU units, see Special EMU 
Units.

• Electrostatic units (ESU). Based on Coulomb’s law for the force between point charges, ESU uses a unit of 
charge called the statcoulomb with CGS units for length, mass, and time. From there, the statampere, or 
franklin, and other derived units of the electrostatic unit system follow. For a list of ESU units, see Special ESU 
Units.

• MPa units. For stationary structural mechanics, where the density does not appear in the equations, it can be 
convenient to use a system where newton and megapascal (hence the name “MPa system”) are naturally derived 
units of force and pressure, respectively. Keeping the SI unit for time, the basic units of length and mass become 
millimeter and tonne. Except for the force and pressure units, other derived units are nameless. For a list of MPa 
units, see Special MPa Units.

E N G L I S H  U N I T  S Y S T E M S

• Foot-pound-second unit system (FPS units). The original foot-pound-second system seems to be the absolute 
system using the pound as a unit of mass. This version of the FPS system is in agreement with the IEEE standard 
(the pound is a unit of mass and not of force). The natural derived unit of force is the poundal. For a list of FPS 
units, see Special FPS Units.

• British engineering units. An alternative to the standard FPS system is the British engineering unit system (also 
called gravitational foot-pound-second system or foot-slug-second system). Here, the pound force is the natural 
unit of force, which causes the introduction of the mass unit slug such that a pound force is a slug-foot per second 
squared. For a list of British engineering units, see Special British Engineering Units.

• Inch-pound-second unit system (IPS units). It is possible to define varieties of the FPS and British engineering 
systems based on the inch instead of the foot as basic unit of length. This gives rise to two distinct 
inch-pound-second systems: the absolute IPS system (just called IPS) and the gravitational IPS system. For a 
list of IPS units, see Special IPS Units.

• Gravitational IPS units. This alternative IPS unit system considers the pound a unit of weight rather than a unit 
of mass. For a list of Gravitational IPS units, see Special Gravitational IPS Units.

O T H E R

• None. No units appear in the settings, which can be useful in nondimensionalized (de-dimensionalized or 
dimensionless) models.

Searching and Finding Text

Press Ctrl+F to open a Find tool that you can use to search for variables or text in all of the model or, for application 
development, only in methods. In the Find tool, click All to search the entire model, including user interface 
components, variable definitions, model entity tags, identifiers, and labels. You can specify to search using an Exact 

match, a Regular expression, or a Case sensitive search by selecting the corresponding check boxes. Windows users 
can also customize the Quick Access Toolbar to access this button ( ).

• Using Units

• Setting the Unit System for Models
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Click Methods to find and optionally replace a text string in methods developed for an application. See the 
Application Builder documentation for details.

Click Advanced to access some advanced search tools. See Advanced Search Options below.

Click the Find button to launch the search. The search results for each search appears in a separate Find Results 
window, where each occurrence of the search string appears in a row. Double-click the row to open the node or 
method and highlight the search result in the Settings window or method where it occurs. The Node column lists 
the node where the search string appears; the Type column lists the type of the search results, such as Setting, 
Description, or Method); and the Text column shows the text in which the search string appears.

A D V A N C E D  S E A R C H  O P T I O N S

Click Advanced to enable a more specific search method where individual types of candidates can be searched for. 
In the Find field, type a search query in the same way as on the All page using an Exact match, a Regular expression, 
or a Case sensitive search, if desired. In the Filter section, below the Find field, use the Include list to specify what to 
include: Node tags, Node labels, Node names, Node types, Descriptions, and Settings. The Include list specifies what 
you search for, so selecting Node tags, for example, only matches the query in the Find field against node tags. The 
option Descriptions searches for any fixed text in the COMSOL Desktop but not text that can be changed such as 
lists. The Settings option searches for values of a setting (for example, text in a text field or in a list). In addition, it 
is possible to add a name query in the Name filter field. Any nonempty entry here will only include settings with a 
specific name, which is the description of the setting. This query is also affected by the settings for the Exact match, 
Regular expression, and Case sensitive check boxes. Select the Include API names in search check box to allow the 
search filter to match against the API names. It is only applicable when searching for Node types and Settings and 
checks the API names of the following search candidates:

• The query in the Name filter field is matched against the API name of a setting (for example, the Axis type list in 
a Block geometry feature has axistype as its API name).

• The query in the Find field is matched against the API value of list settings (for example, the option x-axis in the 
Axis type list has the API value x).

• A search for the value of a check box (typically on or off) is ignored in normal searches but is active when 
including API names. The Find field can then match values that are on or off for most check boxes.

• For the Node types option in the Include list, which otherwise searches for the descriptive string of the type but 
also includes the API name of the type (for example, the Work Plane geometry feature has the API type 
WorkPlane).

A D D I T I O N A L  S E A R C H  T O O L S  F O R  T H E  P H Y S I C S  B U I L D E R

When searching in the Physics Builder, you can also control the scope of the search in the Find tool. In addition to 
physics builder files, it can also search in linked files. A linked file can either be a file in an Import node under the 
External Resources branch (downward search), or a file listed in the External Resources links in the table of the root 
node’s Setting window (upward search). The search can look for files in the upward direction by selecting the Follow 

link sources check box, and it can look for files in the downward direction by selecting the Follow imports check box. 
A Depth value can be used to limit the search. Under the Links tab there is a specialized search that finds links to a 
selected node. It supports the Follow link sources option, and only need to search upward one level. It is not 
applicable for nodes that cannot be a target of a link.
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Th e  App l i c a t i o n  L i b r a r i e s  W indow

The Application Libraries window (Figure 2-13) contains models and applications that you can use for a variety of 
purposes: for learning how to build COMSOL models, as starting points for your own models and applications, 
and as demonstrations of specific functionality. Each add-on module includes its own application library with 
information about how to use the module within its application areas. Each file includes full documentation and a 
brief description, including the solution times and information about the computer used for solving the model.

Figure 2-13: The Application Libraries window with Eigenmodes of a Room highlighted in the tree. Specific 
information about the model or application is displayed to the right, including its name and the computation time.

To open the Application Libraries window ( ):

• From the Home toolbar, Windows menu, select Application Libraries.

• You can also customize the Quick Access Toolbar and then click the Application Libraries button 
on the toolbar. See Windows Toolbars and Menus.

• From the File menu select Application Libraries.

To open the Application Libraries window ( ):

• In the Main toolbar, click the Application Libraries button.

• Select Windows>Application Libraries.



T H E  A P P L I C A T I O N  L I B R A R I E S  W I N D O W  |  85

Browse through the Application Libraries tree to see what is available. Click to highlight the file in the tree and read 
information about it to the right, or search for a specific application. The information for each application includes:

• The COMSOL products used.

• The physics interfaces used.

• The version that the application was created in.

• The computation time. If you hover over the computation time, a tooltip displays information about the 
computer used for the computation (CPU, clock rate, and number of cores) and, if applicable, the solution times 
for each study step.

• The dates and times for when the application was created and last modified.

When you browse the tree, you may notice that three different icons are used for the model and application nodes. 
Their respective look and significance are as follows:

•  (solved) — The file is complete with built meshes and solutions.

•  (compact) — The file contains no stored meshes or solutions. A solved version is available for download via 
Application Library Update (except in a few cases where the file is a template related to another, regular, model).

•  (preview) — The file is a preview of an application or a model file, containing only what is needed to 
represent the model in this particular context, including the model description and information about used 
products and physics interfaces and the computation time. Solved and compact versions are available for 
download. Model documentation will be available if you have specified the use of online help (see The Help 
Window and Topic-Based Help for details on how to do this).

The following sections describe what is available and what you can do from the Application Libraries window:

• The Applications Folders

• Running or Opening a Model or Application and Its Documentation

• Downloading MPH-Files With or Without Solutions

• Searching the Application Libraries

• The Application Library Update Window

You can also set the root directory and create and remove a user-defined library as described next.

A P P L I C A T I O N  L I B R A R Y  P R E F E R E N C E S

The following settings can be modified using the buttons at the bottom of the Application Libraries tree on the 
Application Libraries page in The Preferences Dialog Box and — if the Allow managing libraries in the Application 

Libraries window check box on that page is selected (the default) — also in the Application Libraries window itself.

Add User Application Library
Click the Add User Application Library button ( ) to add customized folders. In the Add User Application Library 
dialog box, navigate to a location on your computer and select an existing directory or click Make New Folder to 
create a custom folder. Click OK to save the changes and exit, or Cancel to exit without saving.

Optionally, you can replace the standard folder icon ( ) with custom icons of your choice that reflect the content 
of your library folders. To use a custom icon for a folder, create a PNG-file with an image size of 16-by-16 pixels 
and save it in the folder under the name folder.png.

It is not possible to add an application library identical to, containing, or being contained in, an 
already used application library.
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Set the COMSOL Application Libraries Root
Click the Set COMSOL Application Libraries Root Directory button ( ) to edit or set the root folder. This redirects 
the COMSOL software to a different folder where customized applications can be stored.

In the Set COMSOL Application Libraries Root Directory dialog box, navigate to the new root folder location or click 
Make New Folder. Click OK to save the changes and exit, or Cancel to exit without saving.

Remove Selected Library
This button is enabled after a user application library folder has been created. Select a user application library root 
folder in the Application libraries tree and then the click the Remove Selected ( ) button to remove the library from 
the tree.

The Applications Folders

In the Applications library folders you find runnable applications with custom user interfaces tailored with the 
Application Builder to simplify solving a specific problem using COMSOL Multiphysics. To run an application, 
click the ( ) Run Application button. If, instead, you want to explore how the application is constructed, click 
( ) Open. For applications in this folder, clicking the ( ) Open PDF document button launches the PDF 
document that you can access from the running application. If no such document is available, this button is not 
activated. For further details, see the next section.

Running or Opening a Model or Application and Its Documentation

R U N N I N G  A N  A P P L I C A T I O N

You can run an application built with the Application Builder by clicking Run application. This button is not 
activated for models.

O P E N I N G  A  M O D E L  O R  A P P L I C A T I O N

Once you have located the file you want to open — for example, you used a search and it is successful (see Searching 
the Application Libraries), or you browsed the Application Libraries tree — then to open the file:

• Double-click the name in the tree.

• Select the name, then click  Open.

• Right-click the name, then from the context menu select  Open.

It is possible to open and postprocess models that include functionality that you have blocked or 
that your license does not include. Nodes with functionality that requires a license for a product 
that is blocked or not available get a License Error subnode ( ), where you find information 
about the missing but required product license. Unless you disable or remove such nodes, it is not 
possible to re-solve such models.
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If the node represents a solved model ( ) or a compact ( ) or solved application, the file will open directly. If, 
instead, the file is a compact model MPH-file or a preview file ( ) and you are connected to the internet, you 
will be presented with the applicable download options:

• For a compact file, choose between opening the local model MPH-file and downloading the solved version 
before opening.

If you select Do not show this dialog again (preference setting), the local file will open directly the next time you 
open a compact model. If you change your mind later, you can control the behavior using the Ask about download 

before opening compact application file check box on the Application Libraries page of the Preferences dialog

• For a preview file, choose between downloading the file with or without solutions, that is between the solved 
and the compact MPH-file.

O P E N I N G  A  P D F  D O C U M E N T

To read the documentation in PDF format, including step-by-step instructions:

• Click to highlight the name in the tree, then click  Open PDF Document.

• Right-click the name, then from the context menu select  Open PDF Document.

The approximate download sizes are displayed next to the options. For models, the numbers 
shown do not include the documentation, which is downloaded together with the MPH-file if you 
have chosen to install documentation.

If you have no internet connection or if the Application Library Update server is unavailable for 
some other reason, these dialogs will not appear and the associated context-menu options will not 
be shown. You can entirely disable availability checks on the Preferences dialog’s Application 

Libraries page by clearing Check Application Library Update availability on first access. (If you already 
opened the Application Libraries window, this setting will take effect in the next session.)

You can enable the Open PDF Document button for a user-library model or application by placing a 
PDF-file with the same name as the MPH-file in the same folder.

PDF and HTML documentation is available also for preview nodes if online help is activated; see 
The Help Window and Topic-Based Help.
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O P E N I N G  T H E  A P P L I C A T I O N  G A L L E R Y

The Application Gallery, which is a part of the COMSOL website, provide access to a large number of models and 
applications, and you can download the MPH-files, PDF documentation, and other related files to extend the 
application libraries. Click the Application Gallery button ( ) above the application libraries tree to open the 
Application Gallery in a web browser.

Downloading MPH-Files With or Without Solutions

R E P L A C I N G  C O M P A C T  F I L E S

To replace compact MPH-files, you can download the files complete with solutions via Application Library Update 
(see The Application Library Update Window). Alternatively, right-click a compact node ( ) in the Application 

Libraries tree and choose Download File with Solutions.

You can also generate the complete models by building the mesh sequences and computing the studies.

R E P L A C I N G  P R E V I E W  F I L E S

To replace a preview file, use Application Library Update or right-click the node  in the Application Libraries tree 
and choose between Download File with Solutions and Download File Without Solutions.

Searching the Application Libraries

In the Application Libraries window, you can Search the application libraries to find any files using a specific feature. 
For example, enter all or part of the name, a physics interface name, a feature name, a feature tag or name prefixed 
by ‘@’, or any other phrase or words or and click Search.

The procedure for restoring the solutions can involve other steps, such as adjusting physics 
interface settings. See the individual documentation for details if the simple approach does not 
work.
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By default, the search includes all words in the Search field (with space signifying logical AND).

S E A R C H  P A R A M E T E R S  F O R  M O D E L S  A N D  A P P L I C A T I O N S

• To search for models and applications by filename only, use the prefix “@name:”, for example @name:busbar. 
You can also use the wildcard character ‘*’ at the beginning and the end of the search expression, for example 
@name:fluid* or @name:*electr*.

• To search for models and applications whose computation time (as displayed in the Application Libraries window) 
falls within a specific range, use the prefix “@time:”. For example, the search expression @time:>=1[h] <=2[h] 
returns all models and applications with a computation time between 1 and 2 hours. The supported relational 
operators are < (the default if no operator is given), >, <=, >=, and ==. Elapsed times can be expressed using the 
supported time units (see the section SI Base, Derived, and Other Units in The COMSOL Modeling 
Environment chapter for details). If no unit is specified, the expression entered is assumed to be given in seconds.

• If you enter more than one search term separated by spaces (in a search that is not restricted to filename using 
the “@name” prefix), the search finds files where all of the search terms appear.

• Limit the search to tags (identifiers) with the prefix “@tag:”. For example, @tag:genext finds all files using a 
General Extrusion node, and @tag:ehs finds all files with an Electron Heat Source node.

• Limit the search to node labels (excluding trailing digits and tags enclosed in parentheses) with the prefix 
“@label:”. To search for labels that include spaces, you need to enclose the label text within quotes. For 
example, @label:"point evaluation" finds files containing Derived Values nodes of Point Evaluation type 
with the default label base (as shown immediately below the window label in the Settings window).

• Limit the search to type names with the prefix “@type:”. For example, @type:segregated finds all files using 
a segregated solver, @type:slider finds all applications containing a Slider form object, and @type:bodyload 
finds all files with a Body Load node.To find out the type names, consult the COMSOL Programming Reference 
Manual or, for application form objects, the COMSOL Multiphysics Application Programming Guide. 
Alternatively, you can save an application as a Model File for Java or Model File for MATLAB and look up the 
second argument for the create(…) method for an object of the type of node you want to search for.

• To search for a specific physics interface, use the scoping syntax @physics:id, where id is a default 
physics-interface identifier (forming the base of the tags shown in the Model Builder window if you have selected 
Model Tree Node Text>Tag in the window’s toolbar). For example, enter @physics:ec to find all models that use 
the Electric Currents interface. Similarly, enter @geom:if to search for models that include an If statement 
(node) in the geometry sequence. Table 2-3 lists the supported model-object context scopes.

• The model-context search scopes @cpl, @export, @func, @multiphysics, @numerical, @probe, and 
@selection used without an identifier return all models that contain any node of the corresponding type; see 
Table 2-3.

COMSOL files are named using an underscore between words (for example, 
effective_diffusivity) because the filename is also the name of the corresponding Model 
MPH-file. The underscore is required to form a valid filename, so it is recommended that you, if 
you are not sure of the full name, enter only the first word (rather than multiple words separated 
by spaces) in the Search field when searching for a model or application name.

The search in the Application Libraries window does not include the models’ PDF documents. To 
search for text in the model documentation, use the COMSOL Documentation window and select 
Application libraries from the Search scope list to limit the search for the application libraries (see 
Searching the Documentation).
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• In addition to the model-object scopes, the following custom keywords are available:

- @keyword:tutorial — finds introductory and tutorial models;

- @keyword:verification — finds models classified as verification models or benchmarks;

- @keyword:industrial — finds models classified as industrial applications.

• To find all models and applications that are locally available in solved or compact form, or only as previews, use 
the search strings $solved, $compact, and $preview respectively

When a search result is presented, hover over a top-level node in the tree to see the number of matching files under 
the corresponding folder. If the search does not return any results, the Application Libraries window contains the 
message No Results Found. Click the Refresh button ( ) under the tree to return to the root Application Libraries 
folder list.

The Application Library Update Window

Application Library Update is a service that provides new and updated models and applications for the application 
libraries of the COMSOL products that your license includes. The text below describes how to use the Application 
Library Update service.

A P P L I C A T I O N  L I B R A R Y  U P D A T E

Open the Application Library Update window by clicking Update COMSOL Application Libraries in the Application 

Libraries window or by going to the File>Help menu (Windows users) or the Help menu (macOS and Linux users) 
and choosing Update COMSOL Application Libraries ( ).

When the Application Library Update window opens, choose if you want to download files containing solutions 
(Solved) or more compact versions of the models and applications (Compact), then click Find Applications to check 

TABLE 2-3:  MODEL-OBJECT SEARCH SCOPES.

SCOPE DESCRIPTION EXAMPLES

@cpl Search for component-coupling nodes. @cpl:genext, @cpl

@dataset Search for dataset nodes. @dataset:cpt

@export Search for export nodes. @export:anim, @export

@func Search for function nodes. @func:wv, @func

@geom Search for geometry-feature nodes. @geom:c

@mesh Search for mesh-feature nodes. @mesh:swe

@multiphysics Search for multiphysics-coupling nodes. @multiphysics:emh, 
@multiphysics

@numerical Search for derived-values nodes. @numerical:min, 
@numerical

@physics Search for physics-interface nodes. @physics:c

@probe Search for probe nodes. @probe:bnd, @probe

@result Search for plot-feature nodes. @result:slc

@selection Search for selection nodes. @selection:box, 
@selection

@sol Search for solver nodes. @sol:se

@study Search for study nodes. @study:param

Using the COMSOL Application Library Update service requires internet access. For a default 
installation, you also need to run COMSOL as an administrator. See Proxy Server Settings section 
below for instructions on how you can modify your installation to avoid this restriction.
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if all the models and applications you have are up to date or if there are any updated or new ones. If the message 
Your Application Libraries are up to date displays, no updated or new models or applications are available.

If the library is not up to date, browse the list that appears with a description and image. Choose which ones to 
download by selecting or clearing the check boxes next to the thumbnail images. By default all check boxes are 
selected; by clicking Clear selection and Select all you can change the global selection state.

Click the Download button to download the selected models and applications. The download time depends on the 
size of the files, which is listed for each file, and the bandwidth of the internet connection.

Proxy Server Settings
If you connect to the internet through a web proxy, you can specify the required settings in the Help section of the 
Preferences dialog box; for details, see Proxy Server Settings.

D E S T I N A T I O N  D I R E C T O R I E S  F O R  L I B R A R Y  U P D A T E S

To edit these settings under Destination directories for library updates, open The Preferences Dialog Box and go to 
the Updates section.

The Destinations list provides two options for specifying which application, documentation, and part directories are 
synchronized with the COMSOL Multiphysics server when you launch an Application Library Update or Part 
Library Update (see the next section) request:

• Current directories (default): Synchronize with application MPH-files under the COMSOL Application Libraries 
root set on the Preferences dialog’s Application Libraries page, with documentation files under the directory 
specified in the Documentation root directory field on the Preferences dialog’s General page, and with part 
MPH-files under the COMSOL Part Libraries root set on the Preferences dialog’s Part Libraries page.

• Specify custom directories: Choosing this option lets you specify COMSOL Application Libraries, 
documentation, and COMSOL Part Libraries root directories separate from those of your current COMSOL 
Desktop environment.

By default, the COMSOL Application Libraries, COMSOL Part Libraries, and documentation root directories are 
located directly under the COMSOL installation root directory, in applications/, parts/, and doc/, 
respectively. This typically implies that special permissions are required for saving downloaded files, and it can 
therefore be beneficial to move or copy the directories to a different location. The settings referred to in this section 
are provided to let you customize Application Library Update to the IT environment of your organization.

Note that if you chose to download solved models and applications and then choose Select all, the 
download size can be on the order of 10s of GB if you have license for several products. Therefore, 
it may be wiser to choose the compact option and then download solved versions of the examples 
you are interested in directly from the Application Libraries window.

Also see the Introduction to Application Builder.
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The Part Library Update Window

Part Library Update is a service that provides new and updated geometry parts for the part libraries of the 
COMSOL products that your license includes. The text below describes how to use the Part Library Update 
service.

P A R T  L I B R A R Y  U P D A T E

Open the Part Library Update window by clicking Update COMSOL Part Libraries in the Part Libraries window or by 
going to the File>Help menu (Windows users) or the Help menu (macOS and Linux users) and choosing Update 

COMSOL Part Libraries ( ).

If the message Your Part Libraries are up to date displays when the Part Library Update window opens, no updated 
or new geometry parts are available. If the library is not up to date, browse the list that appears with a description 
and image. Choose which ones to download by selecting or clearing the check boxes next to the thumbnail images. 
By default all check boxes are selected; by clicking Clear selected and Select all you can change the global selection 
state.

Click the Download button to download the selected geometry parts. The download time depends on the size of 
the files, which is listed for each geometry part, and the bandwidth of the internet connection.

Using the COMSOL Part Library Update service requires internet access. For a default installation, 
you also need to run COMSOL as an administrator. If you connect to the internet through a proxy 
server, see the Proxy Server Settings section for the relevant settings.
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Th e  Ph y s i c s  I n t e r f a c e s

This section is an overview of the core physics interfaces included with a COMSOL Multiphysics license. If your 
license include add-on modules, there are additional physics interfaces described in the individual documentation 
for each module.

Introduction to the Physics Interfaces

Solving PDEs generally means you must take the time to set up the underlying equations, material properties, and 
boundary conditions for a given problem. COMSOL Multiphysics, however, relieves you of much of this work. 
The software provides a number of physics interfaces that consist of nodes and settings that set up the equations 
and variables for specific areas of physics. An extensive set of physics-dependent variables makes it easy to visualize 
and evaluate the important physical quantities using conventional terminology and notation.

A complement to the interfaces for physics, special interfaces for equation-based modeling simplify the setup of 
PDEs for modeling that does not explicitly refer to any particular application field. In addition, other interfaces 
supplement the physics with special functionality such as the Sensitivity and Moving Mesh user interfaces.

Physics Groups and Subgroups

The Select Physics page in the Model Wizard, as well as The Add Physics Window, contain groups and subgroups 
of physics and mathematics interfaces (some items only display if a license includes the corresponding add-on 
modules).

R E C E N T L Y  U S E D  ( )

This group contains the most recently used physics interfaces for easy access.

A C / D C  ( )

This group contains physics interfaces for low-frequency electromagnetics such as electrostatics, electric currents 
and magnetic fields together with multiphysics couplings to heat transfer, structural mechanics and charged particle 
dynamics.

• Building Models in the Model Builder

• Adding and Inserting Physics Interfaces

• Modeling Guidelines

• Creating a New Model

Suites of physics interfaces that are optimized for specific disciplines together with specialized 
application libraries are available in a group of optional products. See The COMSOL Multiphysics 
Modules and Interfacing Options.

• Physics Groups and Subgroups

• Physics Interface Guide

• Selecting Physics Interfaces
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A C O U S T I C S  ( )  

This group contains acoustics-based physics interfaces. Except for the Pressure Acoustics group, these subgroups 
require additional licenses:

• Elastic Waves

• Acoustic-Structure Interaction

• Aeroacoustics

• Thermoviscous Acoustics

• Ultrasound

• Geometrical Acoustics

• Pipe Acoustics

C H E M I C A L  S P E C I E S  T R A N S P O R T  ( )

This group contains chemical species transport physics interfaces used, for example, for convection and diffusion, 
solving for the species concentrations and for chemical reactions. These subgroups are available depending on the 
specific license:

• Moisture Transport

• Reacting Flow (including an additional Turbulent Flow subgroup)

• Reacting Flow in Porous Media

• Rotating Machinery, Rotating Flow

E L E C T R O C H E M I S T R Y  ( )

This group contains electrochemistry physics interfaces for modeling electrochemical components such as batteries 
and fuel cells. This group and its subgroups are only available with additional licenses:

• Battery Interfaces

• Corrosion, Deformed Geometry

• Electrodeposition, Deformed Geometry

F L U I D  F L O W  ( )

This group contains fluid flow physics interfaces such as laminar single-phase flow and, with add-on modules, 
multiphase flow and turbulent flow. These subgroups are available based on the license:

• Single-Phase Flow (including additional Turbulent Flow and Rotating Machinery, Fluid Flow subgroups)

• Thin-Film Flow

• Multiphase Flow (including additional Bubbly Flow; Mixture Model; Euler-Euler Model; Two-Phase Flow, 
Level Set; Two-Phase Flow, Phase Field; Two-Phase Flow, Moving Mesh; Three-Phase Flow, Phase Field; and 
Rotating Machinery, Multiphase Flow subgroups)

• Porous Media and Subsurface Flow

• Nonisothermal Flow (including additional Turbulent Flow and Rotating Machinery, Nonisothermal Flow 
subgroups).

• High Mach Number Flow (including an additional Turbulent Flow subgroup)

• Rarefied Flow

• Particle Tracing

• Fluid-Structure Interaction
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H E A T  T R A N S F E R  ( )

This group contains physics interfaces for heat transfer in solids, fluids, pipes, and in porous media. Other physics 
interfaces are available for bioheat transfer and for heat and moisture transport. There are also multiphysics 
interfaces for thermal multiphysics applications such as Joule heating. These subgroups are available depending on 
the specific license:

• Heat and Moisture Transport

• Thin Structures (for heat transfer in thin shells, thin films, and fractures)

• Conjugate Heat Transfer (including an additional Turbulent Flow subgroup)

• Radiation

• Electromagnetic Heating

• Metal Processing

O P T I C S  ( )

This group contains physics interfaces for electromagnetic wave propagation in linear and nonlinear optical media 
for accurate component simulation and design optimization. This group and the subgroups are only available with 
additional licenses

• Ray Optics 

• Wave Optics

P L A S M A  ( )

This group contains physics interfaces for plasma modeling. This group and the Equilibrium Discharges and Species 
Transport subgroups require the Plasma Module.

R A D I O  F R E Q U E N C Y  ( )

This group contains physics interfaces for high-frequency electromagnetic field simulations solving the full Maxwell 
equations. This group is only available with the RF Module.

S E M I C O N D U C T O R  ( )

This group contains physics interfaces that solves Poisson’s equation for the electric potential and the drift-diffusion 
equations for electrons and holes in a semiconductor material: Semiconductor interfaces and interfaces for solving 
the Schrödinger and Schrödinger-Poisson equations.This group is only available with the Semiconductor Module.

S T R U C T U R A L  M E C H A N I C S  ( )

This group contains structural mechanics physics interfaces for example to study displacements and stresses in solids 
and for multibody dynamics, fatigue, thermal stress, piezoelectricity, and other structural multiphysics couplings. 
Depending on licenses, the following subgroups can be available:

• Rotordynamics

• Thermal Stress

• Piezoresistivity

M A T H E M A T I C S  ( )

This group contains mathematics interfaces for solving PDEs, ODEs, and DAEs, for optimization (which requires 
the Optimization Module) and sensitivity analysis, and for modeling moving meshes and parameterized geometry. 
These subgroups are available:

• PDE Interfaces (including a Lower Dimensions subgroup)

• ODE and DAE Interfaces
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• Optimization and Sensitivity

• Classical PDEs

• Moving Interface (available with either the CFD Module or Microfluidics Module)

• Deformed Mesh

• Wall Distance

• Mathematical Particle Tracing (available with the Particle Tracing Module)

• Curvilinear Coordinates

Adding and Inserting Physics Interfaces

T H E  A D D  P H Y S I C S  W I N D O W

The Add Physics window is similar to the Select Physics window accessed through The Model Wizard. It has the 
same physics interfaces available. This window is a quick way to add physics interfaces to models.

To open the Add Physics window:

T O  A D D  P H Y S I C S  I N T E R F A C E S  T O  A  M O D E L  C O M P O N E N T

1 In the Add Physics window, either enter a Search term or navigate the tree to locate the physics interface to be 
added to the Component.

The tree organizes the available physics interfaces by application areas such as fluid flow, heat transfer, and 
structural mechanics. The physics interfaces found in the modules your license supports display in the different 

For a list of all the physics interfaces under each group and subgroup, see the individual 
documentation included with each add-on module. Or search the online Help for the key words 
Physics Interface Guide.

• Creating a New Model

• Physics Interface Guide

• Selecting Physics Interfaces

• Right-click a Component node and choose Add Physics.

• From the Home toolbar, click Add Physics  

• Select Windows>Add Physics. 

• From the Physics toolbar, click Add Physics .

• Right-click a Component node and choose Add Physics.

• In the Model Toolbar, click Add Physics .

• In the Physics Contextual Toolbar, click Add Physics .

• Select Windows>Add Physics.

The Add Physics  toolbar button is a toggle button: Click it again to close the Add Physics 
window.
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application areas. In some cases, licensing of a module adds physics interfaces to these application areas as well 
as attributes to existing physics interfaces, which are enhanced with additional functionality. The  Recently 

Used branch lists the last five physics interfaces used in recent modeling sessions. You can also enter a text string 
in the search field and click the Search button to list all the interfaces with the search term.

2 Once a physics interface is clicked, review and optionally modify any dependent variable names in the Dependent 

Variables section and, for some physics interfaces, specify the number of dependent variables. For PDE interfaces 
under Mathematics, you can also click the Units tab to specify units for the equation by defining a unit through a 
physical quantity for the dependent variable and the source term. See Units for more information about these 
settings.

If you select multiple physics interfaces, the Dependent Variables section is not available.

3 When there is already a physics interface added to the Component, the existing Studies are listed under Physics 

interfaces in study. By default, the studies appear with a check mark ( ) in the Solve column, which indicates 
that the study solves for the dependent variables in the physics interface. Click in the column to clear the check 
mark and exclude the physics interface from that study.

4 Click the Add to Component or Add to Selection buttons.

- If you click Add to Component, the physics interfaces are added to the Model Builder and become active in the 
entire model component’s geometry by default. You can also press Enter to add the physics components to 
the component.

- If you click Add to Selection, the physics interfaces are added to the Model Builder with a selection taken from 
the selected geometric entities in the Graphics window. This is a method called preselection.

C O P Y I N G ,  P A S T I N G ,  A N D  I N S E R T I N G  P H Y S I C S  I N T E R F A C E S

You can copy and paste physics interfaces within a COMSOL Multiphysics session and also between COMSOL 
Multiphysics sessions, as long as the copied physics interface information remains in the clipboard.

To copy a physics interface with all its subnodes, right-click the physics interface node and choose Copy (or, for 
Windows users, click Copy on the Quick Access Toolbar). You can then paste it in the same or a new COMSOL 
Desktop session by right-clicking a compatible Component node and choosing, for example, Paste Solid Mechanics 
(or, for Windows users, click, for example, Paste Solid Mechanics on the Quick Access Toolbar).

It is also possible to insert physics interfaces from another COMSOL Multiphysics model into a model component. 
To do so, right-click a Component node and choose Insert Physics from Model. An Insert Physics dialog box appears 
where you can browse or type the path and name of the COMSOL Multiphysics model file from which you want 
to insert components in the Model field. Select one or more of the physics interfaces in the model from the Physics 
list and then click OK to insert them into the current model. The list includes the space dimension for the physics 
interface so that you can select compatible physics interfaces.

The contents of the Add Physics window depends on the space dimension of the active model 
component. If there are no Component nodes in the model, the list of physics interfaces is empty.

You can insert a physics from another space dimension if it is applicable in the component you 
insert it into. Most physics applicable in 2D axial symmetry is applicable in 3D, so an interface 
specified in a 2D axisymmetric component can therefore be inserted in a 3D component.
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Some aspects when inserting or pasting a physics interface into an existing model component:

• All selections of a physics interface and its physics features depend on the geometry they belong to. When you 
insert or paste a physics interface into another component and geometry, there is a high risk of thats selections 
change or become empty.

• Any references to named selections will be broken, and no selection nodes are included automatically in the 
insertion process.

• All use of global parameters, functions, variables, materials, multiphysics couplings, and coordinate systems will 
be invalid after the insertion process unless an item with the same name exists in the target component. No 
attempt is made to automatically include any item in the insertion process. Materials should be of minor 
importance if the physics interfaces consistently use the option From material in all their material property 
settings.

• Some physics features are not applicable in all dimensions, so these will simply be ignored. You will be notified 
about this in the message dialog box.

Altogether, these aspects may cause an insert or paste operation to be incomplete to some degree. In some cases, 
the difference is reported in a message dialog box after the insertion process has finished. Click Cancel in this dialog 
box to revert the insertion process.

Physics Interface Guide

The table lists the physics and mathematics interfaces in COMSOL Multiphysics and the availability for 1D, 1D 
axisymmetric, 2D, 2D axisymmetric, and 3D geometries.

• Creating a New Model

• Physics Interface Guide

PHYSICS INTERFACE ICON TAG SPACE DIMENSION AVAILABLE PRESET STUDY TYPE

 AC/DC

Electric Currents ec All dimensions Stationary

Electrostatics es All dimensions Stationary; Time Dependent

Magnetic Fields mf 2D, 2D axisymmetric Stationary; Frequency Domain

 Acoustics

 Pressure Acoustics

Pressure Acoustics, 
Frequency Domain

acpr All dimensions Eigenfrequency; Frequency Domain

 Chemical Species Transport

Transport of Diluted 
Species

tds All dimensions Stationary; Time Dependent
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 Fluid Flow

 Single-Phase Flow

Laminar Flow spf 3D, 2D, 2D 
axisymmetric

Stationary; Time Dependent

 Heat Transfer

Heat Transfer in Solids ht All dimensions Stationary; Time Dependent

Heat Transfer in Fluids ht All dimensions Stationary; Time Dependent

 Electromagnetic Heating

Joule Heating1, — All dimensions Stationary; Time Dependent

 Structural Mechanics

Solid Mechanics solid 3D, 2D, 2D 
axisymmetric

Stationary; Eigenfrequency; Time Dependent

 Mathematics

Wall Distance wd All dimensions Stationary; Time Dependent

Curvilinear Coordinates cc All dimensions Stationary; Eigenvalue

 PDE Interfaces

Coefficient Form PDE c All dimensions Stationary; Time Dependent; Eigenvalue

General Form PDE g All dimensions Stationary; Time Dependent; Eigenvalue

Wave Form PDE wahw All dimensions Time Dependent

Weak Form PDE w All dimensions Stationary; Time Dependent; Eigenvalue

PDE, Boundary 
Elements

pdebe 3D and 2D Stationary

 Lower Dimensions

Coefficient Form 
Boundary PDE

cb All dimensions Stationary; Time Dependent; Eigenvalue

Coefficient Form Edge 
PDE

ce 3D Stationary; Time Dependent; Eigenvalue

PHYSICS INTERFACE ICON TAG SPACE DIMENSION AVAILABLE PRESET STUDY TYPE
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Coefficient Form Point 
PDE

cp 3D, 2D, 2D 
axisymmetric

Stationary; Time Dependent; Eigenvalue

General Form 
Boundary PDE

gb All dimensions Stationary; Time Dependent; Eigenvalue

General Form Edge 
PDE

ge 3D Stationary; Time Dependent; Eigenvalue

General Form Point 
PDE

gp 3D, 2D, 2D 
axisymmetric

Stationary; Time Dependent; Eigenvalue

Weak Form Boundary 
PDE

wb all dimensions Stationary; Time Dependent; Eigenvalue

Weak Form Edge PDE we 3D Stationary; Time Dependent; Eigenvalue

Weak Form Point PDE wp 3D, 2D, 2D 
axisymmetric

Stationary; Time Dependent; Eigenvalue

 ODE and DAE Interfaces

Global ODEs and 
DAEs

ge All dimensions Stationary; Eigenfrequency; Time 
Dependent; Frequency Domain; Eigenvalue

Domain ODEs and 
DAEs

dode All dimensions Stationary; Time Dependent; Eigenvalue

Events ev All dimensions Time Dependent

Boundary ODEs and 
DAEs

bode All dimensions Stationary; Time dependent; Eigenvalue

Edge ODEs and DAEs eode 3D Stationary; Time dependent; Eigenvalue

Point ODEs and DAEs pode 3D, 2D, 2D 
axisymmetric

Stationary; Time dependent; Eigenvalue

 Optimization and Sensitivity

Optimization

Requires the 
Optimization Module

opt All dimensions Stationary; Eigenfrequency; Time 
Dependent; Frequency Domain; Eigenvalue

Sensitivity sens All dimensions Stationary; Eigenfrequency; Frequency 
Domain; Eigenvalue; Time Dependent 
(available with the Optimization Module)

 Classical PDEs

Laplace Equation lpeq 1D, 2D, 3D Stationary

Poisson’s Equation poeq 1D, 2D, 3D Stationary

Wave Equation waeq 1D, 2D, 3D Time Dependent

PHYSICS INTERFACE ICON TAG SPACE DIMENSION AVAILABLE PRESET STUDY TYPE
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Common Physics Interface and Feature Settings and Nodes

There are several common settings and sections available for the physics interfaces and feature nodes (Table 2-4). 
Some of these sections also have similar settings or are implemented in the same way no matter the physics interface 
or feature being used. There are also some physics feature nodes (Table 2-5) that display in COMSOL 
Multiphysics.

In each module’s documentation, only unique or extra information is included; standard information and 
procedures are centralized in this manual.

S H O W  M O R E  P H Y S I C S  O P T I O N S

To display additional sections and options for the physics interfaces (and other parts of the model tree), click the 
Show More Options button ( ) on the Model Builder and then select the applicable options in the Show More Options 
dialog box that opens.

After selecting some options, sections display on the Settings window when a node is clicked, or additional nodes 
are made available from the Physics toolbar or context menu. Selecting Advanced Physics Options either adds an 
Advanced settings section or enables nodes in the context menu or Physics toolbar. In many cases these options are 
described in the individual documentation.

For more information about the Show options, see Showing More Options and The Model Builder.

Helmholtz Equation hzeq 1D, 2D, 3D Stationary

Heat Equation hteq 1D, 2D, 3D Stationary; Time Dependent

Convection-Diffusion 
Equation

cdeq 1D, 2D, 3D Stationary; Time Dependent

Stabilized 
Convection-Diffusion 
Equation

scdeq 1D, 2D, 3D Stationary; Time Dependent

 Deformed Mesh

Deformed Geometry dg All dimensions Stationary; Time Dependent; Frequency 
Domain; Eigenvalue

Moving Mesh ale All dimensions Stationary; Time Dependent; Frequency 
Domain; Eigenvalue

1 This physics interface is a predefined multiphysics coupling that automatically adds all the physics interfaces and 
coupling features required.

Table 2-4 has links to common sections and Table 2-5 to common feature nodes. You can also 
search for information: press F1 to open the Help window or Ctrl+F1 to open the Documentation 
window. 

PHYSICS INTERFACE ICON TAG SPACE DIMENSION AVAILABLE PRESET STUDY TYPE
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C O M M O N  P H Y S I C S  S E T T I N G S  S E C T I O N S

TABLE 2-4:  COMMON PHYSICS SETTINGS SECTIONS

SECTION CROSS REFERENCE AND NOTES

Advanced Settings — Pseudo 
time stepping

Pseudo Time Stepping and Pseudo Time Stepping for Laminar Flow Models

Advanced Settings — Frames See Frames.

Advanced This section can display after selecting Advanced Physics Options. The Advanced 
section is often unique to a physics interface or feature node. 

Anisotropic materials For some User defined parameters, the option to choose Isotropic, Diagonal, 
Symmetric, or Full displays. See Modeling Anisotropic Materials for 
information.

Consistent Stabilization See Stabilization.

Constraint Settings Constraint Reaction Terms, Weak Constraints, and Symmetric and 
Nonsymmetric Constraints

Coordinate System Selection Coordinate Systems

Selection of the coordinate system is standard in most cases. Extra information is 
included in the documentation as applicable.

Dependent Variables Predefined and Built-In Variables

This section is unique for each physics interface, although some interfaces have 
the same dependent variables.

Discretization Settings for the Discretization Sections

Discretization — Frames See Frames.

Equation Physics Nodes — Equation Section

The equation that displays is unique for each interface and feature node, but how 
to access it is centrally documented.

Frames (Advanced Settings — 
Frames and Discretization — 
Frames)

Handling Frames in Heat Transfer and About Frames

Geometric entity selections Working with Geometric Entities

Selection of geometric entities (Domains, Boundaries, Edges, and Points) is 
standard in most cases. Extra information is included in the documentation as 
applicable.

Inconsistent Stabilization See Stabilization.

Settings Predefined and Built-In Variables

Displaying Node Names, Tags, and Types in the Model Builder

There is a unique Name for each physics interface.

Material Type About Using Materials in COMSOL Multiphysics

The Settings Window for Material

Selection of material type is standard in most cases. Extra information is included 
in the documentation as applicable.
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C O M M O N  F E A T U R E  N O D E S

Model Inputs About Model Inputs and Model Inputs and Multiphysics Couplings

Selection of Model Inputs is standard in most cases. Extra information is included 
in the documentation as applicable.

To define the absolute pressure for heat transfer, see the settings for the Fluid 
node.

To define the absolute pressure for a fluid flow interface, see the settings for the 
Fluid Properties node (described for the Laminar Flow interface).

If you have a license for a nonisothermal flow interface, see that documentation 
for further information.

Override and Contribution Physics Exclusive and Contributing Node Types

Physics Node Status

Pair Selection Identity and Contact Pairs

Continuity on Interior Boundaries

Selection of pairs is standard in most cases. Extra information is included in the 
documentation as applicable. Contact pair modeling requires the Structural 
Mechanics Module or MEMS Module. Details about this pair type can be found in 
the respective user’s guide.

Stabilization — Consistent and 
Inconsistent

Numerical Stabilization, Numerical Stability — Stabilization Techniques for 
Fluid Flow and Heat Transfer Consistent and Inconsistent Stabilization 
Methods

TABLE 2-5:  COMMON FEATURE NODES

FEATURE NODE CROSS REFERENCE AND NOTES

Auxiliary Dependent Variable Auxiliary Dependent Variable

Axial Symmetry See Symmetry.

Continuity Continuity on Interior Boundaries and Identity and Contact Pairs.

This is standard in many cases. When it is not, the node is documented for the 
physics interface.

Discretization Discretization (Node)

Equation View Equation View

The Equation View node’s contents is unique for each physics and mathematics 
interface and feature node, but it is centrally documented.

Excluded Edges, Excluded Points, 
and Excluded Surfaces

Excluded Points, Excluded Edges, Excluded Surfaces

Global Constraint Global Constraint. Also see the Constraint Settings section.

Global Equations Global Equations

Harmonic Perturbation Harmonic Perturbation, Prestressed Analysis, and Small-Signal Analysis

Initial Values Physics Interface Default Nodes, Specifying Initial Values, and Dependent 
Variables

This is unique for each physics interface. 

Periodic Condition and 
Destination Selection

Periodic Condition and Destination Selection

Periodic Boundary Conditions 

Periodic Condition is standard in many cases. When it is not, the node is 
documented for the physics interface.

Pointwise Constraint Pointwise Constraint. Also see the Constraint Settings section.

TABLE 2-4:  COMMON PHYSICS SETTINGS SECTIONS

SECTION CROSS REFERENCE AND NOTES
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Symmetry Using Symmetries and Physics Interface Axial Symmetry Node. There is also 
information for the Solid Mechanics interface about Axial Symmetry.

This is standard in many cases. When it is not, the node is documented for the 
physics interface.

Weak Constraint Weak Constraint. Also see the Constraint Settings section.

Weak Contribution Weak Contribution (ODEs and DAEs) and Weak Contribution (PDEs and 
Physics)

Weak Contribution on Mesh 
Boundaries

Weak Contribution on Mesh Boundaries

• Creating a New Model

• The Add Physics Window

• Showing More Options

• Selecting Physics Interfaces

TABLE 2-5:  COMMON FEATURE NODES

FEATURE NODE CROSS REFERENCE AND NOTES
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C r e a t i n g  a  New Mode l

This section describes how to create a new model using The Model Wizard or to begin with a blank model. First 
you need to Open a New Window to Begin Modeling. It is also useful to have a basic model added to the Model 
Builder; then you can experiment with The Model Builder, which is described in the Building a COMSOL 
Multiphysics Model chapter.

Open a New Window to Begin Modeling

To open a New window:

• On the Quick Access Toolbar (Windows users) or the Model Toolbar (macOS and Linux users), click the New 
button ( ).

• Press Ctrl+N.

• Select File>New.

After the New window opens to the Model page, select an option: 

• Click the Model Wizard button ( ) to open the Select Space Dimension window. Go to The Model Wizard 
section to continue.

• Click the Blank Model button ( ) to open COMSOL Multiphysics without any model set up in the Model 
Builder or return to the default COMSOL Desktop. You can then add components and physics interfaces to the 
model.

The Model Wizard

The Model Wizard helps you build a model by choosing the space dimension, physics interfaces, and the study you 
want to use. In the Model Wizard you Select Space Dimension, Select Physics, Review Physics Interface, and finally 
Select Study.

S E L E C T  S P A C E  D I M E N S I O N

1 Open the Model Wizard (see Open a New Window to Begin Modeling).

2 On the Select Space Dimension page, click to choose the Component geometry dimension: 3D, 2D axisymmetric, 
2D, 1D axisymmetric, 1D, or 0D.

To enable the Physics Builder choose Preferences ( ) from the File menu (Windows users) or from 
the Options menu (macOS and Linux users). Click Physics Builder and select the Enable Physics 

Builder check box. 

After the applicable check box is selected, go to the Model Wizard and on the New page under 
Physics, click Physics Builder ( ). See the Physics Builder Manual for information.
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Component Nodes by Space Dimension
The Component node has different icons based on space dimension 0D ( ) (no space dimension), 1D ( ), 1D 

axisymmetric ( ), 2D ( ), 2D axisymmetric ( ), and 3D ( ).

S E L E C T  P H Y S I C S

On the Select Physics window, there are different ways to select one or several physics interfaces to add to the model. 
There are also interfaces for PDEs, ODEs, and DAEs, and other mathematical interfaces for equation-based 
modeling under the Mathematics branch.

Once one or more physics interfaces are selected, there are several options to continue; see Figure 2-14. Click to 
select one of these buttons:

0D is used for interfaces modeling spatially homogeneous systems such as chemical reacting 
systems, electrical circuits, and general ODEs and DAEs. If you want to import a geometry, this 
is done in the Model Builder, but make sure you choose spatial dimensions that this geometry 
exists in. Remember, not all physics interfaces are available for all space dimensions.

Also add a Component node to the Model Builder:

• By right-clicking the root node ( ) and selecting it from the Add Component menu.

• In the Home toolbar, select an option from  Add Component list. 

ICON AND NAME ACTION

Add Double-click to add the selected physics interface to the Added physics interfaces list, or 
right-click and select Add physics to add one or more selected physics interfaces. You can also 
add the selected physics by pressing Enter. Add as many physics interfaces as you want. You 
can use the Review Physics Interface page to edit the Dependent Variables as required. Click 
Remove as required to organize the physics interfaces in the list.

 Space Dimension Click to go back to the Select Space Dimension page.

 Study Click to choose the study for the model.

 Done Click to add the physics interface without a study. 

 Cancel Click to return to the New page of the Model Wizard.

 Help Click to open the context-based Help window.

You can also add physics interfaces from the Model Builder and The Add Physics Window:

• In the Home toolbar, click the  Add Physics button.

• By right-clicking the Component node and selecting Add Physics. 
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Figure 2-14: The Select Physics and Review Physics Interface windows in the Model Wizard. 

R E V I E W  P H Y S I C S  I N T E R F A C E

Under Added physics interfaces (see Figure 2-14), click any interface to open the Review Physics Interface page. Here 
you can review and optionally modify any Dependent Variables names and, for some physics interfaces, specify the 
number of dependent variables. For other physics interfaces you can edit both the name of the field and the field 
components. Examples of fields with components are the displacement field in a Solid Mechanics interface and the 
Velocity field for a Laminar Flow interface.

To remove a physics interface already selected, highlight it in the list and click Remove under the table.

S E L E C T  S T U D Y

On the Select Study page, click to select the type of study to perform. You can also double-click the study to select 
it and close the Model Wizard. The available options depend on the set of physics interfaces included in the model. 
Some study types are applicable to all physics interfaces for which you choose to solve, while others are not, but all 
are in some way available. The most applicable and common studies, such as Stationary, appear at the top of the list 
under General Studies. You can also select a study type from one of the following branches (see Figure 2-15):

• General Studies — General studies that are the most applicable for the selected physics interfaces.

• Preset Studies for Selected Physics Interfaces — Studies applicable to each physics interface that you have chosen 
to include. These preset studies appear under subnodes for each physics interface or under Suggested by Some 

Physics Interfaces.

• Preset Studies for Selected Multiphysics — Studies applicable to the multiphysics couplings that you have chosen 
to solve for.

• More Studies — Any fundamental study types (Stationary, Time Dependent, Eigenfrequency, Eigenvalue and 
Frequency Domain) that are not applicable to any of the physics interfaces being solved for. Also, this branch can 
contain some advanced composite study types.
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• Preset Studies for Some Physics Interfaces — The study types recognized by some, but not all, of the physics 
interfaces being solved for.

• Empty Study — An empty study that will not perform any type of study unless you add some study steps to it.

Figure 2-15: The Select Study page in the Model Wizard.

Once a study is highlighted, information about it displays to the right of the window and it is included under Added 

study. There are several options to continue.

ICON AND NAME ACTION

 Physics Click to go back to the Select Physics and Review Physics Interface window.

 Done Click to exit the Model Wizard.

 Cancel Click to return to the New page of the Model Wizard.

 Help Click to open the context-based Help window.

Also add physics interfaces from the Model Builder and The Add Physics Window:

• In the Home toolbar, click the  Add Physics button.

• By right-clicking the Component node and selecting Add Physics.
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After clicking Done, the Model Builder window displays a model tree with a set of default nodes in the Component 
branches: Definitions, Geometry, Materials, Mesh, and nodes based on the physics interfaces selected (see 
Figure 2-16). The Component nodes and branches form the sequence of operations that define the model.

Figure 2-16: After clicking Done, a 3D Component with Electric Currents, Heat Transfer in Solids interfaces, and a 
Stationary study is added to the Model Builder.

Also add a study from the Model Builder and The Add Study Window:

• By right-clicking the root node and selecting Add Study.

• In the Home toolbar, click the Add Study button.

• Building a COMSOL Multiphysics Model

• The Component Node

• The Add Physics Window

• The Add Study Window

• The Model Builder
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T oo l b a r s  and K e yboa r d  S ho r t c u t s

The toolbars and context menus in COMSOL Multiphysics are based on the stage of modeling. This section is a 
single resource for each of the ribbon and contextual toolbars available on the COMSOL Desktop. There are also 
several Keyboard Shortcuts that are useful for navigating during the modeling process. The following sections have 
a table where there are links to more information about the available items in the ribbon toolbar or contextual 
toolbar.

Home Toolbar

The Home ribbon toolbar (Windows) and the Model Toolbar (macOS and Linux) contains many of the common 
features and actions required to build and analyze a model. 

• Home Toolbar

• Definitions Toolbar

• Geometry Toolbar

• Sketch Toolbar

• Work Plane Modal Toolbar

• Materials Toolbar

• Physics Toolbar

• 0D Component Toolbar

• Mesh Toolbar

• Study Toolbar

• Results Toolbar

• Plot Group Contextual Toolbar

• Report Group Contextual Toolbar

• Template Group Contextual Toolbar

• View Toolbar

• Developer Toolbar

About Changes to the Ribbon Display (Windows Users)

For step-by-step instructions and general documentation descriptions, this is the Home toolbar. 

TABLE 2-6:  THE HOME TOOLBAR

BUTTON 
OR MENU

NAME DESCRIPTION OR OPTIONS LINK TO MORE INFORMATION

Application 

Application 
Builder 
(Ctrl+Shift+A)

Toggle between the Application Builder and Model 
Builder windows.

Model 

Component Select any existing model component to move to 
that component. The name and icon indicates the 
current component and can therefore vary.

The Component Node

Add Component Add 3D, 2D, 2D Axisymmetric, 1D, 1D 
Axisymmetric, and 0D model components.

The Component Node
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Definitions 

Parameters Add globally available Parameters to your model. Global Definitions, 
Geometry, Mesh, and 
Materials and Parameters

Variables Choose from Global Variables and Local Variables. Global Definitions, 
Geometry, Mesh, and 
Materials, Predefined and 
Built-In Variables

Functions Choose from a list of all available Functions Functions

Parameter Case Add a Parameter Case subnode to a Parameters 
node.

Parameter Cases

Geometry 

Build All Build all features in the current geometry. Editing and Building 
Geometry Nodes

The Geometry Node

Import Import the geometry from a COMSOL 
Multiphysics file or CAD file.

Import

LiveLink Choose to connect to a CAD software using a 
LiveLink connection that is included in your license.

See the documentation for the 
CAD LiveLink products.

Materials 

Add Material Open the Add Material window to add materials to 
components or selections.

The Add Material Window

Physics 

— Various — the 
physics interface 
name

When physics interfaces are added, these are listed 
here and you can click to take you to the node in 
the Model Builder.

Physics Interface Guide

Select Physics 
Interface

For a blank model this is available. Selecting Physics Interfaces

 Add Physics Open the Add Physics window to add physics 
interfaces to the current component. 

The Add Physics Window

Mesh 

Build Mesh Build the current mesh. Adding, Editing, and 
Building Meshing Sequences

Select Mesh1 Available for a blank model. Mesh Elements for 1D, 2D, 
and 3D Geometries

Mesh1 When meshes are added, these are listed here and 
you can click to take you to the node in the Model 
Builder.

Creating a Mesh for Analysis

Study 

Compute1 Compute the selected study. Computing a Solution

TABLE 2-6:  THE HOME TOOLBAR

BUTTON 
OR MENU

NAME DESCRIPTION OR OPTIONS LINK TO MORE INFORMATION
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Select Study1 Available for a blank model. Open a New Window to 
Begin Modeling and The Add 
Study Window

Study1 When studies are added, these are listed here and 
you can click to take you to the node in the Model 
Builder.

Introduction to Solvers and 
Studies

 Add Study1 Open the Add Study window to add a study to the 
current Component.

The Add Study Window

Results 

Select Plot 
Group1

Available for a blank model. About Plot Groups

— Various —the 
name of the plot 
group1

Once results are available or plot groups are added, 
these are listed here and you can click to take you 
to the node in the Model Builder. It also opens a 
new Plot Group contextual toolbar for the plot 
group.

Plot Groups and Plots

Add Plot Group1 3D Plot Group, 2D Plot Group, 1D Plot Group, 
Polar Plot Group, or Smith Plot Group.

About Plot Groups

Layout

Reset Desktop2 Reset the COMSOL Desktop to its default settings 
and choose Widescreen Layout or Regular Screen 
Layout.

Customizing the Desktop 
Layout

Windows Choose any of the available windows that you can 
add to the COMSOL Desktop. The Windows 
menu contains the windows on the following rows 
in this table.

Add Physics2 Open the Add Physics window to add physics 
interfaces to the current component.

Creating a New Model

Add 
Multiphysics2

Open the Add Multiphysics window to add 
multiphysics couplings to the current component.

The Add Multiphysics 
Window

Add Study2 Open the Add Study window to add a study to the 
current Component.

The Model Wizard

Add Material 
from Library2

Open the Add Material window to add materials to 
components or selections from the material 
libraries.

The Add Material Window

Material 
Browser2

Open the Material Browser where you can access 
and edit material libraries.

The Material Browser 
Window

Application 
Libraries2

Open the Application Libraries window. The Application Libraries 
Window

Part Libraries2 Open the Part Libraries window where you can 
access collections of geometry parts.

Part Libraries

Selection List2 Choose objects, for example, while working with 
complex geometries and when you need to easily 
locate a geometric entity that is not easily viewed.

The Selection List Window

Properties2 The Properties window is accessed from the 
context menu and displays other node properties.

Settings and Properties 
Windows for Feature Nodes

TABLE 2-6:  THE HOME TOOLBAR

BUTTON 
OR MENU

NAME DESCRIPTION OR OPTIONS LINK TO MORE INFORMATION
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Definitions Toolbar

The Definitions ribbon toolbar (Windows) and the Definitions contextual toolbar (macOS and Linux) contain many 
of the common features and actions required to work with features found under the Definitions node in the Model 
Builder.

Messages2 Contains information useful after an operation is 
performed.

The Messages Window

Debug Log Displays debug information for debugging code in 
methods.

See the Application Builder 
Reference Manual.

Table2 Displays the results from integral and variable 
evaluations defined in Derived Values nodes or by 
Probes and stored in Table nodes.

The Table Window and 
Tables Node

External 
Process2

Follow external processes (such as distributed 
batch jobs) that have been started. The window 
updates when you are attached to the external 
processes. 

The External Process Window

Recovery Files2 Manage and open recovery files. Saving and Opening Recovery 
Files

Comparison 
Results2

Comparison of Physics Builder files. See the Physics Builder Manual.

Physics Builder 
Manager2

Manage testing, compilation, and comparison of 
your Physics Builder files. 

See the Physics Builder Manual.

1 For cross-platform users (macOS and Linux), the combination of buttons that display is dependent on the toolbar 
setting. For example, some buttons may not be visible if the Tools>Toolbar Display Mode is set to Normal and the 
Tools>Toolbar Button Label is set to Show Icon and Text. It also depends on whether you are using a widescreen or 
regular screen layout.
2 For cross-platform users (macOS and Linux), these options are available from other menus or toolbars. See Cross 
Platform (macOS and Linux) Toolbars and Menus.

For step-by-step instructions and general documentation descriptions, this is the Definitions 
toolbar. 

TABLE 2-7:  THE DEFINITIONS TOOLBAR

BUTTON 
OR 
MENU

NAME DESCRIPTION OR OPTIONS LINK TO MORE INFORMATION

Variables

Local Variables Add a Variables node under Definitions. Global Definitions, Geometry, 
Mesh, and Materials, 
Predefined and Built-In 
Variables

Variable Utilities Add a variable utility such as a matrix variable 
under Definitions.

Variable Utilities

Functions

Analytic Add an Analytic function node to define an 
analytic function.

Analytic

TABLE 2-6:  THE HOME TOOLBAR

BUTTON 
OR MENU

NAME DESCRIPTION OR OPTIONS LINK TO MORE INFORMATION
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Interpolation Add an Interpolation function node to define an 
interpolation function.

Interpolation

Piecewise Add a Piecewise function node to define a 
piecewise function.

Piecewise

More Functions All available Functions (except Analytic, 
Interpolation, and Piecewise).

Functions

Selections

Explicit Add an Explicit node under Definitions. Creating Named Selections and 
Explicit

Complement Add a Complement node under Definitions. Union, Intersection, 
Difference, and Complement

Adjacent Add an Adjacent node under Definitions. Adjacent

Ball/Disk Add a Ball (3D) or Disk node under Definitions. Ball, Disk

Box Add a Box node under Definitions. Box

Cylinder Add a Cylinder node under Definitions. Cylinder

Union Add a Union node under Definitions. Union, Intersection, 
Difference, and Complement

Intersection Add an Intersection node under Definitions.

Difference Add a Difference node under Definitions.

Colors Add, reset, or remove colors for selections. Selection Colors

Probes

Update Probes Update all probes. Probes

Probes Select an option from the list to add a node 
under Definitions Table 5-18. 

Physics Variables

Mass Properties Add a Mass Properties node to the current 
model component.

Mass Properties

Mass Contributions Add a Mass Contributions node to the current 
model component (under More Physics 
Variables).

Mass Contributions

Participation 
Factors

Add a Participation Factors node to the current 
model component (under More Physics 
Variables).

Participation Factors

Response Spectrum Add a Response Spectrum node to the current 
model component (under More Physics 
Variables).

Response Spectrum

TABLE 2-7:  THE DEFINITIONS TOOLBAR

BUTTON 
OR 
MENU

NAME DESCRIPTION OR OPTIONS LINK TO MORE INFORMATION
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Geometry Toolbar

Once a geometry is added to the model, the Geometry ribbon toolbar (Windows) and the Geometry contextual 
toolbar (macOS and Linux) contains many of the common features and actions required to create and build a 
geometry.

For cross-platform users, some options listed in Table 2-8 are available from other toolbars and menus. Table 2-9 
lists the geometry drawing tools available on the toolbars in 1D and 2D, as well as on the Work Plane toolbar for 
3D models. See Cross Platform (macOS and Linux) Toolbars and Menus.

Coupling

Nonlocal Couplings Select an option from the list to add a node 
under Definitions.

Nonlocal Couplings and 
Coupling Operators

Pairs Select an option from the list to add a node 
under Definitions.

About Identity and Contact 
Pairs

Coordinate Systems

Coordinate 
Systems1

Select an option from the list to add a node 
under Definitions Table 5-17. 

Coordinate Systems

Perfectly Matched 
Layer1

Add a Perfectly Matched Layers node under 
Definitions.

Perfectly Matched Layer

Infinite Element 
Domain1

Add an Infinite Element Domain node under 
Definitions.

Infinite Element Domain

Absorbing Layer1 Add an Absorbing Layer node under Definitions. Absorbing Layer

Deformed Mesh

Moving Mesh Add moving mesh nodes under Definitions. Moving Mesh Features

Deformed 
Geometry

Add deformed geometry nodes under 
Definitions.

Deformed Geometry Features

Optimization

Optimization Add optimization nodes. See the documentation for the 
Optimization Module.

View

 View1 Add a View node to the current Component to 
control the view and lighting in the Graphics 
window.  3D and  2D.

View (1D and 2D), View (3D), 
Axis (2D and 2D 
Axisymmetric) and Axis (1D 
and 1D Axisymmetric)

1 For cross-platform users (macOS and Linux), the combination of buttons that display is dependent on the toolbar 
setting. For example, some buttons may not be visible if the Tools>Toolbar Display Mode is set to Normal and the 
Tools>Toolbar Button Label is set to Show Icon and Text. It also depends on whether you are using a Widescreen or 
Regular Screen Layout.

For step-by-step instructions and general documentation descriptions, this is the Geometry toolbar. 

TABLE 2-7:  THE DEFINITIONS TOOLBAR

BUTTON 
OR 
MENU

NAME DESCRIPTION OR OPTIONS LINK TO MORE INFORMATION
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TABLE 2-8:  THE GEOMETRY TOOLBARS

BUTTON 
OR 
MENU

NAME DESCRIPTION OR OPTIONS

Build 

Build All2 Build all features in the current geometry. See Editing and Building Geometry 
Nodes.

Import/Export 

Import2 Import the geometry from a COMSOL Multiphysics file or CAD file.

Insert Sequence Insert a geometry sequence from a COMSOL Multiphysics file into the current 
geometry. See Inserting a Sequence.

Export Export the current geometry as a COMSOL binary or text file or to a CAD file 
format. See Exporting a Geometry.

Cleanup 

Defeaturing and 
Repair1,3

Choose from Cap Faces, Delete Fillets, Delete Short Edges, Delete Sliver Faces, Delete 
Small Faces, Delete Spikes, Delete Faces, Detach Faces, Knit to Solid, and Repair.

Remove Details Remove small details from 3D geometries. See Remove Details.

Virtual 
Operations1

Virtual geometry operations and mesh control operations. See Virtual Geometry 
Operations and Virtual Geometry and Mesh Control Operations.

Sketch (2D) 

Sketch Toggle the sketch visualization on or off. See The Sketch Visualization.

Primitives  (3D)

Block Add a Block to the current geometry.

Cone Add a Cone to the current geometry.

Cylinder Add a Cylinder to the current geometry.

Sphere Add a Sphere to the current geometry.

Torus Add a Torus to the current geometry.

Helix Add a Helix to the current geometry.

More Primitives Add all other 3D primitives as in Table 7-3 and Geometric Primitives. Also see the 
geometry parts available in the Part Libraries.

Primitives  (2D)

Circle Add a Circle to the current geometry.

Ellipse Add an Ellipse to the current geometry.

Rectangle Add a Rectangle to the current geometry.

Square Add a Square to the current geometry.

Polygon Add a Polygon to the current geometry.



T O O L B A R S  A N D  K E Y B O A R D  S H O R T C U T S  |  117

Point Add a Point to the current geometry.

More Primitives Add all other 2D primitives as in Table 7-3 and Geometric Primitives. Also see The 
1D Geometry Toolbar — Drawing Tools (Table 2-9) and the geometry parts 
available in the Part Libraries.

Primitives  (1D)

Interval Draw an interval (line) in the Graphics window. For 1D models, first click the Interval 
button, then click the starting point and endpoint in the Graphics window.

Also see Geometric Primitives and The 1D Geometry Toolbar — Drawing Tools 
(Table 2-9).

Point Add a point to the Graphics window. Use this to draw a single point. First click the 
Point button, then click in the Graphics window (in 1D and 2D), or specify the point 
location in its Settings window. In 2D and 3D, this button is available on the More 
Primitives menu.

Work Plane 

Select Work 
Plane

Once Work Planes are available or added, these are listed here and you can click to 
take you to the associated Plane Geometry node in the Model Builder. It also opens a 
new Work Plane contextual toolbar for the Work Plane. See Using Work Planes, 
Work Plane Modal Toolbar and Table 2-9.

Work Plane Add a Work Plane to the current geometry. See Using Work Planes, Work Plane 
Modal Toolbar and Table 2-9.

Operations 

Extrude Extrude planar faces of geometry objects or objects from a work plane to create 3D 
geometry objects.

Revolve Revolve planar faces of geometry objects or objects from a work plane about an axis 
to create 3D geometry objects.

Sweep Sweep faces along a spine curve to create a solid object.

Loft Requires the Design Module. Lofting planar sections along a path.

Booleans and 
Partitions

Create a geometry object using Boolean operations: Union, Intersection, Difference, 
and Compose.

Partition geometry objects into parts using other geometry objects as tool objects for 
the partition. Alternatively, in 3D, use a work plane to partition the geometry objects. 
Select Partition Objects or Partition Edges.

Transforms This menu has these operations available: Array, Copy, Mirror, Move, Rotate1, Scale1

Conversions1 See Table 7-8 for a list of these features. Also see Conversion Operations.

Chamfer1 Chamfer corners in 2D geometry objects. Also in 3D with the Design Module.

Fillet1 Fillet corners in 2D geometry objects. Also in 3D with the Design Module.

Tangent Add a line segment that is tangent to a given edge in 2D geometries.

Delete1 Delete the selected geometry objects. See Clearing Sequences and Deleting 
Sequences or Nodes.

TABLE 2-8:  THE GEOMETRY TOOLBARS

BUTTON 
OR 
MENU

NAME DESCRIPTION OR OPTIONS
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G E O M E T R Y  D R A W I N G  T O O L B A R  B U T T O N S

In 1D, there are buttons for drawing Geometric Primitives by using the mouse. In 2D, the Sketch Toolbar provides 
tools for drawing 2D geometric primitives. In 3D, the buttons are available to create primitives, but you cannot 
draw these using the mouse unless you are using a Work Plane.

Edit Object Adjust edges and vertices for 2D geometry objects or add or delete edges and vertices 
in the object.

Cross Section Create 2D cross sections from 3D geometries.

Other 

Parts 3D, 2D, and 1D Parts, Load Part, and Part Instances. See Part Libraries, Using 
Geometry Parts, and Part Instance.

Programming1 If + End If and Parameter Check. From the Add Before and Add After menus: If, Else If, 
Else, and End If. See If, Else If, Else, End If, and Parameter Check.

Selections1 Create named selections of geometry objects or geometric entities in geometry 
objects. See Creating Named Selections in the Geometry Sequence.

Colors1 Add coloring to highlight named selections in the Graphics window. See Selection 
Colors.

Measure1 Measure the volume, area, perimeter, or other geometric properties of the selected 
geometric entities or objects. See Measuring Geometry Objects.

Delete 
Sequence1

Delete a geometry sequence. See Clearing Sequences and Deleting Sequences or 
Nodes.

1 For cross-platform users (macOS and Linux), the combination of buttons that display is dependent on the toolbar 
setting. For example, some buttons may not be visible if the Tools>Toolbar Display Mode is set to Normal and the 
Tools>Toolbar Button Label is set to Show Icon and Text. It also depends on whether you are using a Widescreen or 
Regular Screen Layout. It also depends if the button is available on the Work Plane toolbar, in which case it may be 
visible.
2 For cross-platform users, this option is available from a different toolbar or menu. See Cross Platform (macOS 
and Linux) Toolbars and Menus.
3 These features are available for the LiveLink and CAD products, and you must use the CAD kernel for the 
geometry representation.

TABLE 2-9:  THE 1D GEOMETRY TOOLBAR — DRAWING TOOLS

BUTTON 
OR 
MENU

NAME DESCRIPTION OR ACTION

Draw Settings 

Snap to Grid Snap to the grid when drawing a geometry object in the Graphics window.

By default, the mouse pointer snaps to the grid points. The active grid point for the 
snapping is indicated with a red circle. To disable snapping to the grid, click the Snap to 
Grid button.

Snap to 
Geometry

Snap to the vertices of other geometry objects when drawing a geometry object in the 
Graphics window.

By default, the mouse pointer snaps to the geometry vertices. The active point for the 
snapping is indicated with a red circle. To disable snapping to the geometry objects, 
click the Snap to Geometry button.

TABLE 2-8:  THE GEOMETRY TOOLBARS

BUTTON 
OR 
MENU

NAME DESCRIPTION OR OPTIONS
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Sketch Toolbar

Use the Sketch toolbar to draw in the graphics window for a 2D geometry or part, or in a work plane for a 3D 
geometry. If you have the Design Module, the Sketch toolbar also contains buttons for creating geometric 
constraints and dimensions (see the Design Module documentation for more information)..

Draw 

Interval Draw an Interval (line) in the Graphics window. For 1D models, first click the Interval 
button, then click the starting point and endpoint in the Graphics window.

Point Add a Point to the Graphics window. Use this to draw a single point. First click the 
Point button, then click in the Graphics window (in 1D and 2D), or specify the point 
location in its Settings window. In 2D and 3D, this button is available on the More 
Primitives menu.

TABLE 2-10:  THE SKETCH TOOLBAR

BUTTON 
OR 
MENU

NAME DESCRIPTION OR ACTION

Sketch

Sketch Toggle the sketch visualization on or off. See The Sketch Visualization.

Draw Settings 

Snap to Grid Snap vertices and edges to the grid when drawing or dragging a vertex in the Graphics 
window. The snapped cursor position is indicated with a blue circle.

Snap to 
Geometry

Snap vertices and edges to vertices and edges when drawing or dragging a vertex in the 
Graphics window. The vertex or edge snapped to is highlighted in turquoise. There can 
also be a green line or circle segment between the snapped entities. If you have the 
Design Module and you have enabled Use constraints and dimensions in the Geometry 
node’s settings: When snapping occurs, a constraint feature will be generated in some 
cases, so that the snapping will persist when you modify your geometry.

Solid Create a solid object (instead of a curve object) when drawing a closed curve in the 
Graphics window.

Draw 

Polygon Draw a sequence of line segments in the Graphics window. Click the points of the 
polygon. Then right-click anywhere to finish, or click another curve drawing button to 
create a Composite Curve.

Circular Arc Draw a sequence of circular arcs in the Graphics window in one of the following ways:

• Click the Circular Arc button or choose the menu item Start, Center, Angle. Then 
click the starting point, the center, and the direction of the end angle.

• Choose the Start, Tangent, End menu item. Then click the starting point, the 
direction of the tangent line at the starting point, and the endpoint.

• Choose the Start, Tangent, End menu item. Then click the starting point, the 
direction of the tangent line at the starting point, and the endpoint.

TABLE 2-9:  THE 1D GEOMETRY TOOLBAR — DRAWING TOOLS

BUTTON 
OR 
MENU

NAME DESCRIPTION OR ACTION
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Interpolation 
Curve

Draw a cubic spline curve that interpolates given points in the Graphics window, in one 
of the following ways:

• Click the Interpolation Curve button or choose the Interpolation Points menu item. 
Then click a sequence of points to interpolate.

• Choose the Start, Tangent, Other menu item. Then click the starting point, the 
direction of the tangent line at the starting point, and the other interpolation 
points.

Finally, right-click anywhere to finish, or click another curve drawing button to 
create a Composite Curve.

Quadratic Draw a sequence of quadratic Bézier curve segments in the Graphics window. Click 
the three control points to create one Bézier segment. A Quadratic Bézier node is 
then added. Optionally, click an even number of additional control points to create 
several Bézier segments. Finally, right-click anywhere to finish, or click another curve 
drawing button to create a Composite Curve that contains Quadratic Bézier nodes 
corresponding to each Bézier segment.

Cubic Draw a sequence of cubic Bézier curve segments in the Graphics window. Click the 
four control points to create one Bézier segment. A Cubic Bézier node is then added. 
Optionally, click additional control points to create several Bézier segments. Finally, 
right-click anywhere to finish, or click another curve drawing button to create a 
Composite Curve that contains Cubic Bézier nodes corresponding to each Bézier 
segment.

Point Draw a point in the Graphics window. After clicking the button, click the point in the 
Graphics window.

Rectangle Draw a rectangle or square in the Graphics window in one of the following ways:

• Click the Rectangle button or choose the Rectangle menu item. Then click two 
opposite corners of the rectangle.

• Choose the Square menu item. Then click one corner. Move the mouse to adjust 
the size of the square. Click to finish.

• Choose the Rectangle (Center) menu item. Then click the center and one corner.

• Choose the Square (Center) menu item. Then click the center. Move the mouse 
to adjust the size of the square. Click to finish.

Circle Draw a circle or ellipse in the Graphics window in one of the following ways:

• Click the Circle button or choose the Circle menu item. Then click the center. 
Move the mouse to adjust the size of the circle. Click to finish.

• Choose the Ellipse menu item. Then click the center. Move the mouse to adjust 
the axes of the ellipse. Click to finish.

• Choose the Circle (Corner) menu item. Then click one corner of the circumscribed 
square of the circle. Move the mouse to adjust the size of the circumscribed 
square. Click to finish.

• Choose the Ellipse (Corner) menu item. Then click one corner of the 
circumscribed rectangle of the ellipse. Move the mouse to adjust the size of the 
circumscribed rectangle. Click to finish.

TABLE 2-10:  THE SKETCH TOOLBAR

BUTTON 
OR 
MENU

NAME DESCRIPTION OR ACTION
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Work Plane Modal Toolbar

The Work Plane modal toolbar is available after clicking Plane Geometry under Geometry>Work Plane in the Model 
Builder.

Operations 

Composite 
Curves

Create a Composite Curve feature that has a sequence of child features of type 
Polygon, Circular Arc, Interpolation Curve, Quadratic Bézier, and Cubic Bézier. First 
select at least one edge from each curve object to include in the Composite Curve in 
the Graphics window. These objects must be of one of the following types: Polygon, 
Circular Arc, Interpolation Curve, Quadratic Bézier, Cubic Bézier, or Composite 
Curve. The curve objects must form a single connected chain. Then click the Compose 
Curves button. The original curve features will be replaced with a Composite Curve 
feature or a Polygon feature in the Model Builder.

Delete Delete the selected vertices and edges. Select some vertices and edges in the Graphics 
window. Then click the Delete button or press the Del key. This will delete the selected 
entities using a combination of the following methods:

• Removing geometry features from the Model Builder

• Removing points from Polygon features

• Splitting Polygon and Composite Curve features into several features

• Adding Delete Entities features

This operation does not delete selected vertices that are adjacent to an edge that is 
not selected.

If you have the Design Module, you can also select symbols for constraint and 
dimension features and then delete them by clicking Delete or pressing Del.

For step-by-step instructions and general documentation descriptions, this is the Work Plane modal 
toolbar.

The Work Plane toolbar is similar to the 2D Geometry Toolbar except that the Virtual Operations 
menu is not available and there is a Close button.

TABLE 2-10:  THE SKETCH TOOLBAR

BUTTON 
OR 
MENU

NAME DESCRIPTION OR ACTION
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Figure 2-17: Click the Plane Geometry node to open the Work Plane toolbar.

Materials Toolbar

Once physics interfaces are added to the model, the Materials ribbon toolbar (Windows) and the Materials 
contextual toolbar (macOS and Linux) contains many of the common features and actions required to work with 
the features found under the Materials node in the Model Builder.

For step-by-step instructions and general documentation descriptions, this is the Materials toolbar. 

TABLE 2-11:  THE MATERIALS TOOLBAR

BUTTON 
OR 
MENU

NAME DESCRIPTION OR OPTIONS LINK TO MORE INFORMATION

Materials

Add Material Open the Add Material window to add materials to 
components or selections.

The Add Material Window

Blank Material Add a blank material to your model. Materials and The Settings 
Window for Material

Browse 
Materials

Open the Material Browser where you can access 
and edit material libraries.

The Material Browser Window

More Materials Add a Material Link, a Material Switch, or an 
External Material.

Material Link, Switch for 
Materials, and Working with 
External Materials
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Physics Toolbar

Once physics interfaces are added to the model, the Physics ribbon toolbar (Windows) and the Physics contextual 
toolbar (macOS and Linux) contains many of the common features and actions required to add physics interfaces 
and features to the Model Builder.

Property Groups

Analytic Add an Analytic function node to define an analytic 
function.

Analytic and Using Functions 
in Materials

Interpolation Add an Interpolation function node to define an 
interpolation function.

Interpolation and Using 
Functions in Materials

Piecewise Add a Piecewise function node to define a piecewise 
function.

Piecewise and Using Functions 
in Materials

User-Defined 
Property Group

Add a user-defined property group to current 
material.

Property Groups

User-Defined Libraries

Add to Library Add a material to a user-defined material library. User-Defined Materials and 
Libraries

For interfaces available in 0D, see 0D Component Toolbar.

For step-by-step instructions and general documentation descriptions, this is the Physics toolbar.

TABLE 2-12:  THE PHYSICS TOOLBAR

BUTTON 
OR 
MENU

NAME DESCRIPTION OR OPTIONS LINK TO MORE INFORMATION

Physics 

— Various - the 
physics 
interface name

Any physics interfaces added to the selected 
Component are listed. Click to go to the node in the 
Model Builder and open the Settings window. See 
Physics Interface Guide.

The Physics Interfaces

Add Physics Open the Add Physics window to add physics 
interfaces to the current component.

The Add Physics Window

Add 
Multiphysics

Open the Add Multiphysics window to add 
applicable multiphysics couplings to the current 
component.

The Add Multiphysics Window

Insert Physics 
from Model

Open the Insert Physics dialog box to insert physics 
interfaces in the current model component from 
another model file.

Adding and Inserting Physics 
Interfaces

TABLE 2-11:  THE MATERIALS TOOLBAR

BUTTON 
OR 
MENU

NAME DESCRIPTION OR OPTIONS LINK TO MORE INFORMATION
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0D Component Toolbar

Once a 0D component interface is added to the model, a toolbar with the same name as the physics interface 
displays in the ribbon (Windows) and the contextual toolbar (macOS and Linux).

These toolbars are documented for the interfaces in the applicable module documentation.

Geometric Entity

Domains See Table 3-3 for a list of all the icons by space 
dimension.

Available physics features for the physics interface 
are listed. To add subnodes, however, you need to 
right-click the parent node. For example, to add a 
Destination Selection subnode, right-click Periodic 
Condition.

About Geometric Entities

About Selecting Geometric 
Entities

Boundaries

Pairs

Edges

Points

Global

Contextual 

— Attributes Subnodes that can be added to a main (parent) 
node. 

 0D,  1D,  2D, and  3D

For example, Destination 
Selection (a subnode to Periodic 
Condition) or Damping (a 
subnode to Linear Elastic 
Material).

When available, Harmonic 
Perturbation is added from this 
menu as an exclusive node. See 
Harmonic Perturbation — 
Exclusive and Contributing 
Nodes

Load Group After adding a Load Group to the Global Definitions 
branch you can activate it in one or more load cases.

Using Load Cases

Constraint 
Group

After adding a Constraint Group to the Global 
Definitions branch you can activate it in one or 
more load cases.

Harmonic 
Perturbation

Click this to add Harmonic Perturbation as a 
contributing node.

Harmonic Perturbation — 
Exclusive and Contributing 
Nodes

Multiphysics

Multiphysics 
Couplings

This menu contains any physics features that provide 
multiphysics couplings likely to be used for the set of 
physics interfaces added to the Model Builder.

Multiphysics Modeling 
Workflow and The 
Multiphysics Branch

For step-by-step instructions and general documentation descriptions, the name of the toolbar is 
the same as the physics interface it is attached to.

TABLE 2-12:  THE PHYSICS TOOLBAR

BUTTON 
OR 
MENU

NAME DESCRIPTION OR OPTIONS LINK TO MORE INFORMATION
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A V A I L A B L E  W I T H  A  C O M S O L  M U L T I P H Y S I C S  L I C E N S E :

• Global ODEs and DAEs. See The Global ODEs and DAEs Interface.

• Events. See The Events Interface.

• Sensitivity. See The Sensitivity Interface.

A V A I L A B L E  W I T H  T H E  A D D I T I O N  O F  V A R I O U S  L I C E N S E S :

• Reaction Engineering

• Chemistry

• Optimization

Mesh Toolbar

Once a mesh is added to the model, the Mesh ribbon toolbar (Windows) and the Mesh contextual toolbar (macOS 
and Linux) contains many of the common features and actions required to work with meshes.

TABLE 2-13:  THE MESH TOOLBAR

BUTTON 
OR MENU

NAME DESCRIPTION OR OPTIONS LINK TO MORE INFORMATION

Build

Build Mesh2 Build the current mesh. Adding, Editing, and Building 
Meshing Sequences

Mesh (1, 2, 3,...) Lists the meshes available in the model. Click a 
Mesh button to go to the node in the Model 
Builder.

Creating a Mesh for Analysis

Add Mesh Add a new mesh to the current model 
component.

Adding, Editing, and Building 
Meshing Sequences

Physics Controlled 

Edit Edit the physics-controlled sequence.

Physics-Controlled Mesh
Reset Reset the sequence to the physics-controlled 

settings.

Mesh Size (Normal 
is the default)

See Table 8-1 for a list of options. The Mesh Toolbar (Predefined 
Mesh Element Sizes)

Mesh Element Quality and 
Size

Generators 

Free Tetrahedral Generate unstructured tetrahedral mesh for 3D 
components.

Free Tetrahedral

Swept Generate swept mesh for 3D components. Swept

Boundary The following are available from this menu: Free 
Triangular, Free Quad, Mapped, and Edge.

Boundary Layers Generate boundary layer mesh. Boundary Layers

Operations 

Modify Size: Distribution and Corner Refinement

Elements: Convert and Refine

Mesh: Reference and Scale

Meshing Operations and 
Attributes and Mesh Attributes



126 |  C H A P T E R  2 :  T H E  C O M S O L  M O D E L I N G  E N V I R O N M E N T

Copy Copy Domain, Copy Edge, Copy Face, and 
Copy.

Meshing Operations and 
Attributes

Attributes 

Mesh Size (Normal 
is the default)

See Table 8-1 for a list of options. The Mesh Toolbar (Predefined 
Mesh Element Sizes)

Mesh Element Quality and 
Size

Distribution Add a Distribution node under the selected 
node to specify an element distribution.

Mesh Attributes

More Attributes See Mesh Attributes.

Import/Export 

Import Import mesh. Importing Meshes

Partition Entities Create geometric entities by partitioning the 
mesh. Ball, Box, Cylinder, Logical Expression, 
and Detect Faces.

Using Operations on an 
Imported Mesh

Create Entities Create mesh vertices, edges, faces, and domains, 
and fill holes in imported meshes.

Using Operations on an 
Imported Mesh

Delete Entities Delete geometric entities. Using Operations on an 
Imported Mesh

Join Entities Join adjacent geometric entities. Using Operations on an 
Imported Mesh

Export Export mesh. Exporting Meshes

Create Part Create a Mesh Part node, under which you 
import a mesh and prepare it for use in a 
component.

Using Mesh Parts

Create Geometry 
from Mesh

Create a new model component with a 
geometry created from the mesh.

Creating Geometry from Mesh

Evaluate 

Measure Measure the volume, area, perimeter, or other 
geometric properties of the selected geometry 
objects.

Measuring Geometry Objects

Statistics Write information about number and quality of 
elements to the Messages window.

The Mesh Statistics Window

Plot Add a mesh plot. Mesh (Plot)

Clear 

Clear Mesh1 Clear the mesh. Clearing Sequences and 
Deleting Sequences or Nodes

Clear All Meshes1 Clear all meshes in the model.

TABLE 2-13:  THE MESH TOOLBAR

BUTTON 
OR MENU

NAME DESCRIPTION OR OPTIONS LINK TO MORE INFORMATION
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Study Toolbar

The Study ribbon toolbar (Windows) and the Study contextual toolbar (macOS and Linux) contains many of the 
common features and actions required to work with studies and solvers.

Delete Sequence1 Delete a meshing sequence. Clearing Sequences and 
Deleting Sequences or Nodes

1 For cross-platform users (macOS and Linux), the combination of buttons that display is dependent on the toolbar 
setting. For example, some buttons may not be visible if the Tools>Toolbar Display Mode is set to Normal and the 
Tools>Toolbar Button Label is set to Show Icon and Text. It also depends on whether you are using a Widescreen or 
Regular Screen Layout.
2 For cross-platform users, this option is available from a different toolbar or menu. See Cross Platform (macOS and 
Linux) Toolbars and Menus.

For step-by-step instructions and general documentation descriptions, this is the Study toolbar.

TABLE 2-14:  THE STUDY TOOLBAR

BUTTON 
OR 
MENU

NAME OPTIONS DESCRIPTION OR OPTIONS LINK TO MORE INFORMATION

Study 

Compute1 Compute the selected study. Computing a Solution

Select Study1 See a list of all available studies in Table 20-2. Study and Study Step Types

 Add Study1 Open the Add Study window to add a study to 
the current model component.

The Add Study Window

Continue Continue the computation of a solver sequence 
from the last computed feature.

The Progress Window

Update Solution Update the solution using the current values of 
parameters and user-defined variables.

Updating a Solution

Get Initial Value Generate a solution using the initial values of the 
dependent variables (without solving for the 
dependent variables).

Computing the Initial Values

Solver 

Show Default 
Solver

Display the nodes in the solver sequences that 
are created by default.

Show Default Solver

Study Step 

Study Steps See lists of all available study types and study 
steps in Table 20-2 and Table 20-3.

The Add Study Window and 
The Relationship Between 
Study Steps and Solver 
Configurations

Parametric Sweep Choose Parametric Sweep or Optimization, for 
example.

Study Extension Steps and 
Advanced Study Extension 
Steps

Function Sweep Run a function sweep, switching between 
different user-defined functions.

Function Sweep

TABLE 2-13:  THE MESH TOOLBAR

BUTTON 
OR MENU

NAME DESCRIPTION OR OPTIONS LINK TO MORE INFORMATION
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Results Toolbar

The Results ribbon toolbar (Windows) and the Results contextual toolbar (macOS and Linux) contains many of the 
common features and actions required to work with studies and solvers.

Material Sweep Run a material sweep, switching between 
different materials.

Material Sweep

Combine Solutions Combine solutions using concatenation or 
summation, or by removing solutions.

Combine Solutions

Study Reference Add a study step that refers to another study. Study Reference

Optimization Perform an optimization study. This is available 
with the addition of the Optimization Module.

See the Optimization Module 
User’s Guide.

Parameter 
Estimation

Perform a parameter estimation study. This is 
available with the addition of the Optimization 
Module.

See the Optimization Module 
User’s Guide.

Sensitivity Add a Sensitivity study step. Sensitivity

Model Reduction Add a Model Reduction study step. Model Reduction

Batch & Cluster 

Batch Add a Batch or Batch Sweep study node Batch and Batch Sweep

Cluster Add a Cluster Computing or Cluster Sweep 
study node

Cluster Computing and 
Cluster Sweep

Operations 

Create Solution 
Copy

Make a copy of a solution. Solution Operation Nodes and 
Solvers

Evaluate 

Statistics Display statistics for the study, including the 
number of degrees of freedom (DOFs).

The Statistics Page

Clear 

Clear Solutions Clear the solutions in the current solver 
sequence.

Clearing Sequences and 
Deleting Sequences or Nodes

Clear All Solutions Clear all solutions.

1 For cross-platform users, this option is available from a different toolbar or menu. See Cross Platform (macOS 
and Linux) Toolbars and Menus.

For step-by-step instructions and general documentation descriptions, this is the Results toolbar.

TABLE 2-14:  THE STUDY TOOLBAR

BUTTON 
OR 
MENU

NAME OPTIONS DESCRIPTION OR OPTIONS LINK TO MORE INFORMATION
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TABLE 2-15:  THE RESULTS TOOLBAR

BUTTON OR 
MENU

NAME DESCRIPTION OR OPTIONS LINK TO MORE INFORMATION

Plot Group 

Plot Plot the selected plot group. Plot Groups and Plots. Also 
see Plot Group Contextual 
Toolbar.

— Select Plot 
Group

Choose from a list of plots included in the 
model.

About Plot Groups. Also see 
Plot Group Contextual 
Toolbar.

3D Plot Group Create a new 3D Plot Group for 3D plots 
such as volume and slice plots.

2D Plot Group Create a new 2D Plot Group for 2D plots 
such as surface and contour plots.

1D Plot Group Create a new 1D Plot Group for 1D graph 
plots.

Polar Plot Group Create a new Polar Plot Group for graph 
plots in a polar coordinate system.

Definitions 

Parameters Add a Parameters node under Results for 
defining results parameters.

Parameters

Dataset 

Cut Plane Create a Cut Plane dataset for data on a plane 
in 3D.

Cut Plane

Cut Line 3D Create a 3D Cut Line dataset for data along a 
line in 3D.

Cut Line 2D and Cut Line 3D

Cut Point 3D Create a 3D Cut Point dataset for data at a 
point in 3D.

Cut Point 1D, Cut Point 2D, 
and Cut Point 3D

Cut Line 2D Create a 2D Cut Line dataset for data along a 
line in 2D.

Cut Line 2D and Cut Line 3D

Cut Point 2D Create a 2D Cut Point dataset for data at a 
point in 2D.

Cut Point 1D, Cut Point 2D, 
and Cut Point 3D

More Datasets See Table 21-7 for a list of all datasets. Datasets

Selection (under 
Attributes)

Add a selection to the current dataset. Adding a Selection to a 
Dataset and Creating Named 
Selections

Remesh 
Deformed 
Configuration 
(under 
Attributes)

Create a deformed geometry from a current 
dataset.

Deformed Configuration

Numerical 

Evaluate All Evaluate all derived values and evaluation 
groups.

Table Window toolbar and 
Menu Options

Clear and 
Evaluate All

Clear all current table entries and then 
evaluate all derived values and evaluation 
groups.

Table Window toolbar and 
Menu Options
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Evaluation 
Group

Add an Evaluation Group node to evaluate 
derived values and present them in an 
Evaluation Group table.

About Evaluation Groups

Point Evaluation Add a Point Evaluation node to evaluate some 
expressions or variables at points.

Point Evaluation

Global 
Evaluation

Add a Global Evaluation node to evaluate 
some global expressions or variables.

Global Evaluation

More Derived 
Values

See Table 21-9 for a list of all derived value 
types.

Derived Values, Evaluation 
Groups, and Tables

Table Add a table. Derived Values, Evaluation 
Groups, and Tables

Export 

Data1 Data, Plot, Mesh (Export), Table

Exporting Data and Images

Image1 Image

Animation Animation or Player (see Animation) Create 
a movie to animate a solution (as an animated 
GIF, Flash, AVI, or WebM movie file, an image 
sequence, or as a player directly in the 
COMSOL Desktop Graphics window).

Report 

Report1 Choose a Brief Report, Intermediate Report, 
Complete Report, Custom Report, 
Documentation, or create or choose a 
custom report template.

Creating, Exporting, and 
Using Custom Report 
Templates

Clear 

Clear Plot Data1 Clear all plot data that is stored in the model. Saving Plot Data in the Model
1 For cross-platform users (macOS and Linux), the combination of buttons that display is dependent on the toolbar 
setting. For example, some buttons may not be visible if the Tools>Toolbar Display Mode is set to Normal and the 
Tools>Toolbar Button Label is set to Show Icon and Text. It also depends on whether you are using a Widescreen or 
Regular Screen Layout.

TABLE 2-15:  THE RESULTS TOOLBAR

BUTTON OR 
MENU

NAME DESCRIPTION OR OPTIONS LINK TO MORE INFORMATION
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Plot Group Contextual Toolbar

The plot group contextual toolbar is available after clicking a specific plot group in the Model Builder. The available 
tools are based on the model and the type of plot.

For step-by-step instructions and general documentation descriptions, this is generally referred to 
as the Plot Group toolbar, where the name of the toolbar changes based on the plot group (3D 
Plot Group, 2D Plot Group, 1D Plot Group, or Polar Plot Group). If the plot group is renamed, 
the toolbar name also changes to match the new name, as in the example above where the 3D Plot 

Group toolbar was renamed Stress (solid).

TABLE 2-16:  THE PLOT GROUP CONTEXTUAL TOOLBAR

BUTTON 
OR MENU

NAME LINK TO MORE INFORMATION

Plot 

Plot Plot Groups and Plots

Plot In New Window The Plot Windows

Add Plot 

Various See Table 21-10 for the available plots by Plot 
Group (3D, 2D, 1D, or Polar Plot Groups). 

About Plot Groups

Attributes 

Add a Color Expression to the currently selected 
plot.

Color Expression

Add a Deformation to the currently selected 
plot.

Deformation

Add a Filter to the currently selected plot. Filter

Add a Height Expression to the currently 
selected plot. This is for 2D plots.

Height Expression

Select  (available for creating cross-section plots)

Various See Table 21-11 for a list of the available 
buttons.

Creating Cross-Section Plots and Combining Plots 
and Plotting and Cross-Section Interactive Toolbar

Export 

Various See Table 21-12 for a list of export options. Exporting Data and Images
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Report Group Contextual Toolbar

The report group contextual toolbar is available after clicking a Report node in the Model Builder. It contains tools 
for creating a model report. 

For step-by-step instructions and general documentation descriptions, this is generally referred to 
as the Report Group toolbar, where the name of the toolbar name changes based on the report 
group. If the report group is renamed, the toolbar name also changes to match the new name.

TABLE 2-17:  THE REPORT GROUP CONTEXTUAL TOOLBAR

BUTTON 
OR MENU

NAME LINK TO MORE INFORMATION

Write

Generate

Preview All The Report Node

Write

Structure

Title Page (available for custom reports) The Title Page

Table of Contents (available for custom reports) The Table of Contents

Section Sections in the Report

Contents

Equation Custom Report Components

Heading Custom Report Components

Image Custom Report Components
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Template Group Contextual Toolbar

The template group contextual toolbar is available after clicking a Template node or its subnodes under Reports in 
the Model Builder. It includes tool for creating report templates. 

View Toolbar

Once physics interfaces are added to the model, the View ribbon toolbar (Windows) and the View contextual toolbar 
(macOS and Linux) contains many of the common features and actions required to work with the features found 
under the Materials node in the Model Builder.

List Custom Report Components

Table Custom Report Components

Text Custom Report Components

Model Contents Model Contents — Report Components

Declaration Contents Declaration Contents

Arrays Arrays and Scalars

Scalars Arrays and Scalars

TABLE 2-18:  THE TEMPLATE GROUP CONTEXTUAL TOOLBAR

BUTTON 
OR MENU

NAME LINK TO MORE INFORMATION

Export

Generate

Export The Template Node

Export All

Structure

Title Page The Title Page

Table of Contents The Table of Contents

Section Sections in the Report

Contents

Model Contents Model Contents — Report Components

For step-by-step instructions and general documentation descriptions, this is the View toolbar.

TABLE 2-17:  THE REPORT GROUP CONTEXTUAL TOOLBAR

BUTTON 
OR MENU

NAME LINK TO MORE INFORMATION
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Developer Toolbar

For creating and running methods, adding method calls and settings forms to the Model Builder, and testing 
applications, the Developer ribbon toolbar is available in the Windows version. Some of the functionality is 
connected to the Application Builder and the creation and testing of applications, but you can also create model 
methods and method calls and run them for custom extensions of a model created in the Model Builder and also 
add custom settings form for custom settings to control the workflow in the Model Builder.

TABLE 2-19:  THE VIEW TOOLBAR

BUTTON 
OR 
MENU

NAME DESCRIPTION OR OPTIONS LINK TO MORE INFORMATION

Reset View

Reset to 
Default

Restore the default settings for the View node. User-Defined Views

Lights (3D only)

Directional 
Light

Add a Directional Light to the View. About the 3D View Light 
Sources and Attributes

Point Light Add a Point Light to the View.

Spotlight Add a Spotlight to the View.

Headlight Add a Headlight to the View.

Hide

Hide Add a selection feature to hide geometry objects or 
entities.

Hide for Geometry, Hide for 
Physics, Hide for Mesh Import

TABLE 2-20:  THE DEVELOPER TOOLBAR

BUTTON 
OR MENU

NAME DESCRIPTION OR OPTIONS LINK TO MORE INFORMATION

Application 

Application Builder 
(Ctrl+Shift+A)

Toggle between the Application Builder and 
Model Builder windows.

Data Access Add data and properties that can be modified 
from a running application.

Data Access in the Application 
Builder Reference Manual.

Test Application 
(Ctrl+F8)

Launch the application in a separate window. Testing the Application in the 
Application Builder Reference 
Manual. 

Create Methods 

New Method Create a new method with code to run in the 
model.

Creating and Running 
Methods in Models. Also see 
Creating Methods in the 
Application Builder Reference 
Manual.

Record Method Record changes to the embedded model to a 
new application method or model method.

Recording Code in the 
Application Builder Reference 
Manual. 
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Keyboard Shortcuts

The following table summarizes the available keyboard shortcuts on Windows and Linux and on macOS (see also 
Keyboard Shortcuts for the Quick Access Toolbar and the Application Builder documentation for specific keyboard 
shortcuts):

Method Calls 

Method Call Add any available model method as a method 
call in the Model Builder.

 Method Calls

Run Methods 

Run Method Run one of the available methods.

Creating and Running 
Methods in Models

Run Method Call Run one of the added method calls.

Stop Stop a running method.

Forms 

Settings Form Add a form as a Settings window in the Model 
Builder.

Creating and Using Settings 
Forms and DialogsUpdate Forms Update forms in the Model Builder

Show Dialog Show the form as a dialog box.

Add-ins 

Add-ins Add an add-in as a Settings window in the Model 
Builder.

Creating Add-insAdd-in Libraries Open the Add-In Libraries window.

Refresh Add-ins Refresh the available add-ins in the Model 
Builder.

Clear Add-ins Clear all imported add-ins in the Model Builder.

Compare 

Compare Compare the current model and application 
with another MPH-file on the file system and 
then open the Comparison Result window.

Comparing Models and 
Applications

SHORTCUT (WINDOWS, 
LINUX)

SHORTCUT (MACOS ACTION

F1 F1 Display help for the selected node or window.

Ctrl+F1 Command+F1 Open the COMSOL Documentation front page in an 
external Help window.

F2 F2 Rename the selected node, file, or folder.

F3 F3 Disable selected nodes.

F4 F4 Enable selected nodes.

TABLE 2-20:  THE DEVELOPER TOOLBAR

BUTTON 
OR MENU

NAME DESCRIPTION OR OPTIONS LINK TO MORE INFORMATION
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F5 F5 Update solution with respect to new definitions 
without re-solving the model. Update reduced model 
data. Also, on Windows, to continue in the Method 
Editor’s debugging tool in the Application Builder.

F6 F6 Build the preceding node in the Geometry branch or 
plot the previous plot for a time-dependent, 
eigenfrequency, or eigenvalue solution. Also, on 
Windows, to step in the Method Editor’s debugging tool 
in the Application Builder,

F7 F7 Build the selected node in the geometry and mesh 
branches, compute the selected study step, compute to 
the selected node in the solver sequence, or plot the 
next plot for a time-dependent, eigenfrequency, or 
eigenvalue solution. Also, on Windows, to step into in 
the Method Editor’s debugging tool in the Application 
Builder.

F8 F8 Build the geometry, build the mesh, compute entire 
solver sequence, update results data, update the plot, 
or run model method in a method call. Also, on 
Windows, to create an executable or an add-in in the 
Application Builder.

F9 On Windows, check syntax for a method in the 
Application Builder.

Del Del Delete selected nodes and selected geometry objects.

Left arrow (Windows); 
Shift + left arrow (Linux)

Left arrow If you are at the top of a branch, pressing this collapses 
this branch in the Model Builder. Continue pressing the 
left arrow key to move upward in the tree to collapse 
all branches.

If within a subbranch, pressing the left arrow key 
repositions you to the beginning of the branch.

Right arrow (Windows); 
Shift + right arrow (Linux)

Right arrow Expand a branch in the Model Builder.

Up arrow Up arrow Move to the node above in the Model Builder. Highlight 
the next entity for a 3D geometry in the Graphics 
window when it has focus.

Down arrow Down arrow Move to the node below in the Model Builder. Highlight 
the previous entity for a 3D geometry in the Graphics 
window when it has focus.

Alt+left arrow Ctrl+left arrow Move to the previously selected node in the Model 
Builder.

Alt+right arrow Ctrl+right arrow Move to the next selected node in the Model Builder.

Ctrl+A Command+A Select all domains, boundaries, edges, or points; select 
all cells in a table or all contents of a table cell.

Ctrl+C Command+C Copy text in fields. Copy images in graphics and plot 
windows.

Ctrl+D Command+D Clear the selection of all domains, boundaries, edges, or 
points in the Model Builder. Clear all selections in form 
editor windows.

Ctrl+Shift+D Command+Shift+D Duplicate the selected node in the Model Builder.

Ctrl+F Command+F Find a search string in a model or application method.

SHORTCUT (WINDOWS, 
LINUX)

SHORTCUT (MACOS ACTION
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Ctrl+G Command+G Group nodes.

Ctrl+Shift+G Command+Shift+G Ungroup nodes.

Ctrl+K Create, use, or rename a shortcut to an Model Builder 
node (for use in the Application Builder).

Ctrl+L Command+L Take a quick image snapshot.

Ctrl+N Command+N Create a new model.

Ctrl+O Command+O Open a model file.

Ctrl+P Command+P Print the contents of the plot window.

Ctrl+S Command+S Save a model file.

Ctrl+V Command+V Paste copied text.

Ctrl+Y Ctrl+Shift+Z Redo the last undone operation.

Ctrl+Z Command+Z Undo the last operation.

Ctrl+1 Create a local variable or correct the type of an existing 
variable in methods.

Ctrl+7 Toggle comments on and off in methods.

Ctrl+up arrow Command+up arrow Move a definitions node, geometry node, physics 
interface or feature node (except default nodes), 
material node, mesh node, study step node, or results 
node up one step.

Ctrl+down arrow Command+down arrow Move a definitions node, geometry node, physics 
interface or feature node (except default nodes), 
material node, mesh node, study step node, or results 
node down one step.

Ctrl+Tab Ctrl+Tab Switch focus to the next window on the desktop.

Ctrl+Shift+Tab Ctrl+Shift+Tab Switch focus to the previous window on the desktop.

Ctrl+Shift+A Switch to the Application Builder window from the 
Model Builder.

Ctrl+Shift+M Switch to the Model Builder window from the 
Application Builder.

Ctrl+F4 Command+W Close the active window in COMSOL Desktop, if it is 
closable.

Ctrl+F8 Test an application.

Ctrl+Alt+left arrow Command+Alt+left arrow Switch focus to the Model Builder window.

Ctrl+Alt+right arrow Command+Alt+right arrow Switch focus to the Settings window.

Ctrl+Alt+up arrow Command+Alt+up arrow Switch focus to the previous section in the Settings 
window.

Ctrl+Alt+down arrow Command+Alt+down arrow Switch focus to the next section in the Settings window.

Shift+F10 or (Windows 
only) Menu key

Ctrl+F10 Open the context menu.

Ctrl+Pause Command+. (Command + 
period)

Stop running a method when test running applications.

Ctrl+Space, Ctrl+/ Ctrl+Space, Ctrl+/ Open list of predefined quantities for insertion in text 
fields and table cells for expressions. Ctrl+/ is an 
alternative primarily intended for users of Asian 
Windows versions.

SHORTCUT (WINDOWS, 
LINUX)

SHORTCUT (MACOS ACTION
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+, - +, - Highlight the next or previous entity for a 3D geometry 
in the Graphics window. Expand or collapse a branch in 
the Model Builder.

R R Toggle between automatic and manual rotation center 
for mouse rotation in 3D.

X, Y, Z X, Y, Z Press to force rotation around the x, y, or z axis, 
respectively, when you move the mouse in 3D.

SHORTCUT (WINDOWS, 
LINUX)

SHORTCUT (MACOS ACTION
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B u i l d i n g  a  C O M S O L  M u l t i p h y s i c s  M o d e l

This chapter explains a range of methods and topics used when building models 
in COMSOL Multiphysics®: From working with the Model Builder and 
fundamental concepts for building a model to the use of units. For examples of how 
to build a complete model and application step by step, see the application libraries 
for COMSOL Multiphysics and the add-on modules.

In this chapter:

• Building Models in the Model Builder

• Modeling Development Tools

• Working with Nodes in the Model Builder

• Modeling Guidelines

• Multiphysics Modeling Workflow

• Specifying Model Equation Settings

• Boundary Conditions

• Computing Accurate Fluxes

• Using Load Cases
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• Numerical Stabilization

• Using Units
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Bu i l d i n g  Mode l s  i n  t h e  Mode l  Bu i l d e r

The power of COMSOL Multiphysics is the ease of working with all the features and functionality required to build 
a model in The Model Builder. The sections About the Sequence of Operations, The Component Node, Branches 
and Subbranches in the Tree Structure, Settings and Properties Windows for Feature Nodes, and Opening Context 
Menus and Adding Nodes further introduce you to key concepts about navigating in the Model Builder, the 
structure of the tree, and how to add features (nodes) as you build your model. 

The physics feature nodes that are added to physics interfaces are flexible and several sections describe the ways to 
identify changes, status updates, and other ways to work with these nodes: The Physics Nodes, Physics Interface 
Default Nodes, Physics Feature Nodes by Space Dimension, Physics Interface Node Context Menu Layout, Physics 
Exclusive and Contributing Node Types, Physics Node Status, Dynamic Nodes in the Model Builder, and Errors 
and Warnings.

The Model Builder

The modeling procedure is controlled through the Model Builder window, which is essentially a model tree with all 
the functionality and operations for building and solving models and displaying the results. These are introduced 
to your modeling procedure by adding a branch, such as the Geometry branch. Branches can have further nodes 
(or subbranches) that relate to their parent node. It is all About the Sequence of Operations. See Figure 3-2 for an 
example.

A node has its own properties and Settings window that are characteristic to it. Branches and subbranches can also 
contain properties and settings. See Branches and Subbranches in the Tree Structure and Settings and Properties 
Windows for Feature Nodes for examples.

The Model Builder has many types of nodes to help you create models and visualize the model structure — for 
example, the Component node is categorized by space dimension, and nodes are dynamic, which helps you identify 
nodes that change status. See Component Nodes by Space Dimension, Physics Interface Default Nodes, and 
Dynamic Nodes in the Model Builder for more information.

Also learn about the context menu available when you right-click a node in the Model Builder (Opening Context 
Menus and Adding Nodes). In the next section (Working with Nodes in the Model Builder), there is also 
information about Going to the Source Node, Copying, Pasting, and Duplicating Nodes, Undoing and Redoing 
Operations, Clearing Sequences and Deleting Sequences or Nodes, and Disabling or Enabling Nodes.

• The Root Settings and Properties Windows

• Creating a New Model

• The COMSOL Desktop

• The Root Settings and Properties Windows

• Creating a New Model

• Basic Navigation

• The COMSOL Desktop
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About the Sequence of Operations

COMSOL Multiphysics operates through sequencing and evaluates most of the branch nodes in the Model Builder 
from the top down as a sequence of operations. By adding nodes to a branch in the Model Builder in a certain order, 
you set up such sequences of operations, which makes it possible to, for example, parameterize a model and rerun 
the simulation. COMSOL Multiphysics then reevaluates each sequence, automatically updating the geometry, 
mesh, physics interfaces and features, and solution. A solver sequence, for example, could define your model with 
one solver and then, using the returned solution, solve it with an alternative solver. 

Some nodes under a physics interface branch can override other nodes higher up in the sequence. How the 
COMSOL Multiphysics software treats those nodes depends on whether they are contributing or exclusive nodes 
(see Physics Exclusive and Contributing Node Types).

The sequence of operations means that the order of the nodes in the tree is important. In the following branches 
of the model tree, the node order makes a difference, and you can move nodes up and down to change the sequence 
of operations for these nodes: Geometry, Material, physics interfaces and features, Mesh, and Solver.

Also, the order can have some importance in the plot groups in the Results branch and also for the Perfectly 
Matched Layer and Infinite Element Domain nodes in the Definitions branch (those nodes are available with some 
of the add-on modules).

The Global Definitions Node

Under the Global Definitions node ( ) you can add functionality that is global and applies to the entire mode. 
Right-click the Global Definitions node to add global parameters, variables and variable utilities, user-defined 
functions, load and constraint groups, global materials, default model inputs, and more. See Global Definitions.

The Component Node

A model component is a fundamental part of the model and contains a geometry with its associated physics 
interface, mesh, and variables and other definitions that are local to that component. The Component node defines 
the namespace for each part of a model that is defined in a model component. A model can have several Component 
nodes. For example, if you are setting up a system model using both a 2D simplification — represented in one 2D 
Component branch — and a full 3D description in another Component, these can both be added to the Model 
Builder to represent different aspects or parts of the model. You can couple variables between different components 
in a model using coupling operators.

For most sequences, you run the sequence by right-clicking the top node of the branch and selecting 
Build All  (geometry) and Build  (mesh), Compute  (studies), or Plot  (plot groups), or by 
pressing F8. These buttons are also on the Settings window and in the respective toolbars.

• Physics Node Status

• Physics Exclusive and Contributing Node Types

• Creating a Geometry for Analysis and Working with Geometry Sequences

• Moving Nodes in the Model Builder

To Add Physics and Add Mesh to the Component, from the Home toolbar, or for any operating system, 
right-click the Component node. See The Add Physics Window, and Creating a Mesh for Analysis for 
more information.
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The Component node icon also indicates the space dimension:.

A D D I N G  A  C O M P O N E N T  T O  A  M O D E L

You can create models with multiple geometries by adding one or more Component nodes to the Model Builder. 
Typically a component is added to the model in the Model Wizard when you select a space dimension.

To add a Component node or nodes:

• Right-click the root node (the topmost node) in the Model Builder and select Add Component (see The Root 
Settings and Properties Windows). 

• In The Model Wizard on the Select Space Dimension page, select 3D, 2D axisymmetric, 2D, 1D axisymmetric, or 1D. 
Continue defining the model as in Creating a New Model.

C O P Y I N G ,  P A S T I N G ,  A N D  I N S E R T I N G  C O M P O N E N T S

You can copy and paste model components within a COMSOL Multiphysics session and also between COMSOL 
Multiphysics sessions, as long as the copied component information remains in the clipboard.

To copy a component with all its subnodes, right-click the Component node and choose Copy (or, for Windows 
users, click Copy on the Quick Access Toolbar). You can then paste it in the same or a new COMSOL Desktop 
session by right-clicking the root node and choosing Paste Multiple Items (or, for Windows users, click Paste Multiple 

Items on the Quick Access Toolbar).

It is also possible to insert components from another COMSOL Multiphysics model. To do so, right-click the top 
node (root node) and choose Insert Components from Model. An Insert Components dialog box appears where you 
can browse or type the path and name of the COMSOL Multiphysics model file from which you want to insert 
components in the Model field. Select one or more of the components in the model from the Components list and 
then click OK to insert them into the current model.

Some aspects when inserting or pasting a component into an existing model:

• Existing components in the open model may conflict with the inserted ones. In such cases, the inserted 
component will be renamed (for example, from comp1 to comp2). Because inserting a component also inserts 
many other nodes (geometry, physics, materials, coordinate systems, and so on), these will also be renamed if 
there are existing ones in the open model.

• Most of the nodes under a component only requires that the other nodes under the same component is inserted 
with them. However, there are some situations when items outside the component must be included. Especially, 
the geometry sequence depends on such items. When inserting or pasting a component, the process 
automatically includes necessary global parameters, global functions, and geometry parts. It will not include 
references to items in other components.

TABLE 3-1:  SPACE DIMENSION ICONS IN THE MODEL BUILDER

ICON SPACE DIMENSION

3D

2D axisymmetric

2D

1D axisymmetric

1D

0D (space-independent models for chemical 
reactions and other ODEs and DAEs)
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• File references are inserted as is, and no attempt is made to check if the file exists. When inserting or pasting a 
component, the process does not include stored files but rely on the original file path to be valid.

• Global parameters, global variables, and global functions in variable expressions (either in other variables or in 
physics settings) will not be inserted or pasted automatically.

• Deformed geometries and their associated meshes are not included in the insertion or paste operation. These 
geometries and meshes are typically the result of computing a solution and contain binary data that is not 
included in the insertion either. They should appear again after re-solving, which you need to do after the 
insertion anyway.

Altogether, these aspects may cause an insert or paste operation to be incomplete to some degree. In some cases, 
the difference is reported in a message dialog box after the insertion process has finished. Click Cancel in this dialog 
box to revert the insertion process.

S W I T C H I N G  T O  A N O T H E R  C O M P O N E N T

In a model with more than one component, you can switch the focus to another component by selecting from the 
list of components in the Home toolbar’s Model section. You can also switch to another component by clicking its 
Component node in the model tree (or any other node inside that component).

T H E  D E F A U L T  N O D E S

Figure 3-1: An example of the Model Builder default nodes for the Electric Currents and Heat Transfer in Solids 
interfaces.

These default nodes are normally added under a Component node:

• Definitions: Contains user-defined variables, selections, views, pairs, functions, probes, nonlocal couplings, and 
coordinate systems, which are defined locally for the model. See Global Definitions, Geometry, Mesh, and 
Materials for information about using these local Definitions ( ) and Global Definitions ( ). Use Global 

Definitions to define Parameters, Variables, Functions, and loads and constraint groups with a global scope — that 
is, groups that are not specific to one Component node.

• Geometry ( ): Contains the sequence of geometric objects and operations (or imported CAD data) that defines 
the model geometry.
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• Materials ( ): Contains the materials and material properties used as sources for material data in the 
component. See Materials for detailed information.

• Physics interfaces ( ): Any added physics interface displays as a node under Component (Solid Mechanics in 
Figure 3-1 for example).

• Multiphysics ( ): When a multiphysics interface is added to the Model Builder, this node contains all the 
relevant multiphysics coupling features for that interface. See Multiphysics Modeling Workflow for more 
information.

• Meshes ( ): Contains the sequences of meshing operations that defines the computational meshes for the 
model. When there is only one mesh in the model, its Mesh node appears directly under the Component node.

The Settings window has the following sections (also see Figure 3-3):

The label appears on the node as the default node name. The default label is Component 1, but you can change it 
in the Label field.

The name is a string used to define a namespace for the model component and identify variables defined in that 
component. The default component name is comp1, comp2, and so on, but you can change it in the Name field. See 
Settings and Properties Windows for Feature Nodes and Displaying Node Names, Tags, and Types in the Model 
Builder for more information.

G E N E R A L

This section contains general settings that you normally do not need to change:

Unit System
The default setting in the Unit system list, Same as global system, is to use the global unit system, which you specify 
in the root node’s Settings window. If you want to use another unit system in a model, select it from this list.

Underneath, you can define the coordinates for the frames in a model if you do not want to keep the default names. 
All frames are always defined. See About Frames for more information about frames.

Spatial frame coordinates
For Spatial frame coordinates, the default names are x, y, and z for 3D as well as planar 1D and 2D geometries. For 
axisymmetric geometries, the default names for the spatial frame coordinates are r,  (phi), and z. If you use the 
geometry to represent something other than space, or if you for some other reason want to use other names for the 
spatial coordinates, you can change the names in the fields for the First, Second, and Third coordinate under Spatial 

frame coordinates.

Material frame coordinates
For Material frame coordinates, the default names are X, Y, and Z for 3D as well as planar 1D and 2D geometries. 
For axisymmetric geometries, the default names for the material frame coordinates are R,  (PHI), and Z. You can 
change the names in the fields for the First, Second, and Third coordinate under Material frame coordinates.

Geometry frame coordinates
For Geometry frame coordinates, the default names are Xg, Yg, and Zg for 3D as well as planar 1D and 2D 
geometries. For axisymmetric geometries, the default names for the geometry frame coordinates are Rg,  (PHIg), 
and Zg. You can change the names in the fields for the First, Second, and Third coordinate under Geometry frame 

coordinates.

Branches and Subbranches in the Tree Structure

ϕ

ϕ

ϕg
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Mesh frame coordinates
For Mesh frame coordinates, the default names are Xm, Ym, and Zm for 3D as well as planar 1D and 2D geometries. 
For axisymmetric geometries, the default names for the mesh frame coordinates are Rm,  (PHIm), and Zm. You 
can change the names in the fields for the First, Second, and Third coordinate under Mesh frame coordinates.

Geometry Shape Order
The setting in the Geometry shape order list determines the order of the curved mesh elements that determine the 
geometry shape. The default setting is Automatic, but it is also possible to select an order such as Linear, Quadratic, 
Cubic, Quartic, Quintic, Sextic, and Septic. The default setting allows for automatic reduction of the order in some 
cases.

By default, the software avoids inverted elements by an optimization of the element shapes. To deactivate that 
functionality, clear the Avoid inverted elements by curving interior domain elements check box. See Avoiding Inverted 
Mesh Elements for more information.

Adding Extra Dimensions to a Model

To add an extra, abstract spatial dimension to a model, right-click the Global Definitions node ( ), and then from 
the Extra Dimensions context menu, choose 3D, 2D Axisymmetric, 2D, 1D Axisymmetric, or 1D to add an extra 
dimension to the selected space dimension (requires that Extra Dimensions is selected in the Show More Options 
dialog box). An Extra Dimension node, in the chosen space dimension, is then added under the Global Definitions 
node in the Model Builder. You can add one or several Extra Dimension nodes. It is also possible to attach an extra 
dimension to several components. Extra dimensions can be useful, for example, to model transport and reactions 
in two different scales, where one scale is the homogenized scale of a set of larger pores between particles or larger 
cracks in rocks, and a second smaller scale is the one inside porous particles or in porous rock.

The added node then contains these default nodes: Definitions, Geometry, and Mesh. The settings for the Extra 

Dimension node are the same as for the Component node, except it has a unique Name.

ϕm

You cannot use the variable for the time, t, as a frame coordinate name.

• Creating a New Model

• The Root Settings and Properties Windows

• Editing Node Properties, Names, and Labels

• About Frames

• Setting the Unit System for Models

• Using Extra Dimensions

• Curved Mesh Elements

The default nodes associated to the Extra Dimension are considered the extra dimension geometry and 
extra dimension mesh. The original geometry and mesh are called the base geometry and base mesh.

Before you can use the extra dimensions in physics interfaces, they must be attached on a selection in 
the base geometry.
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The default node label in the Label field is Extra Dimension 1 for the first Extra Dimension node. The component 
name is a string used to identify variables in the model. The default Extra Dimensions component name is xdim1, 
xdim2, and so on, but you can change it in the Name field.

Branches and Subbranches in the Tree Structure

You can proceed through your modeling in the Model Builder by selecting the branches in the order suggested by 
the default positions, from the top down, or selecting and defining each branch as needed. One level below the 
main Component branch are subbranches as described in Table 3-2 and shown in Figure 3-2. The node appearance 
can also change depending on many factors. See Dynamic Nodes in the Model Builder for examples.

Using Extra Dimensions

TABLE 3-2:  THE MODEL BUILDER BRANCHES AND SUBBRANCHES

FIGURE 
REF.

ICON NAME DESCRIPTION AND LINK TO MORE INFORMATION

Main Branches

1 Global 
Definitions

Define global parameters, and right-click to define global Variables, Functions, 
Load and Constraint Groups, a Materials branch, and optional Geometry Parts. 
Mesh Parts, and Extra Dimension branches, which are globally available in all 
model components. See The Global Definitions Node.

2 Various Component This branch includes the subbranches Definitions, Geometry, Materials, physics 
interfaces, and Mesh. You can also right-click the node to Add Physics and Add 
Mesh at this level. See The Component Node.

3 Study This subbranch is where you set up study steps and solver configurations to 
solve a model using one or more study types for different analyses. See Studies 
and Solvers.

4 Results The features contained in the subbranches for Datasets, Derived Values, Tables, 
Export, and Reports are used to present and analyze results. See Results 
Analysis and Plots.

Subbranches

5 Definitions 
(Local)

This subbranch is used to create Variables, Functions, Selections, Coordinate 
Systems, Nonlocal Couplings, and Probes as well as other definitions that are 
local to a specific component in your model. See Global and Local Definitions.

6 Geometry 
(Local)

This branch contains the definition of the model’s geometry, where you can 
import a geometry or build one yourself using the available tools. See 
Geometry Modeling and CAD Tools.

7 Materials 
(Global)

This branch makes it possible to add materials and a material switch for material 
sweeps at the global level. You can add materials in the same way as you do 
under a Component branch, but materials on the global level are available 
throughout the model and therefore have no Geometric Entity Selection 
section. See Global Materials.

7a Materials 
(Local)

Collect all material properties organized in Material nodes with a defined 
geometric scope. Material properties required by any of the physics interfaces 
and features show up automatically in the defined material’s Settings window. 
See Materials.

8 Various Physics 
interfaces

Each physics interface forms its own branch based on the model definition 
requirements. See The Physics Interfaces and Creating a New Model to start.
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8a Multiphysics This is a main branch but is associated directly with the physics interface 
branches above it. It contains multiphysics coupling nodes. See The 
Multiphysics Branch.

9 Mesh This subbranch collects all meshes defined for a model. If there is only a single 
mesh in a model, its Mesh node appears directly under the corresponding 
Component node. See Meshing.

10 Datasets Datasets refer to the source of data for creating Plots and Reports. It can be a 
Solution, a Mesh, or some transformation or cut plane applied to other 
datasets; that is, you can create new datasets from other datasets. 

Derived 
Values

Used to define evaluations of numerical results — globally, in a point, or 
integrated quantities. For 2D and 3D plots, you can also get numerical results 
directly in a table by clicking the plot. See About Derived Values.

Tables This subbranch displays the results from integral and variable evaluations 
defined in Derived Values nodes or by probes and stored in Table nodes. See 
The Table Window and Tables Node.

Various Plot Groups After adding a 3D, 2D, or 1D Plot Group, plots are added and defined under 
this subbranch. See Plot Groups and Plots.

Export After a model is completed, you can add various components to this and then 
generate outputs (animations, data, images, or export), or export the 
information to your computer as image, movie, or data files for use in external 
documents or for other purposes. See Export Types.

Reports This subbranch opens the Report Generator, which is a tool for reporting and 
documenting models created in COMSOL. It creates a record of the entire 
model including all the settings made during the modeling process. The report is 
an overview of the model and includes model properties, geometry, physics 
interfaces and features, mesh, studies, and results and visualization. See 
Reports. 

TABLE 3-2:  THE MODEL BUILDER BRANCHES AND SUBBRANCHES

FIGURE 
REF.

ICON NAME DESCRIPTION AND LINK TO MORE INFORMATION
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Figure 3-2: An example of the Model Builder tree structure showing the many different types of branches and 
subbranches available in a model. Refer to Table 3-2 to learn more about a node. Use the numbers to locate the node in 
the table.
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Settings and Properties Windows for Feature Nodes

S E T T I N G S  W I N D O W

For all operating systems, and when any node is clicked in the Model Builder (except a few container nodes such 
as Definitions and Datasets), a corresponding Settings window opens with the same name as the node. The Settings 
window contains settings for defining operations and properties specific to a node, as shown in Figure 3-3.

Figure 3-3: An example of a node Settings window. In this example, the Settings window for the Component node opens 
when the node of the same name is clicked. You can also toggle between the Settings and Properties window from the 
context menu.

S E T T I N G S  W I N D O W  F U N C T I O N A L I T Y

When an operation or property is updated in the Settings window, its effect on the model is displayed in the 
Graphics window either instantaneously or by clicking the applicable button, which are available in some of the 
Settings window toolbars. If you update settings for the physics interfaces and features, you must recompute the 
solution to reflect the changes in the physics interface and features.

To select the parts of the model to define in a specific Settings window, select the relevant geometric entities directly 
in the displayed model in the Graphics window, from the Selection List window, or as, for example, All domains in 
the Settings window.

L A B E L S  A N D  N A M E S  I N  T H E  S E T T I N G S  W I N D O W

Every Settings window has the option to change the node Label. The Label is the default node description (it defaults 
to the node Type followed by an index suffix). For example, it might be the Electric Currents interface, or in 
Figure 3-3 it is Component. You can also right-click and choose Rename or press F2.

For most sequences, you can run the sequence by right-clicking the top node of the branch and 
selecting Build All  (geometry) and Build  (mesh), Compute  (studies), or Plot  (plot 
groups), or by pressing F8. These buttons are also on the Settings window and in the respective 
toolbars.



B U I L D I N G  M O D E L S  I N  T H E  M O D E L  B U I L D E R  |  151

Some Settings windows have the option to change the Name. These include physics interfaces, components (as in 
Figure 3-3), multiphysics couplings, and some Definitions features. The Name is used primarily as a scope prefix for 
variables defined by the physics interface. Refer to such physics interface variables in expressions using the pattern 
<name>.<variable_name>. In order to distinguish between variables belonging to different physics interfaces, the 
name string must be unique. Only letters, numbers, and underscores (_) are permitted in the Name field. The first 
character must begin with a lowercase or uppercase letter (a–z or A–Z). All other characters in the Name must be 
a lowercase or uppercase letter, a number between 0 and 9, or an underscore (_). See Variable Naming Convention 
and Namespace for more information.

In most Settings windows, there is also a Create Shortcut button ( ) next to the Label field. Click it (or press 
Ctrl+K) to create a shortcut to that node for use in the Application Builder (see the Application Builder 
documentation for more information). If a shortcut already exists, you can click the Rename Shortcut button ( ) 
(or press Ctrl+K) to rename the shortcut.

P R O P E R T I E S  W I N D O W

Figure 3-4: An example of a node Properties window. In this example, the Properties window for the Component node 
opens when you right-click the node and select Properties from the context menu. You can also toggle between the Settings 
and Properties window from this context menu.

The Properties window ( ) in Figure 3-4 is accessed by right-clicking the node and choosing Properties from the 
context menu. The information listed includes the Label, Name, Tag, and the Node Properties. 

• The Label can be edited on the Settings window. The default or edited name is displayed here but cannot be 
changed in this window.

You can choose to display any combination of the Name, Tag, and Type in the Model Builder. See 
Displaying Node Names, Tags, and Types in the Model Builder. 
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• The Name is available for Component, functions and other nodes under Definitions, Material, and physics 
interface and multiphysics coupling nodes. You can edit the name on the Settings window for Component nodes, 
the main physics interface nodes, and for some functions and other nodes under Definitions, where the names 
servers as an identifier in the namespace for variables or as the function name, for example.

• The Tag is unique for each node and is assigned automatically. Tags are primarily used when running COMSOL 
models in Java or MATLAB. To display the Tag in the Model Builder, click Model Builder Node Text  on the 
toolbar and choose Tag. See Displaying Node Names, Tags, and Types in the Model Builder for more 
information.

• The Node Properties section includes the following information: Created, Author, Version, and Comments (the root 
node is a special case; see The Root Settings and Properties Windows). The Created field is automatically assigned 
by the software. You can edit the Author, Version, and Comments fields in this window. For the Comments field, 
you can add formatting and special characters that will appear in reports. This information can also be included 
when creating Reports. 

Displaying Node Names, Tags, and Types in the Model Builder

S E L E C T I N G  T H E  M O D E L  B U I L D E R  N O D E  C O N T E N T S

The Model Builder always shows the label for the nodes. To add more information, on the Model Builder toolbar 
click Model Builder Node Text . Then select any combination of options from the list: Name, Tag, and Type. See 
Figure 3-5 for examples.

• A Name is only used in the Model Builder for short names (descriptions) of the nodes. The Name can only be 
changed for the top Component, physics interface nodes and multiphysics couplings, and for Definitions nodes. 
Some Settings windows have the option to change the Name. See Settings and Properties Windows for Feature 
Nodes for information about Label versus Name. The Name and Tag for top level features are often the same.

• A Tag is unique for each node and is assigned automatically. Tags are primarily used when running COMSOL 
models in Java or MATLAB. Select Tag to display each node’s feature name with the predefined tag in curly 
braces using an italic font. The Name and Tag can be the same.

• A Type is automatically assigned by the software and cannot be changed. Select Type to display each node’s feature 
type (predefined name). This is the most useful if a node Label is renamed or if you use a local language other 
than English and want to see the predefined name; otherwise, the type and the label are the same (except that 
the label typically includes a number, such as Boundary System 1).

• Toolbars and Keyboard Shortcuts

• About Selecting Geometric Entities

• The Graphics Window

For Definitions features, the Name is displayed differently for Functions, Probes, Nonlocal Couplings, 
and Pairs. See Common Settings for the Definitions Nodes for more information.



B U I L D I N G  M O D E L S  I N  T H E  M O D E L  B U I L D E R  |  153

Figure 3-5: Examples of the available combinations on the Model Builder Node Label menu. The second example of a 
Type shows how this is useful when the Label is edited in the Settings window and you need to know the original type of 
node.

L A B E L S

Node Settings windows have a Label field where you can change the default node description for all levels (except 
the root node, which gets its name from the model filename). The label can also be changed by right-clicking and 
choosing Rename or by pressing F2.

Name

Type

Label edited on the 
Settings window

Tag

The Label can also be displayed in the Model Builder where it is called a Tag. See Settings and Properties 
Windows for Feature Nodes. 

• Editing Node Properties, Names, and Labels

• The Root Settings and Properties Windows
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Opening Context Menus and Adding Nodes

In addition to using the toolbars and menus (see The COMSOL Desktop Menus and Toolbars), you can right-click 
a node to open a context menu. The context menu lists all the functionality available as properties and subnodes 
to a particular node in a branch of the tree. Figure 3-6 shows the context menu for some of the Geometry node 
options. From the menu you can add additional, and relevant, functionality, operations, or attributes to the 
sequence. Often there is a mixture of submenus, keyboard shortcuts, or specific features to choose from as in 
Figure 3-6 and Figure 3-7. There are also standard options such as  Rename,  Properties, and  Help.

The context menu is also further divided and categorized for physics interfaces, as in the section Physics Interface 
Node Context Menu Layout and Figure 3-7.

O P E N I N G  T H E  C O N T E X T  M E N U

• Right-click any node in the Model Builder to open the context menu

• Once a node is highlighted, right-click anywhere in the Model Builder to open it.

• Use the shortcuts based on operating system:

- Windows: Press Shift+F10.

- macOS: Press Ctrl+F10.

- Linux: Press Shift+F10.

After selecting an option from the list, an associated Settings window opens to the right (by default) of the Model 

Builder window. See Figure 3-3 for an example.

To add physics feature nodes to physics interfaces, in general, go to the Physics toolbar, no matter what 
operating system you are using. Subnodes are available by clicking the parent node and selecting it 
from the galleries that open.

The layout of the context menu (especially for physics interfaces) depends on whether the nodes are 
grouped by space dimension. The default is ungrouped nodes. See Grouping Nodes by Space 
Dimension and Type for an example comparing the different context menus. 

In the context menu, a plus sign next to any icon ( ) means a node of that type is added to the 
Model Builder. 
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Figure 3-6: A context menu opens when you right-click any node in the Model Builder. In this example, the options 
available for the Geometry node are shown.

The Physics Nodes

An important part of building a model is where you add physics branches. For example, when Creating a New 
Model. This branch (see Figure 3-2 for an example) contains the nodes that define the material properties, 
equations, loads, initial values, boundary conditions, and other parts of the physics that the model describes. All 
Settings windows for the specification of the physics and equations accept parameters and variables as input data. 

A keyboard shortcut

Submenus to 
additional options

Click to add a specific node 
or open a window.

Standard options on all 
context menus.

• Settings and Properties Windows for Feature Nodes

• Grouping Nodes by Space Dimension and Type

• Clearing Sequences and Deleting Sequences or Nodes

• Disabling or Enabling Nodes

• About Geometric Entities



156 |  C H A P T E R  3 :  B U I L D I N G  A  C O M S O L  M U L T I P H Y S I C S  M O D E L

S P E C I F Y I N G  P H Y S I C S  I N T E R F A C E  S E T T I N G S

Each physics interface includes nodes for specifying all input data for a specific physics in a model:

• Material properties and material models

• Boundary and physics interface conditions

• Equations (for equation-based modeling)

• Initial conditions

In addition, you can specify weak form contributions and element types for additional flexibility.

Specifically, the settings are available on the following parts of the geometry:

• Domains

• Boundaries

• Edges

• Points

• Additional properties that are independent of the geometry

P H Y S I C S  F E A T U R E  N O D E S  B Y  S P A C E  D I M E N S I O N

The physics feature nodes indicate the geometric entity level (domains, boundaries, edges, points, or pairs) based 
on the space dimension of the Component (see Table 3-3). The nodes also correspond to The Graphics Window 
Toolbar Buttons and Navigation, some of which are also based on space dimension. 

Not all of these options are available for all geometry types and physics interfaces.

See Physics Exclusive and Contributing Node Types and Physics Node Status for examples of other 
differences to how the nodes display in the Model Builder.

TABLE 3-3:  PHYSICS FEATURE NODES BY SPACE DIMENSION

NAME 3D 2D AND 2D 
AXISYMMETRIC

1D AND 1D 
AXISYMMETRIC

Domain level 

Domain level, default node

Boundary level

Boundary level, default node

Boundary level, Pairs

Point level —

Edge level — —
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Physics Interface Default Nodes

When you add a physics interface, the software automatically adds a corresponding physics interface branch in the 
tree, which typically includes a number of default nodes, including but not limited to:

• A model equation or material model node, typically on the domain level. This node defines the domain equations 
(except optional sources, loads, reactions, and similar contributing domain quantities) and the related material 
properties or coefficients.

• A boundary condition node. For multiphysics interfaces there is one boundary condition for each participating 
physics.

• For axisymmetric models, the symmetry axis has an Axial Symmetry boundary condition (see Physics Interface 
Axial Symmetry Node).

• An Initial Values node for specifying initial values for a time-dependent simulation or an initial guess for the 
solution to a nonlinear model (see Specifying Initial Values).

In most cases, the default nodes’ initial selections include all domains or all boundaries (or all instances of another 
geometric entity level). Their selection is always every instance that is not overridden by another node on the same 
geometric entity level. It is not possible to delete such default nodes, but you can copy and duplicate all default 
nodes. Some multiphysics interfaces also add default nodes with no initial selection, which are possible to delete 
from the model. Default nodes include a D (for “default”) in the upper-left corner ( ) to indicate their special 
status. The copy or duplicate of a default node is a node of the same type but behaves as a normal node with an 
initially empty selection.

For example, for a geometry with four boundaries, the default boundary condition’s initial selection includes all 
four boundaries. If another exclusive boundary condition for Boundary 3 is added, that boundary becomes 
overridden (inactive) in the default boundary condition’s selection. If you disable or remove that boundary 
condition, the default boundary condition becomes active for Boundary 3 again. You cannot change a default 
node’s selection.

Physics Interface Node Context Menu Layout

The context menu opens when you right-click a physics interface node, or any node in the Model Builder (see 
Opening Context Menus and Adding Nodes). Depending on the space dimension, this menu is divided into these 

• The Physics Interfaces

• Physics Interface Default Nodes

• Physics Interface Node Context Menu Layout

• Physics Node Status

Some physics interfaces also add standard nodes directly when you add them to a model. They 
represent functionality that is likely to be useful but that you might want to make only active on a part 
of the geometry or delete. Such nodes do not include a D in the upper-left corner.

• Physics Feature Nodes by Space Dimension

• Physics Node Status

• Physics Exclusive and Contributing Node Types

• Dynamic Nodes in the Model Builder
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sections for most physics interfaces: the first section contains domain settings, the second boundary settings, the 
third edge settings, and the fourth has point settings.

Figure 3-7: An example of a Heat Transfer in Solids interface context menu. The choices are based on the Component 
dimension (in this example it is 3D) as well as the physics interface. The menu is further divided by geometric entity level 
(domains, boundaries, edges, and points).

As shown in Figure 3-7, the context menu layout is also based on whether the nodes are not grouped (the default) 
or if Group by Space Dimension is selected.

There can be menu items with the same name but applied at different geometric entity levels.

To add physics feature nodes to physics interfaces, in general, go to the Physics toolbar, no matter what 
operating system you are using. Subnodes are available by clicking the parent node and selecting it from 
the gallery that opens.

Domain level settings for 
ungrouped nodes

Boundary level settings for 
ungrouped nodes

Edges and Points submenus

Common options on physics 
interface context menus.

An example of the context help menu 
when the nodes are not grouped by 
space dimension (the default).
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Physics Exclusive and Contributing Node Types

The nodes for the physics interfaces and features are in a sequence, which acts like a macro that the software runs 
in a top-down order. Depending on the selection for each node, a node can totally or partially override, or shadow, 
a node earlier in the sequence. How the software treats these nodes depends on the relationship. There are two 
different types of nodes: exclusive and contributing (see Figure 3-8)..

E X C L U S I V E  N O D E S

The use of an exclusive node means that only one can be active for a given selection. That is, if you add another 
exclusive node (for example, an identical node) with the same selection, the first exclusive node is overridden and 
thus has no effect.

Typical exclusive nodes include model equations, initial values, and boundary conditions that are constraints, such 
as prescribed values for displacements, temperatures, pressures, and so on, or other Dirichlet-type conditions, 
including special variants of these such as ground conditions in electromagnetics and fixed constraints in structural 
mechanics. Also some boundary conditions that are not constraints but have a definitive meaning are exclusive 
nodes — for example, electric insulation, thermal insulation, and no-flow conditions. Depending on the selections 
for each node, an exclusive node can override another node partially. Nodes are exclusive only within their specific 
physics interface. When a node is selected in the Model Builder tree, nodes that are overridden by the selected node 
have a red arrow in the lower-left corner of the icon ( ), and nodes that override the selected node display a red 
arrow in the upper-left corner of the icon ( ).

C O N T R I B U T I N G  N O D E S

A contributing node means you can have more than one of these nodes with the same selection and that the 
software adds these together when evaluating the model. Typical contributing nodes are loads, fluxes, and source 
terms, where you can have more than one of each type that is active on the same domain or boundary, for example. 
The total effect is then a sum of each contributing node. When a node is selected in the Model Builder tree, the 
tree shows other nodes, which the current node contributes with, indicated using a yellow dot to the left of the 
icon (for example, in this boundary level icon ). See also Figure 3-8 for an example.

O R D E R  O F  E X C L U S I V E  A N D  C O N T R I B U T I N G  N O D E S

An exclusive node typically override all other nodes that share some common geometric entity and that appear 
above it in the list of nodes under a physics interface. Conversely, a contributing node can contribute with an 
exclusive node that appears above it. For example, in a heat transfer interface, a Temperature exclusive node 
overrides a Heat Flux contributing node defined above it (when defined on some common boundaries). If you 
switch the order of those nodes, so that the Heat Flux node appears below the Temperature node, it then contributes 
with the Temperature node. Because the Temperature node imposes a constraint on the temperature, the computed 
solutions are identical when evaluating the temperature. However, the contributing heat flux changes the reaction 
force of the temperature condition, which you can verify by integrating the reaction force on a boundary using the 
reacf operator, for example.

The exclusive and contributing nodes maintain the described behavior only in relation to similar types 
of nodes within the same physics interface (for example, you can have a temperature constraint and a 
pressure constraint for the same boundary in the same model component).

What the node looks like in the Model Builder is based on the space dimension. See Physics Feature 
Nodes by Space Dimension.
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L I S T I N G  O V E R R I D E S  A N D  C O N T R I B U T I O N S

If your preferences include showing the Override and Contribution section in the Settings windows for physics nodes, 
you can find the following information about how exclusive and contributing nodes interact in the model. Click 
the Show More Options button ( ) and select the Override and Contribution in the Show More Options dialog box 
to display the information as in Figure 3-8 and described below.

• The Overridden by list contains the names of the nodes that the selected node is overridden by. The selected node 
is then overridden by these nodes at least partially, and the Selection list contains (overridden) for the geometric 
entities (boundaries, for example) where it is overridden. The nodes that the selected node is overridden by are 
indicated using a red arrow in the lower-left corner of the icon such as in this boundary level icon .

• The Overrides list contains the names of the nodes that the selected node overrides (where the current node is 
active). The nodes that the selected node overrides are indicated using a red arrow in the upper-left corner of the 
icon such as in this boundary level icon .

• The Contributes with list contains the names of the nodes that the selected node contributes with for at least some 
shared selection. The nodes that the selected node contributes with are indicated using a yellow dot to the left 
of the icon such as in this boundary level icon .

If a physics node is disabled locally in a study step using the Physics and Variables Selection section in 
the study step’s Settings window, the indications of overrides and contributions in the Model Builder 
are unchanged (but disabled physics nodes get an asterisk to indicate that their state has been changed 
in at least one study step). However, the local variables and physics tree in the study step’s Settings 
window displays the overrides and contributions taking the disabled nodes into account.
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Figure 3-8: The Override and Contribution section lists other physics nodes that the selected node is overridden by, 
overrides, or contributes with.

Physics Node Status

The status of a physics node depends on if it is a default node, the selection that it applies to, and other nodes in 
the same branch that can override nodes earlier in the sequence. You can change the order of nodes (except the 
default nodes) by moving them up or down.

O V E R R I D D E N  S E L E C T I O N S

A node can be partially or completely overridden by another node further down in the same branch of the model 
tree that is of a similar, exclusive type. For example, if you specify a temperature boundary condition on boundary 
1 and boundary 3, and then add another temperature boundary condition for boundary 3, the first temperature 
boundary condition is overridden on boundary 3. In the Settings window for the Temperature nodes that define the 
temperature boundary condition, the Selection list then shows 3 (overridden) to indicate that the temperature 
boundary condition defined on this selection is overridden for boundary 3 but is still active on boundary 1. 
Deleting or disabling the other temperature boundary condition on boundary 3 reactivates the original 
temperature boundary condition, and then shows 3 (without the (overridden) indication).

• Physics Node Status

• Physics and Variables Selection

• Physics Interface Default Nodes
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S E L E C T I O N S  T H A T  A R E  N O T  A P P L I C A B L E

For selections that are not applicable for a node (such as interior boundaries for an boundary condition that is only 
applicable for exterior boundaries), the Selection list then shows (not applicable) next to entries that are, in this case, 
interior boundaries.

E M P T Y  S E L E C T I O N S

For physics nodes that you add to a model (that is, not for default nodes), a warning appears on the physics node 
when the node has no selection. An added source or boundary condition, for example, has no effect on the model, 
so leaving an added physics node with an empty selection might be an unintended state, leading to unexpected 
simulation results.

Figure 3-9: The warning and tooltip for an added physics node with an empty selection.

The warning for an empty selection does not appear in the following cases:

• For completely overridden selections.

• When no applicable entities are available.

• When selections are set to all entities, but the geometry has no entities on the given entity level (for example, no 
geometry or domain selection on a surface geometry).

E N A B L I N G  A N D  D I S A B L I N G  N O D E S

By enabling or disabling physics nodes, you can activate and deactivate (shadow) other physics interface nodes that 
appear higher up in the physics interface branches.

Dynamic Nodes in the Model Builder

The Model Builder is a dynamic environment. As your model is built and analyzed, there are numerous ways to 
quickly identify nodes that change status during the process. Table 3-4 lists generic examples and links to the 
dynamic visual aids that are used to help you.

• Physics Interface Default Nodes

• Physics Exclusive and Contributing Node Types

• Physics Feature Nodes by Space Dimension 

• Clearing Sequences and Deleting Sequences or Nodes

• Disabling or Enabling Nodes

• Branches and Subbranches in the Tree Structure

• The Component Node
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TABLE 3-4:  DYNAMIC NODES — VISUAL AIDS TO IDENTIFICATION

ICON TYPE NODE EXAMPLE AND LINK TO MORE INFORMATION (WHERE APPLICABLE)

Error For example, on a Material node . See Errors Relating to the Material Nodes.

Error node Errors and Warnings

Current node, not 
built (yellow frame)

For example, on a Geometry node ( ). This node is also displaying the asterisk 
indicating the node is being Edited. The asterisk also appears on plot nodes when the 
plot has not been updated to reflect changes in the data or settings (for example, after 
re-solving), See The Current Node in Geometry Sequences.

Current node (green 
frame)

A current node is used for Geometry and Meshing nodes and indicates that the feature 
or sequence of steps has been built. It is a green line on the left and upper edges of the 
node. For example, on a Geometry node , after building. Also see The Current 
Node in Geometry Sequences.

Enabled sequence During solution processing, the particular sequence that is enabled and runs when 
selecting Compute has a green border around its icon ( ). See Computing a 
Solution.

Harmonic 
Perturbation

For example, on a boundary level node for the Electric Currents interface, Electric 
Ground node . See Harmonic Perturbation, Prestressed Analysis, and 
Small-Signal Analysis.

Warning For example, on a Mesh node .

Editing, or in process 
of editing, a node

For example, on a Mesh node . This node is also displaying the asterisk indicating 
the node is being Edited. Also indicates physics interface nodes that have been disabled 
in a Study Step. See Editing and Building Geometry Nodes for Geometry nodes for 
example.

Pairs For example, on a 3D Boundary Level node . See Identity and Contact Pairs.

Pairs — Fallback 
Features

For example, on a 3D Boundary Level pair node . See Identity and Contact Pairs.

Contributing node For example, on a 3D boundary level node . See Physics Exclusive and 
Contributing Node Types and Physics Node Status.

Default node For example, on a 2D boundary level node . See Physics Interface Default Nodes.

Override For example, on a 3D boundary level node . See Physics Exclusive and 
Contributing Node Types.

Overridden For example, on a 3D boundary level node . See Physics Exclusive and 
Contributing Node Types

STUDY STEPS ANALYSIS

Solve For For example, a Laminar Flow interface  where the green dot in the lower-right 
corner indicates that the study solves for the degrees of freedom in this physics 
interface. See Physics and Variables Selection.

Disable in Solvers For example, a Laminar Flow interface  is enabled (not dimmed), shows that the 
study step provides degrees of freedom (the yellow dot in the lower-right corner), and 
has a change of state indicated by the asterisk. The yellow dot means that the study step 
provides degrees of freedom but does not solve for the physics interface. See Physics 
and Variables Selection. 

Change of State 
(editing)

An asterisk appears in the upper-right corner of nodes for which you change their state 
in the study step’s selection tree compared to their state in the main model tree in the 
Model Builder. For example, for the Joule Heating interface .
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Physics Symbols

There are physics symbols available with structural mechanics and some other physics features to help you to 
graphically indicate boundary conditions, loads, and other physics features:

• Physics Symbols for Structural Mechanics and Other Physics

• About Coordinate Systems and Physics Symbols

• Displaying Physics Symbols in the Graphics Window — An Example

P H Y S I C S  S Y M B O L S  F O R  S T R U C T U R A L  M E C H A N I C S  A N D  O T H E R  P H Y S I C S

To display the physics symbols listed in Table 3-5, select the Enable physics symbols check box under Physics Symbols 
in the main physics interface node’s Settings window. This check box is not selected by default.

Once you have turned on the physics symbols for a certain physics interface, you can fine-tune the display. Every 
feature that has associated physics symbols now has a Show physics symbols check box, by which you can control the 
display of the symbols for that specific feature.

In the Physics Symbols section in the settings for the physics interface, you can click the Select All button, which 
displays all symbols in that physics interface by selecting all Show physics symbols check boxes in the Settings 
windows for the physics features that include symbols. Similarly, the Clear All button clears all Show physics symbols 
check boxes in the individual physics features.

The following symbols are available with the applicable structural mechanics feature nodes and with some other 
physics interfaces (this table is a partial list of available symbols). 

Disabled in Model 
(provides no degrees 
of freedom) and 
shows a change of 
state

In this example, a Transport in Diluted Species interface  is disabled (unavailable), 
provides no degrees of freedom (red dot in the lower-right corner), and has a change of 
state indicated by the asterisk. See Physics and Variables Selection.

LOAD AND CONSTRAINT GROUPS

Load Group This is an example of a Boundary Load node with a load group . This is for a 2D 
model at the boundary level. See Load Group and Using Load Cases.

Constraint Group This is an example of a Fixed Constraint node with a constraint group . This is for a 
2D model at the boundary level. See Constraint Group and Using Load Cases. 

TABLE 3-4:  DYNAMIC NODES — VISUAL AIDS TO IDENTIFICATION

ICON TYPE NODE EXAMPLE AND LINK TO MORE INFORMATION (WHERE APPLICABLE)

• Solid Mechanics and Using Load Cases

• The Graphics Window

TABLE 3-5:  PHYSICS SYMBOLS

SYMBOL SYMBOL NAME DISPLAYED BY NODE NOTES

Added Mass1 Added Mass

Antisymmetry1 Antisymmetry

Body Load1 Body Load

3D Coordinate System Green indicates the Y direction, blue indicates the 
Z direction, and red indicates the X direction.
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A B O U T  C O O R D I N A T E  S Y S T E M S  A N D  P H Y S I C S  S Y M B O L S

Physics symbols connected to a node for which input can be given in different coordinate systems are shown 
together with a coordinate system symbol. This symbol is either a triad or a single arrow. The triad is shown if data 
are to be entered using vector components, as for a force. The single arrow is displayed when a scalar value, having 
an implied direction, is given. An example of the latter case is a pressure.

In both cases, the coordinate directions describe the direction in which a positive value acts. The coordinate 
direction symbols do not change with the values actually entered for the data.

2D Coordinate System Green indicates the Y direction and red indicates 
the X direction.

Distributed Force Boundary Load

Face Load

Edge Load

Can be displayed together with the Distributed 
Moment symbol, depending on the values given in 
the node.

Damping1 Spring Foundation Can be displayed together with the Spring symbol, 
depending on the values given in the node.

Distributed Moment1 Boundary Load

Face Load

Edge Load

Can be displayed together with the Distributed 
Force symbol, depending on the values given in the 
node.

Fixed Constraint Fixed Constraint

No Rotation1 No Rotation

Pinned1 Pinned

Point Force Point Load Can be displayed together with the Point Moment 
symbol, depending on the values given in the node.

Point Mass1 Point Mass

Point Moment1 Point Load Can be displayed together with the Point Force 
symbol, depending on the values given in the node.

Prescribed 
Displacement

Prescribed Displacement

Prescribed Velocity1 Prescribed Velocity

Prescribed 
Acceleration1

Prescribed Acceleration

Rigid Connector1 Rigid Connector A line is drawn to each connected boundary,

Roller Roller 

Spring1 Spring Foundation

Thin Elastic Layer

Can be displayed together with the Damping 
symbol, depending on the values given in the node.

Symmetry Symmetry

Thin-Film Damping2 Thin-Film Damping

1 Requires the Structural Mechanics Module
2 Requires the MEMS Module

TABLE 3-5:  PHYSICS SYMBOLS

SYMBOL SYMBOL NAME DISPLAYED BY NODE NOTES
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Physics symbols are in most cases displayed even if no data values have been entered in the node.

In some cases, a single feature can display more than one symbol. An example is the Point Load node in the Beam 
interface, which can display either the Point Force symbol ( ), the Point Moment symbol ( ), or both, 
depending on the data entered. In those cases, no symbol is shown until nonzero data is entered.

D I S P L A Y I N G  P H Y S I C S  S Y M B O L S  I N  T H E  G R A P H I C S  W I N D O W  —  A N  E X A M P L E

1 Add a physics interface, for example, Solid Mechanics, from the Structural Mechanics branch.

2 In the Solid Mechanics node’s Settings window, under Physics Symbols, select the Enable physics symbols check 
box and then click the Select All button.

3 Add any of the feature nodes listed in Table 3-5 to the physics interface. Availability is based on license and 
physics interface.

For cases when physics symbol display is dependent on values given in the node, it can be necessary to 
move to another node before the display is updated on the screen.

The physics symbols also display for any multiphysics interface that includes Structural Mechanics 
feature nodes or other physics feature nodes with symbols.
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4 When adding the boundary, edge, or point (a geometric entity) to the Selection list in the feature Settings window, 
the symbol displays in the Graphics window. See Figure 3-10 and Figure 3-11.

Figure 3-10: Example of Boundary Load physics symbols as displayed in the COMSOL Multiphysics model 
“Deformation of a Feeder Clamp”. 

Figure 3-11: Example of Roller and Boundary Load physics symbols as displayed in the COMSOL Multiphysics model 
“Tapered Cantilever”.

Errors and Warnings

COMSOL Multiphysics reports problems of two types: errors and warnings.

E R R O R S

Errors prevent the program from completing a task. For errors, a COMSOL Error window appears with a brief error 
description and, in some cases, an Open Log File button for additional information. Under the node where the error 
occurred there is, in most cases, also an Error subnode ( ) that contains an error message that generally provides 
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additional information. Also, for many error types, the icon for the node where the error occurred appears with a 
red cross in the lower-right corner. For some errors there is also a link to more diagnostic information on the 
COMSOL website.

L I C E N S E  E R R O R S

It is possible to open and postprocess models that include functionality that you have blocked or that your license 
does not include. Nodes with functionality that requires a license for a product that is blocked or not available get 
a License Error subnode ( ), where you find information about the missing but required product license. Unless 
you disable or remove such nodes, it is not possible to re-solve such models.

W A R N I N G S

Warnings are problems that do not prevent the completion of a task but that might affect the accuracy or other 
aspects of the model. Warnings typically appear in the Log window ( ). The warning message also appears as a 
Warning subnode ( ) under the node from which the warning was sent.

I N D I C A T I O N  O F  U N E X P E C T E D ,  U N K N O W N ,  O R  I N C O N S I S T E N T  U N I T S

The unit display appears orange for the properties in the settings for the physics interface, physics features, and 
materials that have invalid or inconsistent units or a different unit than expected.

Inconsistent Units
An inconsistent unit can occur by summing terms with units that represent different physical quantities, such as 
273[K]+3[ft]. A tooltip displays a message at the corresponding field.

Unexpected Unit of Input
In the case of a valid but unexpected unit, this message contains the deduced and expected units in the current unit 
system.

Unknown Unit
This message appears when a unit bracket contains invalid units.

Syntax Errors
A unit display that appears red contains a syntax error, which can be due to, for example, missing or misplaced 
parentheses.

Evaluating Unexpected or Inconsistent Units
If an unexpected or inconsistent unit appears in a text field for a physical property, the COMSOL Multiphysics 
software ignores the unit and uses the numerical value, including an SI prefix if present, as the input to the model. 
For example, in a text field for density using SI units, the software interprets 2930[K] as 2930 kg/m3 and 
2930[mK] as 2.930 kg/m3.

E R R O R S  A N D  W A R N I N G S  I N  A  G E O M E T R Y  S E Q U E N C E

If an error occurs when you build a node, the build stops. The node with the problem then gets an Error 

subnode ( ) that contains the error message. Also, the node’s icon displays with a red cross in the lower-left 
corner.

Some specialized plot types require a license for an add-on product and are then also unavailable if you 
postprocess models that include such plots and your license does not include the required product.

It is not possible to open models that require a license for the Material Library, ECAD Import Module, 
CAD Import Module, LiveLink™ for MATLAB®, or any of the CAD LiveLink™ products if your license 
does not include this required product.
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After a successful build of a node, a warning message can sometimes display as a Warning subnode ( ). If a 
warning message exists, the node’s icon displays with an orange triangle in the lower-right corner.

E R R O R S  A N D  W A R N I N G S  I N  M E S H I N G  S E Q U E N C E S

If a problem occurs when you build a node, the build continues if it is possible; otherwise, the build stops. 
Continuing means that geometric entities where the operation failed are skipped and the problems are reported as 
Error subnodes ( ) under the operation node. The build process continues with remaining nodes in the meshing 
sequence.

When the building of the meshing sequence is completed, the error window appears to show the first error 
reported. If there are several errors, you have to inspect the sequence for nodes with a Warning status and 
corresponding Error nodes to find all errors. If a node has a Warning status, the node’s icon includes an orange 
triangle in the lower-right corner (see Dynamic Nodes in the Model Builder).

In some cases, you get a Warning node ( ) even though meshing completed successfully. This happens, for 
example, when geometric entities are much smaller that the desired mesh element size, and you should interpreted 
the warning as a hint that the geometry needs to be simplified to avoid an unnecessarily fine mesh.

If meshing cannot continue, all building stops and the node gets an Error status, which the program indicates by 
adding a red cross in the lower-right corner of the node’s icon. You find information about the error in an Error 
subnode ( ) of the node where the error occurred. If the node is part of a sequence build, the build stops and 
the preceding node becomes the current node.

E R R O R S  A N D  W A R N I N G S  I N  S O L V E R  S E Q U E N C E S

Issues encountered when running a solver or generating a mesh are treated in two different ways depending on if 
it is possible to avoid the problem and continue the operation or if the operation must be stopped. In the first case, 
a Warnings node ( ) appears under the node in the model tree that caused the problem. In the second case, an 
Error node ( ) appears under the node in the model tree that caused the error.

A Warnings node ( ) can also appear under a Compile Equations node if some input to the solvers uses inconsistent 
units, for example.

W A R N I N G S  D U R I N G  P O S T P R O C E S S I N G

For things like empty plots, Warnings nodes ( ) can appear in the Results branch during postprocessing. However, 
you do not get any warnings in these cases:

• Plotting with the Dataset list set to None or a dataset that cannot be evaluated (for example, because the model 
does not contain any solution).

• Plotting without having set any expressions.

The Error and Warning nodes and their subnodes often contain selections that highlight where the 
problem is located in the geometry.

If you still have problems, contact technical support from the Support Center page at 
www.comsol.com/support.

• Using Units

• Unit Systems

• Dynamic Nodes in the Model Builder
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Mode l i n g  De v e l o pmen t  T oo l s

Overview

In addition to the available functionality in COMSOL Multiphysics and the add-on products included in your 
license, you can add custom functionality by defining methods and settings forms and by combining them into 
add-ins for general use in any model. There are also built-in tools for comparing the contents of two models. All 
this functionality is available from the Developer toolbar (see Developer Toolbar). There is also an Add-in Libraries 
window for adding existing add-ins to a model. See the following sections for more information:

• Creating and Running Methods in Models

• Method Calls

• Creating and Using Settings Forms and Dialogs

• Creating Add-ins

• The Add-in Libraries Window

• Comparing Models and Applications

Creating and Running Methods in Models

You can use the method editor capabilities in the Application Builder to create methods that you can run to 
automate or extend operations in the Model Builder tree such as creating a geometry or running some special solver 
sequence. To add a method, go to the Developer ribbon and click New Method ( ) in the Create Methods section. 
In the New Method window, specify a method name in the Name field and click OK. The Application Builder then 
opens, and the new model method appears under Methods ( ) in the Application Builder tree. You can then record 
or write code for the method in the model editor window. See the Application Builder documentation for more 
information about methods. By default, the Show in Model Builder check box is selected in the settings for the Method 
node. All methods with that check box selected appear under Run Method in the Model Builder.

To run a method in the Model Builder, click Run Method ( ) in the Run Methods section and choose the method 
to run. The Model Builder tree is updated according to the changes that the method includes. Click Stop ( ) to 
stop a running method to debug it, for example. You can open the Debug Log window from the Windows menu to 
view debug information. You can also add breakpoints for debugging purposes. You can also click Run Method Call 
( ) to run a method call in a Method Call node (see Method Calls below). Method calls support input arguments 
for the model methods, so that you, for example, can use two instances of the same model method with different 
input values. Model methods with inputs are not available for Run Method. For methods without inputs, running a 
method directly or through a method call is equivalent.

Make sure that the model tree is in a state that is compatible with the method that you run. Otherwise, 
the method code may not work or may produce unexpected results. Also, there is no undo operation 
after running a model method.

See the Introduction to Application Builder for an example of a model method and the Application 
Builder Reference Manual for information about the Model Method node and about creating and 
debugging methods in general.
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Method Calls

You can add any available model method as a Method Call node ( ), which appears under Global Definitions. If the 
Group by Type option is enabled, the Method Call nodes are grouped under the Method Calls node ( ). In the 
Settings window, the model method that this Method Call node calls is listed as, for example, Model method: 

modelmethod1.

At the top of the Settings window, click the Run button ( ) or press F8 to run the model method for this method 
call. Click the Stop button ( ) to stop a running model method (this button is unavailable if a model method is 
not running). 

Click the Edit Method button ( ) to open the model method in a method editor window in the Application 
Builder, where you can make changes and additions to the model method.

You can also right-click the Method Call node and choose Run  (or press F8) or Edit Method .

The Method Call node’s Settings window includes the following section:

I N P U T S

In this section, any inputs that you have defined for the model method appear, using the input’s description as the 
label and a text field for entering a value for the input (the text field contains a default value if it has been defined 
for that input). If the input is a Boolean, it appears as a check box instead. If the input is a 2D array, Array 1D 
Boolean, or Array 1D String, it is shown as a table, where you can add values and add rows and columns as 
applicable. Contrary to running model methods directly, method calls can use model methods with inputs defined 
in the Settings window for model methods in the Application Builder. That way you can, for example, use multiple 
instances of a model method with different input values.

Creating and Using Settings Forms and Dialogs

Forms that you create in the Application Builder can also be used as settings forms in the Model Builder tree that 
can provide customs settings connected to methods for performing some special task in a model. Such forms 
become available in the Model Builder if you select the Show in Model Builder check box. You can add them as nodes 
in the Forms section of the Developer toolbar by choosing them from the Settings Form list ( ). That form is then 
added as a Settings Form node under Global Definitions (or Global Definitions>Settings Forms, if Group by Type is 
active).

You can also show such forms as modal dialog boxes by choosing them from the Show Dialog list (  in the Forms 
section of the Developer toolbar.

To make use of the latest definition of a form in the Application Builder when it is shown in the Model Builder, 
click the Update Forms button ( ) in the Forms section of the Developer toolbar, which updates all settings forms’ 
features. You can also click the Update button ( ) in the in the Settings window for a Settings Form node to update 
that particular settings form.

Forms that include Graphics objects cannot be used as settings form or dialog boxes. Instead you can 
plot in the main Graphics window or in other plots windows using the built-in selectNode method or 
the window property for a plot group.
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Click the Edit Form button ( ) the in the in the Settings window for a Settings Form node to move to its form 
editor window in the Application Builder.

Figure 3-12: An added settings form under Global Definitions provides custom settings.

Creating Add-ins

Add-ins, or add-in programs, are extensions to the COMSOL Multiphysics software and make it possible to share 
methods and settings forms between several models. An add-in consists of a regular COMSOL Multiphysics 
MPH-file in which you have added forms and methods using the Application Builder to provide a settings window 
with some functionality that can simplify or extend the built-in functionality in the COMSOL Multiphysics software 
for some application that might be useful for a range of model files. You can collect add-ins into a user-defined 
add-in library (see The Add-in Libraries Window below). Opening the add-ins that are included in the COMSOL 
Multiphysics as MPH-files from the file system makes it possible to study the forms and methods in the Application 
Builder. See the Application Builder documentation for more information about how to create an add-in in the 
Application Builder and general information about forms and methods.

Using Add-ins

To use an add-in in the current model, choose it from the Add-ins list ( ) on the Developer ribbon toolbar. The 
add-in will then be added to the current model under Global Definitions. To add an add-in to the Add-ins list, select 
it in the Add-in Libraries window (see below). Once the add-in is available under Global Definitions, it works like any 
other node with a Settings window. Depending on its contents, it will affect the model by some functionality 
contained in the add-in.

The Add-in Libraries Window

The Add-in Libraries window contains available add-ins, which you can browse and add to the Model Builder by 
selecting the check box for the add-in and then click Done. This way, you enable the add-in so that it becomes 
available from the Add-ins menu. When you choose the add-in from that menu, it is imported and the selected form 
is added or a selected method is run. You can also make add-ins available by importing them without adding any 

See the Application Builder documentation for more information about creating forms and methods.
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form or running any methods. To do so, right-click an add-in and choose  Import Add-in. Imported add-ins are 
also available from the Add-ins menu. If the add-in includes documentation, click the  Open PDF Document 
button underneath the add-in description, or right-click the add-in and choose Open PDF Document.

Click the Refresh button ( ) to update the list of add-ins. You can also add separate user-defined add-in libraries 
(see below).

A D D - I N  L I B R A R Y  P R E F E R E N C E S

The following settings can be modified using the buttons at the bottom of the Add-in Libraries tree on the Add-in 

Libraries page in The Preferences Dialog Box and — if the Allow managing libraries in the Add-in Libraries window 
check box on that page is selected (the default) — also in the Add-in Libraries window itself.

Add User Add-in Library
Click the Add User Add-in Library button ( ) to add customized folders. In the Add User Add-in Library dialog box, 
navigate to a location on your computer and select an existing directory or click Make New Folder to create a custom 
folder. Click OK to save the changes and exit, or Cancel to exit without saving. The user-defined add-in library 
appears alongside the built-in add-in libraries,

Optionally, you can replace the standard folder icon ( ) with custom icons of your choice that reflect the content 
of your library folders. To use a custom icon for a folder, create a PNG-file with an image size of 16-by-16 pixels 
and save it in the folder under the name folder.png.

Set the COMSOL Add-in Libraries Root
Click the Set COMSOL Add-in Libraries Root Directory button ( ) to edit or set the root folder. This redirects the 
COMSOL software to a different folder where customized add-ins can be stored.

In the Set COMSOL Add-in Libraries Root Directory dialog box, navigate to the new root folder location or click Make 

New Folder. Click OK to save the changes and exit, or Cancel to exit without saving.

Remove Selected Library
This button is enabled after a user add-in library folder has been created. Select a user add-in library root folder in 
the Add-in libraries tree and then the click the Remove Selected ( ) button to remove the library from the tree.

Comparing Models and Applications

It can be useful to compare two versions of the same model or application to get an overview of the differences 
between the two versions. To do so, click the Compare button ( ) in the Compare section of the Developer toolbar. 
A Select Application window then opens, where you can select the Model MPH-file (the remote file) to which you 
want to compare the current model in the COMSOL Desktop (the local file). A comparison then starts, and the 
results, if there are any differences, appear as a tree in the Comparison Result window. The comparison tool compares 
all the settings in the entire model, including visible and invisible settings in the Model Builder and the Application 
Builder.

T H E  C O M P A R I S O N  R E S U L T  W I N D O W

At the top of the Comparison Result window there is a toolbar with the following buttons:

• New Comparison ( ), to make a new comparison. A New Comparison dialog box opens, where the default is that 
the Use open file check box is selected. Clear it to specify another Local file. Specify a Remote file and then click 
OK to perform a new comparison.

It is not possible to add an add-in library identical to, containing, or being contained in, an already 
used add-in library.
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• Update ( ), to update the comparison

• Collapse All ( ) and Expand All ( ), to collapse or expand all branches in the comparison tree

• Load Comparison from File ( ), to load the results from another comparison from an XML-file.

• Save Comparison to File ( ), to save the results from the current comparison to an XML-file.

• Show Next Difference ( ), to move to the next difference in the tree with nodes that differ under Differences.

• Show Previous Difference ( ), to move to the previous difference in the tree with nodes that differ under 
Differences.

Under Comparing files, you find the file paths to the local model and the remote model. The local model is typically 
the model open in the COMSOL Desktop, and it can have been modified after the last save. The left column is 
called Local file (Open application) when the local model is the opened model or application. When the local model 
is a new model that has not yet been saved, the left column is called Open application.

Under Differences, you can use the Filter results list to control filtering with the options No filter, Exclude all matching 

labels (the default), and Include all matching labels. The entries in the Regular expression field define what node labels 
to filter. You can make the filtering case sensitive by selecting the Case Sensitive button ( ) box next to the list. 
The filter matching is done with regular expressions, and any label that contains a matching text will be either 
included or excluded. Filtering can be disabled by choosing No filter from the Filter results list. Click the Show Only 

Active button ( ) next to the list to exclude inactive settings from the comparison. Such settings are not actively 
used in the current model state and do not typically appear in the COMSOL Desktop.

The tree of nodes with differences has a structure according the structure of the underlying model object, not the 
Model Builder or Application Builder trees. This means that the hierarchy can be somewhat different compared to 
the hierarchy seen in the Model Builder and Application Builder windows. The comparison includes all nonbinary 
differences in the model object that can be saved to disk, with some exceptions. For nodes that correspond to a 
node in the Model Builder or Application Builder trees, double-click the node (or right-click and choose Go to 

Source) in the tree of nodes with differences to display the corresponding node in one of those trees in the local file. 
When applicable, you can also right-click a node and choose Go to Remote Source to display the corresponding node 
in one of those trees in the remote file.

Below is a list of consequences of this design:

• The tree can show differences not visible in the Model Builder because they come from inactive settings hidden 
by another setting.

• Some settings and nodes in the Model Builder are not saved in the model object and will therefore not show in 
a comparison (Mesh Statistics, for example).

• No binary data are compared, so, for example, no differences in the solution will trigger a difference in the 
comparison.

Selecting a node in the tree will update the table under Comparing values below the tree. This table shows the 
attributes of the selected node, both in the local model (Local value column) and the remote model (Remote value 
column). This table is particularly interesting for the nodes labeled Attributes differ because they show the values 
that differ. Parent nodes can also show the same differences but typically with a larger number of attributes that 
have the same local and remote values. For differences that contain long entries or large arrays, there is an option 
to show a more detailed difference in a separate window for a selected table. Either double-click the table row or 
click the Detailed Comparison of Selected Attribute button ( ) below the table to open the Compare Attribute 

window.
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Work i n g  w i t h  Node s  i n  t h e  Mode l  Bu i l d e r

This section describes how you can move, copy, paste, duplicate, disable and enable nodes in the model tree that 
describes the contents of a model in the Model Builder window. There is also information about undoing and 
redoing operations in the model tree.

Moving Nodes in the Model Builder

Many of the nodes under the branches and subbranches listed in Table 3-2 can be moved around in the model tree. 
To move nodes use one of these methods:

• Select one node at a time (or by Ctrl-clicking or Shift-clicking to select more than one node at a time), and use 
the mouse to drop them in another applicable position in the model tree. A horizontal line indicates where in 
the model tree the moved (or copied) nodes get inserted when releasing the mouse.

• Right-click the selected nodes and select Move Up ( ) or Move Down ( ). Nodes that are the first or last of 
its kind can only be moved down or up, respectively.

• Use the keyboard shortcuts Ctrl+up arrow or Ctrl+down arrow to move nodes up or down.

• You can also create custom grouping of nodes to organize the nodes in the model tree. See Custom Grouping 
of Nodes.

The order of the nodes in some of the branches affects the evaluation of the sequence that they define. In the 
following branches and subbranches it is possible to move nodes up and down to control the evaluation of the 
sequence or the order in which they appear within the branch or subbranch (also see Table 3-2): 

• Definitions: nodes can be moved relative to other nodes of the same type (functions, selections, and so on).

• Geometry: The Geometry Nodes.

• Materials: Material nodes.

• Mesh: Mesh nodes (see Meshing).

• Physics interfaces: except for the default nodes, the nodes for physics interfaces (such as material models, 
boundary conditions, domains, edges, points, and sources) can be moved within the physics interface branches 
(see The Physics Interfaces). 

• Study: Study and study step nodes can be moved (see Study and Study Step Types).

• Results: the order of the nodes can be rearranged within each of the subbranches (Derived Values, Tables, Plot 
Groups, Export, and Reports). Exceptions under the Export node are the Plot, Mesh, and Table nodes (see 
Results Analysis and Plots).

Copying, Pasting, and Duplicating Nodes

It is possible to copy and paste many of the nodes in the Model Builder to create additional nodes with identical 
settings or to paste it into another model. That is, you can paste the node into a model in a new COMSOL Desktop 

For physics interface nodes it is not possible to move the default nodes (for the default boundary 
condition, for example). It is possible to create a copy of a default node, which initially has no selection. 
To click-and-drag a default node creates a copy whether or not the Ctrl key is pressed.
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session. Some nodes can also be duplicated underneath the original node. You can also move, copy, and duplicate 
nodes using “drag-and-drop” of nodes in the Model Builder.

Nodes that can be copied (and duplicated) include the following:

• Functions, which are possible to copy from one Definitions or Global Definitions branch to another. Also see 
Functions and Global Definitions, Geometry, Mesh, and Materials.

• Variable utilities. Also see Matrices and Matrix Operations.

• Moving Mesh and Deformed Geometry nodes. See also Deformed Geometry and Moving Mesh.

• Material nodes. Also see Materials.

• Nodes for lighting and hiding in the View branch. Also see User-Defined Views.

• Physics and multiphysics feature nodes, which can be copied within the same physics interface or to another 
identical physics interface. You can also copy an entire physics interface to another model, for example. Also see 
The Physics Interfaces.

• Geometry sequences, for which there are two ways to copy and paste geometry objects. Using the 
Transforms>Copy operation (that keeps the nodes linked to one another), or a standard copy and paste (see 
Copying and Pasting Geometry Objects). It is also possible to copy, paste, and duplicate nodes corresponding 
to operation features, such as the Union node.

• Study steps, which are possible to copy from one Study branch to another. Also see Studies and Solvers.

• Derived value nodes. Also see Derived Values, Evaluation Groups, and Tables.

• Export nodes. Also see Exporting Data and Images.

• Plot nodes, which are possible to copy from one plot group to another, and their attributes (subnodes). Also see 
Plot Groups and Plots.

H O W  T O  C O P Y ,  P A S T E ,  O R  D U P L I C A T E  N O D E S

• On the Quick Access Toolbar (Windows users) or from the main Edit menu (macOS and Linux users), click 
Copy ( ), Paste ( ), or Duplicate ( ).

• Right-click a node and select Copy, Paste, or Duplicate.

• To paste a node, and after selecting Copy, click the parent node and right-click to select Paste Heat Flux to paste 
a copied node (a Heat Flux node in this case) to the parent node’s branch.

 Duplicate ( ) is a convenient way to copy and paste in one step. In other words, it combines the Copy 
and Paste functions. When nodes are duplicated, the COMSOL Multiphysics software adds identical 
nodes underneath the original nodes on the same branch. You can duplicate most but not all nodes.

The copied object must be pasted into a model component with the same space dimension. For 
example, a Sphere can only be pasted into a 3D model.
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• Create a copy of a node by Ctrl-clicking it and dragging a copy to an applicable location. A small plus sign at the 
cursor indicates that you drag a copy of the selected node.

• Ctrl-click and drag a duplicate to an applicable location. A small plus sign at the cursor indicates that you drag 
duplicates of the selected nodes.

Undoing and Redoing Operations

It is possible to undo the last operation for operations like adding, disabling, moving, and deleting nodes in the 
Model Builder as well as changing values in the Settings window. You can undo or redo several successive operations.

To undo the last operation or redo an undone operation:

• On the Quick Access Toolbar (Windows users) or from the main Edit menu (macOS and Linux users), select or 
click Undo ( ) or Redo ( ).

• Press Ctrl+Z (undo) or Ctrl+Y (redo).

Going to the Source Node

In the Settings window for many nodes, other nodes can be referenced in the model tree such as a component, 
solution, study or study step, or dataset, which provide data to the node where they are referenced.

Nodes where you refer to other nodes include plot groups, datasets, and solvers; in such nodes’ Settings windows, 
click the Go to Source button ( ) to move to the node that the selection in the list next to the button refers to.

Some nodes, typically default nodes in some physics interfaces, are so-called singleton nodes; that is, 
there can only be one such node in one and the same physics interface, and it may in some cases be 
created automatically. Such nodes, such as the Gravity node in fluid-flow interfaces when the license 
includes the CFD Module or Heat Transfer Module, when copied, are not possible to paste into the 
model.

Undo is not possible for nodes that are built directly, such as geometry objects, solutions, meshes, and 
plots.

• Copying, Pasting, and Duplicating Nodes

• Clearing Sequences and Deleting Sequences or Nodes

• Disabling or Enabling Nodes

• Settings and Properties Windows for Feature Nodes

• Studies and Solvers

• Results Analysis and Plots
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Clearing Sequences and Deleting Sequences or Nodes

You can change the contents, and actions, of the sequences in the model tree by clearing a meshing sequence or 
solution under a solver configuration, or delete nodes in the Model Builder.

C L E A R  O R  D E L E T E  A  M E S H

Use a Clear function to keep the nodes and be able to recreate the mesh by rebuilding the meshing sequence.

Under the Component node where you want to clear or delete the mesh:

• In the Mesh toolbar, click Clear Mesh ( ) or right-click the Mesh node and select Clear Mesh ( ).

• To delete a meshing sequence, in the Mesh toolbar click Delete Sequence ( ) or right-click the Mesh node and 
select Delete Sequence ( ).

• If you have a model geometry with several meshes, you can clear all meshes at the same time. From the Mesh 
toolbar, click Clear All Meshes ( ).

C L E A R  O R  D E L E T E  A  S O L U T I O N

Use a Clear function to keep the nodes and be able to recreate the solution by computing the solution again.

• To clear a set of solutions under a specific study, from the Study toolbar, click Clear Solutions ( ) or right-click 
the Study node and select Clear Solutions ( ).

• To delete all solver nodes, right-click the Solver Configurations node and select Delete Configurations ( ). You 
can also choose whether or not to remove the Results nodes (datasets and plots, for example) associated with the 
solver configuration.

• If you have a model geometry with several studies, you can clear all solutions in all studies at the same time. From 
the Study toolbar, click Clear All Solutions ( ).

D E L E T E  N O D E S

• To delete selected nodes, right-click the nodes and select Delete ( ) or press Del (the Delete key). Confirm the 
deletion of nodes for it to take effect. Also see Clear or Delete a Mesh.

• To delete a geometry sequence, in the Geometry toolbar click Delete Sequence ( ) or right-click the Geometry 
node and select Delete Sequence ( ). You cannot use the Undo command.

• To delete geometry objects or entities, in the Geometry toolbar click Delete ( ) or right-click Geometry and 
select Delete ( ). Or select objects in the Graphics window, and click the Delete button ( ) in the Graphics 
window toolbar.

If you use the Delete button to delete objects, the software deletes the selected objects that correspond to primitive 
features by deleting their nodes from the geometry sequence. If you delete objects that do not correspond to 
primitive features or if you delete geometric entities, a Delete Entities node appears in the sequence.

Disabling or Enabling Nodes

A disabled node does not take part in the evaluation of a sequence; see Figure 3-6. Some nodes, such as container 
nodes and default nodes in the physics interfaces (see Physics Interface Default Nodes), cannot be disabled (or 
deleted). When this is the case, the context menu does not have these options available. You can use Shift-click and 
Ctrl-click to select multiple nodes that you want to delete, disable, or enable.

Undo is not possible for nodes that are built directly, such as geometry objects, meshes, solutions, and 
plots.
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• To disable selected nodes, right-click and select Disable ( ) or press F3. The nodes are unavailable (dimmed) 
in the model tree to indicate that they are disabled. For a geometry or meshing sequence, disabled nodes do not 
affect the finalized geometry or mesh.

• To enable disabled nodes, right-click and select Enable ( ) or press F4.

Instead of disabling and enabling variables and physics nodes to simulate different analysis cases (using 
different boundary conditions or sources, for example), use the selection of variables and physics 
interfaces in the study steps’ Physics and Variables Selection sections, or use load cases for solving cases 
with varying loads or constraints. See Physics and Variables Selection and Using Load Cases.
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Mode l i n g  Gu i d e l i n e s

To model large-scale problems and for successful modeling in general, the COMSOL Multiphysics software makes 
it possible to tune solver settings and to use symmetries and other model simplifications to reach a solution or — 
failing that — interrupt the solution process to retrieve a partial solution. This section provides some tips and 
guidelines when modeling.

Selecting Physics Interfaces

When creating a model in COMSOL Multiphysics, you can select a single physics interface that describes one type 
of physics or select several physics interfaces for multiphysics modeling and coupled-field analyses.

M O D E L I N G  U S I N G  A  S I N G L E  P H Y S I C S  I N T E R F A C E

Most physics interfaces contain Stationary, Eigenvalue, and Time Dependent (dynamic) study types. As already 
mentioned, these physics interfaces provide features and windows where you can create models using material 
properties, boundary conditions, sources, initial conditions, and so on. Each physics interface comes with a 
template that automatically supplies the appropriate underlying equations.

If you cannot find a physics interface that matches a given problem, try one of the interfaces for PDEs, which makes 
it possible to define a custom model in general mathematical terms using equation-based modeling. Indeed, the 
COMSOL Multiphysics software can model virtually any scientific phenomena or engineering problems that 
originate from the laws of science.

M U L T I P H Y S I C S  M O D E L I N G  U S I N G  M U L T I P L E  P H Y S I C S  I N T E R F A C E S

When modeling real-world systems, you often need to include the interaction between different kinds of physics: 
multiphysics. For instance, an electric current produces heat, and the properties of an electronic component such 
as an inductor vary with temperature. To solve such a problem, combine two or several physics interfaces into a 
single model using the program’s multiphysics capabilities. For the example just mentioned, you can use the 
predefined Joule Heating multiphysics coupling, which is a combination of the Electric Currents and Heat Transfer 
interfaces. This way you create a system of two PDEs with two dependent variables: V for the electric potential and 
T for the temperature. There are many other predefined multiphysics couplings that combine two or more coupled 
physics interfaces for common multiphysics applications. If you have added physics interfaces for which predefined 
multiphysics couplings exist, they are available in the Add Multiphysics window (see The Add Multiphysics Window).

You can also combine physics interfaces and equation-based modeling for maximum flexibility.

To summarize the proposed strategy for modeling processes that involve several types of physics: Look for physics 
interfaces suitable for the phenomena of interest. If you find them among the available physics interfaces, use them; 
if not, add one or more interfaces for equation-based modeling.

When coupling multiple physics interfaces in a multiphysics model (without using a predefined multiphysics 
interface), the couplings can occur in domains and on boundaries. The COMSOL Multiphysics software recognizes 
some common multiphysics couplings, which then appear under the Multiphysics node. The program also 
automatically identifies potential model inputs for quickly forming couplings between physics interfaces. For 
example, a velocity field from fluid flow is a model input for convective heat transport in heat transfer. In that case, 
the model input automatically transfers the velocity field from the fluid to the heat transfer part.

Multiphysics Modeling Workflow
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Using Symmetries

By using symmetries in a model you can reduce its size by half or more, making this an efficient tool for solving 
large problems. This applies to the cases where the geometries and modeling assumptions include symmetries.

The most important types of symmetries are axial symmetry, symmetry planes or lines, and antisymmetry planes or 
lines:

• Axial symmetry is common for cylindrical and similar 3D geometries. If the geometry is axisymmetric, there are 
variations in the radial (r) and vertical (z) direction only and not in the angular (θ) direction. You can then solve 
a 2D problem in the rz-plane instead of the full 3D model, which can save considerable memory and 
computation time. Many physics interfaces are available in axisymmetric versions and take the axial symmetry 
into account. During postprocessing, you can revolve the 2D axisymmetric solution to view the results in 3D.

• Symmetry and antisymmetry planes or lines are common in both 2D and 3D models. Symmetry means that a 
model is identical on either side of a dividing line or plane. For a scalar field, the normal flux is zero across the 
symmetry line. In structural mechanics, the symmetry conditions are different. Antisymmetry means that the 
loading of a model is oppositely balanced on either side of a dividing line or plane. For a scalar field, the 
dependent variable is 0 along the antisymmetry plane or line. Structural mechanics applications have other 
antisymmetry conditions. Many physics interfaces have symmetry conditions directly available as nodes that you 
can add to the model tree.

To take advantage of symmetry planes and symmetry lines, all of the geometry, material properties, and boundary 
conditions must be symmetric, and any loads or sources must be symmetric or antisymmetric. You can then build 
a model of the symmetric portion, which can be half, a quarter, or an eighth of the full geometry, and apply the 
appropriate symmetry (or antisymmetry) boundary conditions.

Effective Memory Management

Especially in 3D modeling, extensive memory usage requires some extra precautions. First, check that you have 
selected an iterative linear system solver. Normally you do not need to worry about which solver to use because the 
physics interface makes an appropriate default choice. In some situations, it might be necessary to make changes to 
the solver settings and the model. For details about solvers, see the Studies and Solvers chapter.

E S T I M A T I N G  T H E  M E M O R Y  U S E  F O R  A  M O D E L

Out-of-memory messages can occur when the COMSOL Multiphysics software tries to allocate an array that does 
not fit sequentially in memory. It is common that the amount of available memory seems large enough for an array, 
but there might not be a contiguous block of that size due to memory fragmentation.

In estimating how much memory it takes to solve a specific model, the following factors are the most important:

• The number of node points

• The number of dependent and independent variables

• The element order

• The sparsity pattern of the system matrices. The sparsity pattern, in turn, depends on the shape of the geometry 
and the mesh but also on the couplings between variables in a model. For example, an extended ellipsoid gives 
sparser matrices than a sphere.

The MUMPS and PARDISO out-of-core solvers can make use of available disk space to solve large models that do 
not fit in the available memory.

You can monitor the memory use in the lower-right corner of the COMSOL Desktop, where the program displays 
the amount of physical memory and total virtual memory used (see Information About Memory Use).
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C R E A T I N G  A  M E M O R Y - E F F I C I E N T  G E O M E T R Y

A first step when dealing with large models is to try to reduce the model geometry as much as possible. Often you 
can find symmetry planes and reduce the model to half, a quarter, or even an eighth of the original size. Memory 
usage does not scale linearly but rather polynomially (Cnk, k > 1), which means that the model needs less than half 
the memory if you find a symmetry plane and cut the geometry size by half. Other ways to create a more 
memory-efficient geometry include:

• Avoiding small geometry objects where not needed and using Bézier curves instead of polygon chains.

• Using linear elements if possible (this is the default setting in some physics interfaces). See Selecting an Element 
Type.

• Making sure that the mesh elements are of a high quality. Mesh quality is important for iterative linear system 
solvers. Convergence is faster and more robust if the element quality is high.

• Avoiding geometries with sharp, narrow corners. Mesh elements get thin when they approach sharp corners, 
leading to poor element quality in the adjacent regions. Sharp corners are also unphysical and can lead to very 
large (even infinite, in theory) stress concentrations.

I N F O R M A T I O N  A B O U T  M E M O R Y  U S E

In the lower-right corner of the COMSOL Desktop is information about how much memory the COMSOL 
Multiphysics software is currently using. The two numbers in Figure 3-13 displayed as 1.24 GB | 1.26 GB represent 
the physical memory and the virtual memory, respectively. If you position the cursor above these numbers, the 
tooltip includes the numbers with the type of memory explicitly stated:

• The Physical memory number is the subset of the virtual address space used by COMSOL Multiphysics that is 
physically resident; that is, it is the amount of physical memory (RAM) in “active” use.

• The Virtual memory number is the current size of the virtual address space that the COMSOL Multiphysics 
software uses. 

Figure 3-13: An example of memory use displayed in the COMSOL Desktop.

Selecting an Element Type

As the default element type for most physics interfaces and features, the COMSOL Multiphysics software uses 
first-order or second-order Lagrange elements (shape functions). Second-order elements and other higher-order 
elements add additional degrees of freedom on midpoint and interior nodes in the mesh elements. These added 
degrees of freedom typically provide a more accurate solution but also require more memory due to the reduced 
sparsity of the discretized system and the added number of degrees of freedom (DOFs). For many application areas, 
such as stress analysis in solid mechanics, the increased accuracy of a second-order element is important because 
quantities such as stresses involve space derivatives and become constant within an element when using first-order 
elements.
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COMSOL recommends that you use the default element types. For some applications, it might be possible to use 
a lower-order element than the default element type, but you must then use care to ensure that the important 
quantities are resolved.

Analyzing Model Convergence and Accuracy

It is important that the numerical model accurately captures local variations in the solution such as stress 
concentrations. In some cases you can compare your results to values from handbooks, measurements, or other 
sources of data. Many Applications Libraries examples are benchmark models that include comparisons to 
established results or analytical solutions.

If a model has not been verified by other means, a convergence test is useful for determining if the mesh density is 
sufficient. Here you refine the mesh and run the study again, and then check if the solution is converging to a stable 
value as the mesh is refined. If the solution changes when you refine the mesh, the solution is mesh dependent, so 
the model requires a finer mesh. You can use adaptive mesh refinement, which adds mesh elements based on an 
error criterion, to resolve those areas where the error is large. See the “Stresses and Strains in a Wrench” model in 
the Introduction to COMSOL Multiphysics book for an example of a convergence test.

For convergence, it is important to avoid singularities in the geometry.

Achieving Convergence When Solving Nonlinear Equations

Nonlinear problems are often difficult to solve. In many cases, no unique solution exists. The COMSOL 
Multiphysics software uses a Newton-type iterative method to solve nonlinear systems of PDEs. This solution 
method can be sensitive to the initial estimate of the solution. If the initial conditions are too far from the desired 
solution, convergence might be impossible, even though it might be simple from a different starting value.

You can do several things to improve the chances for finding the relevant solutions to difficult nonlinear problems:

• Provide the best possible initial values.

• Solve sequentially and iterate between single-physics equations; finish by solving the fully coupled multiphysics 
problem when you have obtained better starting guesses.

• Ensure that the boundary conditions are consistent with the initial solution and that neighboring boundaries 
have compatible conditions that do not create singularities.

• Refine the mesh in regions of steep gradients.

• For convection-type problems, introduce artificial diffusion to improve the numerical properties. Most physics 
interfaces for modeling of fluid flow and chemical species transport provide artificial diffusion as part of the 
default settings.

• Scaling can be an issue when one solution component is zero. In those cases, automatic scaling might not work.

• Turn a stationary nonlinear PDE into a time-dependent problem. Making the problem time-dependent generally 
results in smoother convergence. By making sure to solve the time-dependent problem for a time span long 
enough for the solution to reach a steady state, you solve the original stationary problem.

For information about editing shape functions, see Equation View.

Avoiding Singularities and Degeneracies in the Geometry
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• Use the parametric solver and vary a material property or a PDE coefficient starting from a value that makes the 
equations less nonlinear to the value at which you want to compute the solution. This way you solve a series of 
increasingly difficult nonlinear problems. The solution of a slightly nonlinear problem that is easy to solve serves 
as the initial value for a more difficult nonlinear problem.

• The residual operator can provide insight into the location and development of the algebraic residual in models 
with convergence issues.

Avoiding Strong Transients

If you start solving a time-dependent problem with initial conditions that are inconsistent, or if you use boundary 
conditions or sources that switch instantaneously at a certain time, you induce strong transient signals in a system. 
The time-stepping algorithm then takes very small steps to resolve the transient, and the solution time might be 
very long, or the solution process might even stop. Stationary problems can run into mesh-resolution issues such 
as overshooting and undershooting of the solution due to infinite flux problems.

Unless you want to know the details of the transients, start with initial conditions that lead to a consistent solution 
to a stationary problem. Only then turn on the boundary values, sources, or driving fluxes over a time interval that 
is realistic for your model.

In most cases, turn on your sources using a smoothed step over a finite time. What you might think of as a step 
function is, in real-life physics, often a little bit smoothed because of inertia. The step or switch does not happen 
instantaneously. Electrical switches take milliseconds, and solid-state switches take microseconds.

Physics-Related Checks and Guidelines

There are some important checks and guidelines that primarily apply to different areas of physics. Making these 
checks ensures that the model input is sufficient and increases the chances for successful modeling. See also the 
modeling sections of the documentation for the physics interfaces and the modules for more information related 
to modeling different physics.

F L U I D  F L O W  A N D  T R A N S P O R T  P H E N O M E N A

The following checks and guidelines primarily apply to fluid-flow modeling but also to modeling of other transport 
phenomena:

• If none of the boundary conditions include the pressure (most outlet conditions do, however), then you should 
specify the pressure at some point in the fluid domain. Without a specified pressure, the problem is 
underconstrained and it is difficult to get convergence.

• Make sure that the mesh if sufficiently fine, so that it contains at least 4–6 mesh elements across the thickness of 
a channel, for example.

• Make sure that the boundary conditions and the initial conditions match for time-dependent problems. For 
example, instead of starting with a full velocity on the wall, compared to a zero initial velocity field in the fluid, 

• Stabilization Techniques

• Convergence Plots

• Introduction to Solvers and Studies

• Introduction to Solvers and Studies

• Stationary and Time Dependent
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ramp up the velocity with a smoothed step function or a ramp function that takes the inlet velocity from zero, 
which matches the initial value for the velocity field, to the full velocity. See Avoiding Strong Transients.

• For fluid-flow models it is important to estimate the flow regime (laminar or turbulent) using the Reynolds 
number, for example. If the flow is in the turbulent regime, a turbulence model is typically required.

A C O U S T I C ,  S T R U C T U R A L ,  A N D  E L E C T R O M A G N E T I C  W A V E  P R O P A G A T I O N

For models that describe wave propagation, it is important to fully resolve the wave in both time and space. In 
practice that means using a maximum mesh element size that provides about 10 linear or five second-order elements 
per wavelength and also, for transient simulations, a fixed time step that is small enough.

S T R U C T U R A L  M E C H A N I C S

The following checks and guidelines primarily apply to modeling of structural mechanics:

• Make sure that the model is fully constrained. At a minimum, you typically need to constrain the model to avoid 
all rigid-body movement, which for a 3D solid mechanics model means 6 constraints for three translations and 
three rotations. Otherwise, the solution is not well defined and does not converge.

The structural mechanics interfaces include a Rigid Motion Suppression feature, which eliminates all rigid-body 
movement. If you do not use that feature, it is not possible to add all 6 constraints in a single point, where you 
can constrain at most three translational degrees of freedom. For a 3D solid model you can use a “3–2–1 
approach” to constrain 3 degrees of freedom at one point (a fixed constraint), 2 at another point, and 1 at a third 
point. To do so, select three convenient points (vertices) that are well separated. Then fix the first point in all 
three directions. Constrain the second point in the two directions orthogonal (normal) to the vector from point 
one to point two making sure that there is no restriction to deformation along the line from point one to point 
two. Finally, constrain the third point in a direction normal to the plane formed by the three points. To test this 
approach, the model should expand or contract under temperature loading and have small stresses throughout 
with no stress concentrations. The corresponding minimum constraints for a 2D model are a fixed constraint at 
one point for the 2 translational degrees of freedom and an additional constraint in one direction at another point 
to constrain the single rotational degree of freedom.

• Consider if you can assume that the material is linear elastic and that the deformations are small. If not, consider 
using a nonlinear material model.

• Avoid sharp corners in the geometry, which are unphysical and lead to unbounded stress concentrations.

Results With Unphysical Values

W H E R E  A N D  W H Y  D O  U N P H Y S I C A L  V A L U E S  A P P E A R ?

In some models small unphysical values can occur due to numerical artifacts or other model-related reasons. 
Examples include:

• Negative concentrations in mass transfer.

• A temperature that is slightly higher than the initial condition in time-dependent heat transfer studies.

• Small reaction forces that appear in unloaded directions in structural mechanics models.

• Small negative gaps in a contact analysis.

• Small negative effective plastic strain values.

• Stresses above the yield limit for an ideally plastic material in solid mechanics.
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Some reasons for why these unphysical values occur:

• Numerical noise is a common cause. When the values of the dependent variables approach zero, the numerical 
noise can become relatively significant and cause some of the results to be slightly negative even if that is not 
physically possible.

• Interpolation and extrapolation of values can cause some values to become unphysical. Take care when using 
interpolated data or a piecewise polynomial function to define a temperature-dependent material property, for 
example. If you allow extrapolation outside of the defined range of input values, the material property values may 
not be valid. Also, results for an elastoplastic material are correct (within some tolerance) at the integration points 
(Gauss points) inside the finite elements, but values might become unphysical when extrapolating the data to the 
element boundaries.

• Discontinuities in the model is another source of, for example, small negative concentrations due to a 
discontinuous initial value. With an initial value that is zero along a boundary for convective transport models, 
for example, the physical interpretation is an initially sharp, gradually diffusing front moving away from the 
boundary. However, for the default shape function (second-order Lagrange elements), only continuous 
functions are admissible as solutions. COMSOL then modifies the discontinuous initial value before the time 
stepping can begin. This often results in a small dip in the solution at the start time. In the example model that 
the following figure shows, the concentration is locally slightly negative at t = 0:

• Lack of mesh resolution is another cause of unphysical values such as negative concentrations. The resulting 
convergence problems are often the underlying issue when negative concentrations are observed in high 
convection regimes (high Peclet number) and in those with large reaction terms or fast kinetics (high Damkohler 
number).

• Incorrect physics in the model can also cause these types of problems. For mass transfer, for example, the use of 
a constant sink in a reaction term is an approximation that only works for large concentrations. When the 
concentration reaches zero, the reaction term continues to consume the species, finally resulting in a negative 
concentration.

The Plasticity feature is available as a subnode to a Linear Elastic Material with the Nonlinear 
Structural Materials Module.
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A V O I D I N G  U N P H Y S I C A L  V A L U E S

This section contains some ways to avoid computing or displaying unphysical values:

• In some cases it is possible to add a baseline to the dependent variable so that the numerical noise does not affect 
the solution in the same way as when the values of the dependent variable approach zero. This scaling is not 
possible with, for example, a reaction term that depends on the concentration because then the scale and origin 
do matter.

• Avoid discontinuities in the model using, for example, smoothed step functions.

• Formulate logarithmic variables as a way of eliminating mesh resolution problems and negative dips using the 
logarithm of the original dependent variable (the concentration, for example) as the dependent variable. The 
reason for this is that a linearly varying mesh sometimes does not capture the exponential behavior of the changes 
in the dependent variable. Modeling the logarithm of the dependent variable also ensures that the real 
concentration, for example, cannot become negative during the solution process.

• Avoid displaying small unphysical values due to numerical noise by clipping the values for the plot. You can do 
this by plotting, for example, c*(c>0) instead of c, which evaluates to 0 everywhere where c is smaller than 0. 
You can also adjust the range of the plot data and colors to only show nonnegative values. Parts of the plots where 
values are outside the range then become empty.

• It can also be useful to check how the mesh affects the solution by refining the mesh and checking if the problem 
with unphysical values gets better or worse. If it gets better, then continue to refine the mesh. If it gets worse, 
you probably need to check the physics of the model.
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Mu l t i p h y s i c s  Mode l i n g  Wo rk f l ow

The ability to create multiphysics models — those with more than one type of physics or equation such as 
coupled-field problems — is one of the most powerful capabilities of COMSOL Multiphysics. In such models, the 
software can solve all the equations, taken from various areas of physics, as one fully coupled system.

Within the COMSOL software you can choose from several ways to work with multiphysics modeling and 
coupled-field analysis, including predefined multiphysics interfaces, predefined multiphysics couplings, and setting 
up user-defined multiphysics couplings using model inputs or expressions that include dependent variables or other 
expressions from another physics interface.

In this section:

• Creating a Multiphysics Model

• Advantages of Using the Predefined Multiphysics Interfaces

• The Add Multiphysics Window

• The Multiphysics Branch

• Uncoupling a Multiphysics Coupling

• Model Inputs and Multiphysics Couplings

Creating a Multiphysics Model

There are two ways to create and use the available predefined multiphysics couplings: using Predefined Multiphysics 
Interfaces or Adding Predefined Multiphysics Couplings to Physics Interfaces using The Add Multiphysics Window 
or in The Multiphysics Branch. You can also create multiphysics couplings, in the physics interface settings, using 
a model input or by directly typing an expression using a dependent variable from another physics interface, for 
example (see Specifying Equation Coefficients and Material Properties for information about what you can include 
in such expressions).

P R E D E F I N E D  M U L T I P H Y S I C S  I N T E R F A C E S

The Joule Heating Interface is an example of a predefined multiphysics interface. Many other multiphysics 
interfaces are available depending on the products included in your COMSOL license. After Joule Heating is selected 
from The Model Wizard, the Heat Transfer in Solids interface, the Electric Currents interface, and a Multiphysics node, 
including the default feature applicable to the multiphysics coupling (Electromagnetic Heating), are displayed under 
the Added physics interfaces list as in Figure 3-14. Figure 3-15 shows you what is included in the Model Builder 
when a predefined multiphysics interface is added. Compare to Figure 3-16 where individual physics interfaces are 
added, and these features are initially accessible only from the context menu. There can also be moving mesh nodes 
added as part of a multiphysics interface; they then appear under Definitions in the Added physics interfaces list.

Figure 3-14: When Joule Heating is selected in the Model Wizard, the default physics interfaces and coupling feature 
are displayed under Added physics interfaces.

You can add physics interfaces when you start creating the model with The Model Wizard or at any 
time with The Add Physics Window.
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Figure 3-15: An example of what is added to the Model Builder when Joule Heating is selected in the Model Wizard. 
The Electromagnetic Heating feature is automatically included under the Multiphysics node.

A D D I N G  P R E D E F I N E D  M U L T I P H Y S I C S  C O U P L I N G S  T O  P H Y S I C S  I N T E R F A C E S

An empty Multiphysics node is added automatically when two (or more) physics interfaces are set up in a model and 
when there is the possibility to couple the physics interfaces. In other words, if you add physics interfaces one at a 
time, and the software identifies these physics interfaces as being of the multiphysics category, the Multiphysics node 
is automatically added to the Model Builder. The relevant predefined multiphysics coupling features are then 
available from the context menu (right-click the Multiphysics node) as well as from the Physics toolbar, in the 
Multiphysics menu. See Figure 3-16. You can also add predefined multiphysics couplings from the Add Multiphysics 
window (see The Add Multiphysics Window), which then adds all necessary multiphysics coupling nodes under the 
Multiphysics node. Using a workflow where you add physics interfaces and multiphysics couplings manually makes 
it possible to analyze and validate one physics at the time before solving the full multiphysics model.

Figure 3-16: An example of when a Multiphysics node is automatically added to the model. The specific multiphysics 
features are made available from the context menu (left) or (partially shown here) Physics toolbar, Multiphysics menu 
(right) based on the physics interfaces in the model. The difference when the predefined Joule Heating interface is added 
is that these features are included under Multiphysics and there are some modified settings automatically applied. In 
either case, the available features depend on the COMSOL products that the license includes.
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Advantages of Using the Predefined Multiphysics Interfaces

One advantage of using the predefined multiphysics interfaces is that specific or modified settings are included with 
the physics interfaces and the multiphysics coupling features. If physics interfaces are added one at a time, followed 
by the predefined multiphysics coupling features, these modified settings are not automatically included.

For example, if you add single Electric Currents and Heat Transfer in Solids interfaces to the Model Builder, the 
COMSOL Multiphysics software adds an empty Multiphysics node. The applicable multiphysics couplings are then 
available as subnodes that you can add. If you instead choose the predefined Joule Heating multiphysics coupling, 
for example, which then adds the Electromagnetic Heating node under the Multiphysics node, so that you do not 
need to remember which multiphysics coupling nodes to add for a specific type of multiphysics. See The Add 
Multiphysics Window.

In general, it is useful to use any type of multiphysics coupling because you can turn multiphysics on and off (that 
is, enable and disable features), giving you more flexibility to test and observe multiphysics effects.

Even if you do not start with a predefined coupling, another benefit of this approach is that you are no longer 
constrained by the use of specific physics interfaces, nor do these have to be added in any specific order. The order 
in which physics interfaces are added does not matter for the end result.

An example of this is if you start modeling by adding a Heat Transfer in Solids interface. As you continue to build 
the model, you add an Electric Currents interface. At this stage of the process, you may have defined several 
boundary conditions, chosen materials, or experimented with other settings. You may have also solved the model 
successfully at this point and now you want to continue building on this design. The COMSOL Multiphysics 
software recognizes this and adds a Multiphysics node, which you can right-click to access and add any of the 
available predefined multiphysics couplings.

For multiphysics interfaces that consist of participating physics interfaces, the default solver settings use a segregated 
solver approach with one segregated step for each physics interface and each of these steps calling an iterative solver. 
These solver settings are suitable for large models, but if possible, a fully-coupled solver approach using direct 
solvers can be more robust. You can switch to such solver settings by right-clicking the Study node and choosing 
Show Default Solver. Then the solver nodes that the predefined multiphysics interface specifies appear under the 
Solver Configuration node, and you can right-click the solver node to add a Fully Coupled solver node to replace the 
Segregated node, for example.

The Add Multiphysics Window

The Model Wizard and the Add Physics window contain predefined multiphysics interfaces, which typically add two 
or more physics interfaces and some predefined multiphysics coupling features that define the multiphysics 
couplings between those physics interfaces. When building a model, it can sometimes be useful to start with a single 
physics before adding other physics and the multiphysics couplings that connect them. To add any applicable 
predefined multiphysics coupling in a model, open the Add Multiphysics window ( ) by right-clicking a Component 
node or from the Physics ribbon toolbar. The predefined couped multiphysics couplings that the selected physics 
interfaces support then appear in the tree. Choose the wanted multiphysics couplings and add them to the 
component under Multiphysics by pressing Enter, clicking the Add to Component button ( ), or right-clicking a 
multiphysics coupling and choosing Add to Component. The required multiphysics coupling nodes are then added 

For some multiphysics interfaces, a side effect of adding physics interfaces one at a time is that two 
study types — Frequency-Stationary and Frequency-Transient — are not available for selection until 
after at least one coupling feature is added. In this case, it is better to first add an Empty Study, then 
add the coupling features to the Multiphysics node, and lastly, right-click the Study node to add the 
study steps as needed.
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to the model, and the participating physics interfaces are modified by setting the correct physics property values 
and adding any needed features for the selected multiphysics couplings.

You control which multiphysics couplings that appear using the settings under Select the physics interfaces you want 

to couple. You can clear and select all physics interfaces in the current component. By default, all physics interfaces 
are selected and appear with a check mark ( ) in the Couple column. The available multiphysics couplings depend 
on which COMSOL Multiphysics products your license includes. If no multiphysics coupling is available, No 

Coupling Features Available for the Selected Physics Interfaces appears. You must select at least two physics interfaces 
for any multiphysics couplings to appear. With more than two physics interfaces in the component, any combination 
of two or sometimes more physics interfaces typically results in a different set of available multiphysics couplings, 
whereas most combinations of three or more physics interfaces result in no available multiphysics couplings.

The existing Studies are listed under Multiphysics couplings in study. By default, the studies appear with a check 
mark ( ) in the Solve column, which indicates that the study solves for the equations that the multiphysics 
couplings add. Click in the column to clear the check mark and exclude the equations in the multiphysics coupling 
from that study. Some multiphysics couplings do not add any extra equations and are then not affected by this 
setting.

The Multiphysics Branch

The Multiphysics branch ( ) contains, or has available, any predefined multiphysics coupling features that are 
likely to be used as multiphysics couplings for a particular set of physics interfaces added to the Model Builder. See 
Figure 3-16. There are no settings required for the node itself.

Predefined multiphysics interfaces provide you with a quick entry point for common multiphysics applications. You 
can create the same multiphysics couplings using any of the other methods for multiphysics modeling, and you can 
continue to add, modify, disable, and remove physics features or interfaces in a model when you start using one of 
the predefined multiphysics interfaces. If you instead decide to add physics interfaces one by one, you can verify 
that each type of physics or equation gives the expected results before adding more complexity to the model by 
adding another physics interface, physics feature, or multiphysics coupling.

Uncoupling a Multiphysics Coupling

Figure 3-17: Uncoupling a predefined multiphysics coupling feature.

For each multiphysics coupling feature (for example, Electromagnetic Heating), there is a section that defines the 
physics interfaces involved in the multiphysics coupling. By default, the applicable physics interfaces are selected in 
the lists to establish the coupling.

You can also select None from the lists to uncouple the node from a physics interface. If the physics interface is 
removed from the Model Builder (for example, if a Heat Transfer in Solids interface is deleted), then the Heat transfer 

For links to more information about the add-on modules and the multiphysics interfaces available go 
to www.comsol.com/comsol-multiphysics.
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list for the Electromagnetic Heating reverts to None (Figure 3-17) as there is no heat transfer interface to couple to. 
To avoid that the multiphysics coupling is turned off unintentionally, a warning A coupled physics is set to 'None' 
tooltip appears when you change a list under Coupled Interfaces to None.

Figure 3-18: A warning tooltip appears when a multiphysics coupling is turned off.

Model Inputs and Multiphysics Couplings

Model inputs can appear in an equation or material model node’s Model Inputs section. Model inputs are typically 
fields such as temperature and velocities that act as inputs for material models and model equations, but they can 
be any available physical property. They appear in the Model Inputs section if a material is defined so that a material 
property becomes a function of the temperature, for example. The COMSOL Multiphysics software connects the 
model input to an existing field (dependent variable) within the physics interface (but not to available fields in other 
physics interfaces). Default model inputs are always available. You can define scalar values for default model inputs 
under Global Definitions for use throughout the model (see Default Model Inputs).

For frequently used multiphysics couplings, predefined multiphysics coupling nodes are available under the 
Multiphysics node (see The Multiphysics Branch). The following part of this section is mostly useful for cases when 
such predefined couplings are not available.

With more than one physics interface in the model, coupling of the fields is easy: all applicable fields that can serve 
as inputs in another physics interface automatically appear in the other physics interface’s Settings window’s Model 

Inputs section. For example, with a Heat Transfer in Fluids (ht) interface and a Laminar Flow (spf) interface, you 
can select Velocity field (spf), which the Fluid Properties 1 {fp1} node in the Laminar Flow branch defines, from the 
Velocity field list in the Model Inputs section of the Settings window for the Fluid node under Heat Transfer in Fluids. 
The velocity field from the Laminar Flow interface then becomes the velocity field for the convective heat transfer. 
You can also choose Common model input to use its value to define the velocity field, or choose User defined to enter 
a user-defined velocity field.

When you have selected a model input from one of the lists, click the Go to Source button ( ) next to the list to 
move directly to the node in the other physics interface that provides the model input. If more than one node 
contribute to the model input, choose which one to go to in the Contributing Entities dialog box. Then click OK to 
move to the selected node.

You can also, if you have selected Common model input, click the Create Model Input button ( ) to create a local 
Model Input node in the current component (see Model Input) for defining a model input for some or all of the 
geometry in the current component, overriding the default model input.

By default, the Model Input section in the Fluid Properties node under the Laminar Flow node is empty. But if you, 
for example, add a temperature-dependent material property such as the dynamic viscosity, a Temperature list 
appears in the Model Input section where you can explicitly choose the Temperature (ht) field or use a user-defined 
temperature or a Common model input like any other model input.

A list in the Model Inputs section becomes unavailable if the physics itself defines the field because it is then 
automatically connected to that field. For example, with a Heat Transfer in Fluids (ht) interface the Temperature 
list is unavailable in the Fluid node under Heat Transfer in Fluids. This automatic connection selects the 

If a physics interface is deleted and then added to the model again, and in order to re-establish the 
coupling, you need to choose the physics interface again from the lists. This is applicable to all 
multiphysics coupling nodes that would normally default to the once present physics interface.
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Temperature (ht) field. As long as the list is unavailable, you cannot change it. If you want to use another 
temperature field or an expression, you first make the list editable by clicking the Make All Model Inputs Editable 
button ( ). Using this option can be useful in order to, perhaps temporarily, break a multiphysics couping and 
use a user-defined value instead to, for example, investigate a simulation that does not converge.

For this type of fluid-thermal coupling, the Multiphysics branch provides a predefined Nonisothermal 

Flow node, which provides an easy way to set up this coupling without having to explicitly specify the 
model input.

See Joule Heating of a Microactuator for an example of combining the Electric Currents and Heat 
Transfer in Solids interfaces through a Joule Heating multiphysics interface (Application Library path 
COMSOL_Multiphysics/Multiphysics/thermal_actuator_jh).
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S p e c i f y i n g  Mode l  Equa t i o n  S e t t i n g s

The fundamental mathematical model, representing the physics in a physics interface, is contained in physics nodes 
with selection on the same space dimension as the physics itself. The first node under a physics branch is of this type 
and sets up default equations where the physics interface is active. These equations are controlled by specifying:

• Material properties, which COMSOL Multiphysics uses as coefficients in the equations

• A coordinate system, which makes it possible to specify anisotropic material properties and vectors in a more 
convenient coordinate system than the global Cartesian coordinate system.

• A material model (a mathematical model for a constitutive relation, for example), which selects an equation 
suitable for a given type of material 

The default node uses the same material model, and thus the same equations, everywhere. Material properties can 
vary between different parts of the feature’s selection, if the property is specified as taken From material. Add 
additional nodes to use different material models for different parts of the geometry, or to use different User defined 
material property values.

In equation-based modeling, provided by the Mathematics branch interfaces, the form of the equation is fixed for 
each particular node type. Each given equation form contains a number of free PDE coefficients, which you can be 
specify in the settings to define the specific equation that you want to solve.

Specifying Equation Coefficients and Material Properties

To specify an equation coefficient or a material property, enter a value or an expression directly in the corresponding 
field. The expressions in those fields are interpreted, providing the possibility to enter expressions that include 
variables and coordinates in addition to constants and numerical values. Such expressions can contain:

• Numerical values.

• Units (see Using Units).

• Built-in Mathematical and Numerical Constants.

• Spatial coordinates, time, and the dependent variables in any physics feature in the model as well as the spatial 
derivatives and time derivatives. Using such variables makes it possible to create user-defined multiphysics 
couplings.

• Physical Constants — built-in universal physical constants.

• User-defined parameters, variables, coupling operators, and functions, including external functions and 
MATLAB® functions (requires the COMSOL LiveLink™ for MATLAB®). See Operators, Functions, and 
Constants.

• Built-in functions and operators such as d and mean.

You can use these types of variables, constants, functions, and operators in all settings for the physics interfaces; 
many types of variables are also available anywhere in the model.

Not all physics features allow anisotropic materials or more than one material model. Therefore, these 
settings cannot be present.

Equation-Based Modeling
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In most cases where you can enter an expression, you can press Ctrl+Space to choose from a number of applicable 
variables, parameters, functions, operators, and constants that you can insert into the expression at the position of 
the cursor.

Modeling Anisotropic Materials

Anisotropic materials respond differently to an excitation depending on its direction. Because excitations are 
generally vectors and the corresponding response is a vector density, material properties are usually rank-2 tensor 
densities. For example, the following material properties are anisotropic tensor densities: diffusion coefficient, 
permittivity, thermal conductivity, and electrical conductivity.

These properties are, in principle, specified in matrix form and defined by their components in the coordinate 
system selected in the node settings. At most four components are used in 2D and at most nine components in 3D. 
When the material contains symmetries, you can specify only a few coefficients, which are expanded to a matrix 
using the following patterns:

• Isotropic (the default) — enter only one value c.

• Diagonal — enter the diagonal components for an anisotropic material with the main axes aligned with the 
model’s coordinate system.

• Symmetric — enter a symmetric matrix using the diagonal components and the upper off-diagonal components.

• Full — enter the full 2-by-2 (2D) or 3-by-3 (3D) matrix for an anisotropic material:

Specifying Initial Values

An Initial Values node is added by default to each physics interface.

In some types of analyses initial values must be provided:

• As the initial condition for a time-dependent analysis.

• As an initial guess for the nonlinear stationary solver.

• As a linearization (equilibrium) point when solving a linearized stationary model or when performing an 
eigenvalue study.

C
c 0 0
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0 0 c
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To enter initial values, in the Model Builder, click the Initial Values node under a physics interface node. In the Settings 
window, enter the Initial Values for all dependent variables (fields) in the physics interface. The default initial values 
are usually zero.

For some physics interfaces you can also enter initial values for the first time derivative of the dependent variables. 
These are used when solving time-dependent problems containing second time derivatives (wave-type 
applications). Like other default settings, these initial values apply to all domains where no other values are specified.

To use different initial values in different domains, add another Initial Values node from the Physics ribbon toolbar 
(Windows users), Physics context menu (macOS or Linux users), or right-click to access the context menu (all 
users).

See Dependent Variables for more information about handling and plotting initial values.

Equation View

Equation View ( ) is a subnode available for all physics feature nodes. To display these subnodes, click the Show 

More Options button ( ) and select Equation View from the Show More Options dialog box.

The Settings window for Equation View contains detailed information about the implementation of each physics 
feature: variables, shape functions, weak-form equation expressions, and constraints.

To update the values in the Settings window for Equation View to reflect the latest changes in a physics feature, click 
the Refresh Equations button ( ) in the Settings window’s toolbar.

You can edit the expressions or values of variables, weak-form expressions, and constraints in the corresponding 
tables under Variables, Weak Expressions, and Constraints, respectively. This makes it possible to introduce custom 
changes to the equations and variable definitions. If the expression that defines a variable, for example, does not fit 
inside of the text field, a tooltip displays the entire expression. Press Ctrl+Space or use the Insert Expression button 
( ) below the tables to choose from a number of applicable variables, parameters, functions, operators, and 
constants that you can insert into the expression at the position of the cursor. In the table of variables under 
Variables, you can click any of the column headers to sort the table contents alphabetically based on the contents 
of that column (in ascending order; click again for descending order; click yet again to restore the original order).

For a changed definition of a variable or a change to a weak-form expression or constraint, a warning icon ( ) 
appears in the leftmost column, and a small padlock is added to the lower-right corner of the icon for the physics 
node where you have made modifications in its equation view. To restore only the change in the selected variable, 
weak-form expression, or constraint, click the Reset Selected button ( ) under the table in the Variables, Weak 

Expression, or Constraints section. To reset all changes in the equation view, click the Reset All button ( ) in the 
Settings window’s toolbar. If no changes remain, the padlock disappears from the corresponding physics node. An 
orange color for the expression that defines the variable is a warning that the unit of the expression does not match 
the expected unit for the variable that it defines. To store all information in the tables under Variables, Shape 

Functions, Weak Expressions, or Constraints to a text file, click the corresponding Save to File button ( ).

Editing the predefined expressions for variables, equations, and constraints means that the equations 
are altered and that COMSOL Multiphysics solves the model using the new expressions.

For information about the Equation displays available, see Physics Nodes — Equation Section.
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S T U D Y

From the Show equation view assuming list, choose No study or any of the available studies. The equation view of 
the parent feature is then recomputed with the assumption that the selected study step was solved. This operation 
also updates all children to the parent feature, so the lists in their equation views are also updated. When solving a 
study (or study step), the list also changes to represent the last computed study step. The default is No study and 
represents a default behavior, which computes the equations without any study type information. The equation 
form used is then undefined and depends on the physics that the parent feature belongs to. The equation view 
reverts to No study if you change some setting in the parent feature to indicate that the equation view no longer 
represent a specific study step.

V A R I A B L E S

This section has a table with the variables that the physics node defines. The table includes these columns:

• Name: the name of the variable.

• Expression: the expression, using COMSOL syntax, that defines the variable.

• Unit: the unit for the variable (in the active unit system). If the unit of the expression does not match the unit of 
the variable, the expression is displayed in orange.

• Description: a description of the variable.

• Selection: the geometric entities (domains, boundaries, edges, or points) where the variable is defined (Domain 1, 
for example).

• Details: this column contains some details about the variable’s behavior. See About the Details Column below.

S H A P E  F U N C T I O N S

This section has a table with the dependent variables that the physics node defines and their shape functions. This 
is primarily applicable to equation model nodes; for most physics nodes such as boundary conditions, the table is 
empty. The table has these columns:

• Name: the name of the variable.

• Shape function: the type of shape function (element) for the variable (for example, Lagrange for Lagrange 
elements, which are the most common elements). 

• Unit: the unit for the variable (in the active unit system).

• Description: a description of the variable.

• Shape frame: the frame type (typically either a spatial or a material frame) for the shape function.

• Selection: the geometric entities (domains, boundaries, edges, or points) where the shape function is defined 
(Domain 1, for example).

• Details: This column contains some details about the shape function’s behavior. See About the Details Column 
below.

If you click a single variable, its selection, as indicated in the Selection column, appears in the Graphics 
window.

Selecting an Element Type
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W E A K  E X P R E S S I O N S

This section has a table with the weak-formulation equation contributions that the physics node generates. The 
table consist of the following columns:

• Weak expression, the equation expressed in a weak formulation. It is possible to modify these expressions, but 
you then override the equation as specified by the physics interface, and a warning appears in the leftmost column 
of the table.

• Integration order, the order for the integration of the weak expression (see integration order in the Glossary). 
Polynomials of at most the given integration order are integrated without systematic errors. For smooth 
expressions, a sufficient integration order is typically twice the order of the shape function. For example, the 
default integration order for second-order Lagrange elements is 4. You can modify the integration order if 
desired. A warning then appears in the leftmost column of the table to indicate that the predefined order has 
been changed.

• Frame, the frame type (typically either a spatial or a material frame) used when integrating the expression.

• Selection: the geometric entities (domains, boundaries, edges, or points) where the weak expression is defined 
(Domain 1, for example).

Each equation contribution appears on its own row under Weak expression, but the order is not significant.

C O N S T R A I N T S

This section has a table with the constraints that the physics node generates. This is typically the case for boundary 
conditions of constraint types, such as prescribed displacements, temperature, or velocities. Many other physics 
nodes do not generate any constraints, and the table is then empty. The table consists of the following columns:

• Constraint: the expression for the constraint.

• Constraint force: the expression that defines the associated constraint force, which is typically the test function of 
the constraint.

• Shape function: the type of shape function (element) for the constraint (for example, Lagrange for Lagrange 
elements).

• Selection: the geometric entities (domains, boundaries, edges, or points) where the constraint is defined 
(Boundaries 1–5, for example).

A B O U T  T H E  D E T A I L S  C O L U M N

The Details column shows some information about the behavior of variables and shape functions. For variables:

• An empty cell indicates that overlapping contributions are overridden.

• + operation indicates that overlapping contributions are added.

• For some variables, Meta indicates that the variable definitions are not fully updated until you solve the model. 
It is therefore not possible to edit the expressions for such variables.

• In rare cases, other operations (* operation, for example) can occur.

See the following blog post for information about modifying the integration order: 
https://www.comsol.com/blogs/introduction-to-numerical-integration-and-gauss-points/

The PDE interfaces and the ODEs and DAEs interfaces do not display any weak expressions. They are 
either implemented using strong formulations, directly display the weak formulation, or define 
equations discretized in the time domain only.



S P E C I F Y I N G  M O D E L  E Q U A T I O N  S E T T I N G S  |  199

For shape functions:

• Slit means that the shape function creates a slit for the degree of freedom.

Physics Nodes — Equation Section

For each physics node there is an Equation section that is available by default on the Settings window. This section 
has options to display mathematical equations applicable to the node.

The display options available from the lists depend on the study types and other physics-specific factors. See 
Figure 3-20 for an example comparing the equations that display for a Stationary or Time Dependent study for a Heat 

Transfer in Solids interface. Some Settings windows do not have any options and only display the relevant equation 
and other windows have additional sections that become available for the Equation display based on the study type 
selected.

Node Contributions Display a Dotted Line Under Part of the Equation
For all physics nodes (excluding the main physics interface node level), the equation that displays includes a dotted 
line underneath where the node’s contribution is made to the equation. See Figure 3-19 for an example where a 
section of the heat transfer equation is underlined, indicating where the Solid node contributes to it.

Figure 3-19: The Solid contribution to the equation for a 2D model.

Equation Form
When you add physics interfaces to a Component, the supported Study types are listed in the Equation form list. 
Study controlled is the default; select another option as needed. When the setting is Study controlled, the study 
controls the equation form — stationary or time dependent, for example — for the physics interface. In some cases, 
that equation form might not be compatible with the physics covered by the physics interface; the physics interface 

If you do not want to display the Equation section, click the Show More Options button ( ) and clear 
the Equation Sections check box in the Show More Options dialog box.

Equation View

Study and Study Step Types



200 |  C H A P T E R  3 :  B U I L D I N G  A  C O M S O L  M U L T I P H Y S I C S  M O D E L

then uses its default equation form (typically, a stationary equation form). You can then instead choose one of the 
supported study types.

Show Equation Assuming
The Show equation assuming option is available by default when Study controlled is selected (or left as the default) 
as the Equation form. Options availability is based on the studies added and defined for the model.

For the following options — frequency and mode analysis frequency — you also have the option to use another 
frequency than the one used by the solver. This can be necessary if you need two different frequencies for two 
physics interfaces.

Frequency
This option is available if Frequency domain is selected as the Equation form. The default uses the frequency From 

solver. If User defined is selected, enter another value or expression (SI unit: Hz).

Mode Analysis Frequency
This option is available if Mode Analysis or Boundary Mode Analysis is selected as the Equation Form. Enter a value or 
expression in the field (SI unit: Hz). Specify a frequency (it is not present as a solver variable).

Port Name
This option is available with the RF Module Electromagnetic Waves interface and if Boundary Mode Analysis is selected 
as the Equation Form. Enter a value in the field (unitless).

Figure 3-20: An example of the Equation section on a Heat Transfer interface. Selecting the study type updates the 
equation accordingly. 


